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Introduction 
This document is intended for all RemLogic users and provides instructions about 
using the application to review and analyze physiological data collected using 
both Embla and Embletta® recorders. 

It is assumed that the user has a basic knowledge of the Windows® environment, 
working with the mouse, using toolbars, and arranging windows. Sections 
typically begin with an overview of main features, followed by instructions in 
simple action steps. 
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Warnings, Cautions, and Certifications 

Warnings and Cautions 

U.S. Federal law restricts this device to sale by, or on the order of, a physician. 

It is assumed that the user is trained in the manual classification of sleep stages as described in 
the standard manual of Rechtschaffen and Kales and in the AASM Manual for the Scoring of 
Sleep and Associated Events: Rules, Terminology and Technical Specifications before using 
the program. 

It is assumed that the user is trained in the detection of specific events in sleep like apnea, 
hypopnea, and arousal before using the program. Special publications in the journal Sleep 
(1994) by the Atlas Task Force of the American Sleep Disorders Association (now American 
Academy of Sleep Medicine) can be consulted. 

The user is assumed to know the characteristics of a signal and how to interpret spectral 
analysis. 

The computer assisted analysis tools provided by RemLogic are intended to assist in the 
analysis of polysomnographic data by a physician or trained technologist. These tools are not 
intended to replace the physician or trained technologist. Users should always review and edit 
the results of computer assisted analyses to ensure accurate event marking. 

RemLogic is intended to assist the physician or trained technologist in analyzing and reporting 
on data collected during sleep studies. However, users are solely responsible for all data 
collected, and are expected to assess and analyze this data to ensure its accuracy and 
completeness. 

Do not install any third-party software on the computer running the RemLogic Software, unless 
approved by Embla.  Please contact Technical Support (Ottawa.TechSupport@natus.com) for 
information. 

 

All RemLogic studies on patients with any co-morbidity such as congestive heart 
failure, hypertension, and/or moderate to severe pulmonary diseases, should be 
reviewed by a Sleep Medicine Physician. 

 

RemLogic systems may be delivered with factory set passwords.  It is our 
recommendation that you change your password in keeping with your company policy.   

 

RemLogic systems are personal computer based with Windows operating systems.  
As such, they are subject to the same security risks as a personal computer. It is our 
recommendation that you use industry best practices in keeping your system up to 
date with regards to Operating System updates/patches and anti-virus solutions in line 
with the Exclusions, Policies, and Security Update Information for Embla Line 
Products (DOC-012422) documentation.  Please contact Technical Support 
(Ottawa.TechSupport@natus.com) for the latest guidelines. 

http://www.aasmnet.org/
http://www.aasmnet.org/
mailto:Ottawa.TechSupport@natus.com
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Intended Use 

The RemLogic software is intended for Polysomnography studies and allows recording, 
displaying, analysis, printing and storage of physiological signals to assist in the diagnosis of 
various sleep disorders and sleep related respiratory disorders.  The RemLogic software allows:  

 Automated analysis of physiological signals that is intended for use only in adults; 

 An optional audio/visual alert for user defined threshold on calibrated DC input.  These 
alerts are not intended for use   as life support such as vital signs monitoring or 
continuous medical surveillance in intensive care units. 

 Sleep report templates which summarize recorded and scored sleep data using simple 
measures including count, average, maximum and minimum values as well as data 
ranges for trended values; 

The RemLogic software does not provide any diagnostic conclusion about the patient's 
condition and is intended to be used only by qualified and trained medical practitioners, in 
research and clinical environments. 

Certifications 

 

RemLogic is certified to carry the CE mark. The CE mark is a declaration that 
RemLogic is in compliance with the directive for medical devices set forth by the 
European Union. 

The Embla Quality Management System complies with EN ISO 13485:2003. 

RemLogic is manufactured by Embla Systems, a division of Natus Medical 
Incorporated. 

Embla certifies that the development, manufacture, sales, and service of RemLogic 
is in conformity with Annex II of the Directive 93/42/EEC on medical devices. 

Safety and Regulatory Information 

Before using RemLogic, please read this document carefully, paying particular attention to the 
caution or warning that appears with each safety symbol. 

 

The CAUTION notice denotes a potential hazard. It calls attention to an operating 
procedure, practice, or the like, which, if not correctly performed or adhered to, could 
result in damage to the product or loss of important data. Do not proceed beyond a 
CAUTION notice until the indicated conditions are fully understood and met. 
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Getting Started 

System Requirements 

Review the following hardware and software requirements before installing or upgrading to 
RemLogic 3.4. 

 Desktop 

Component Minimum Recommended 

Operating System 

Note: RemLogic is not 
supported on 64-bit editions 
of Windows XP. 

Windows 7 64-bit is 
supported 

Windows XP Professional, SP3 

Windows 7 Home Premium / 
Professional / Enterprise / 
Ultimate, SP1 

Windows 7 Ultimate / Enterprise / 
Professional, SP1 

Processor 

Note: If you are using the 
Embla MDrive with a wireless 
collection, the recommended 
specification for the processor 
should be used. 

Intel® Dual Core processor Intel Quad Core, i5 or higher 
processor 

Clock Speed ≥2 GHz ≥3 GHz 

Memory 2 GB ≥4 GB 

Hard Drive 80 GB ≥500 GB 

CD/DVD Drive CD-RW , DVD+/- RW DVD+/- RW 

Graphics Resolution 1600 x 1050* Highest Available* 

*For AASM-compliant scoring, the minimum graphics resolution required is 1600 x 1050. 

Graphics Memory 128 MB ≥512 MB 

Monitor 19" 24" LCD Flat Panel 

USB Port 2 ≥4 

Microsoft® Office™ 
Suite 

 

Note: RemLogic does not 
support 64-bit or Office 365 
versions of Microsoft Office. 

Microsoft Office 2003 
Professional 

Update for Microsoft Office 2003 
(KB907417) 

Microsoft Office 2007 

Microsoft Office 2010 

Microsoft Office 2013 

Microsoft Office 2016 

Microsoft Office 2010 

Microsoft Office 2013 

Microsoft Office 2016 
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Laptop 

Component Minimum Recommended 

Operating System 

Note: RemLogic is not 
supported on 64-bit editions 
of Windows XP. 

Windows 7 64-bit is 
supported 

Windows XP Professional, SP3 

Windows 7 Home Premium / 
Professional / Enterprise / 
Ultimate, SP1 

Windows 7 Ultimate / Enterprise / 
Professional, SP1 

Processor 

Note: If you are using the 
Embla MDrive with a wireless 
collection, the recommended 
specification for the processor 
should be used. 

Intel® Dual Core processor Intel Quad Core, i5 or higher 
processor 

Clock Speed ≥2 GHz ≥2.5 GHz 

Memory 2 GB ≥4 GB 

Hard Drive 80 GB ≥160 GB 

CD/DVD Drive CD-RW , DVD+/- RW DVD+/- RW 

Graphics Resolution 1440 x 990* Highest Available* 

*For AASM-compliant scoring, the minimum graphics resolution required is 1600 x 1050. 

Graphics Memory 256 MB ≥ 512 MB 

Monitor 15” 15” 

USB Port 2 ≥4 

Microsoft® Office™ 
Suite 

 

Note: RemLogic does not 
support 64-bit or Office 365 
versions of Microsoft Office 

Microsoft Office 2003 
Professional 

Update for Microsoft Office 2003 
(KB907417) 

Microsoft Office 2007 

Microsoft Office 2010 

Microsoft Office 2013 

Microsoft Office 2016 

Microsoft Office 2010 

Microsoft Office 2013 

Microsoft Office 2016 
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Hardware 

Hardware Device or 
Requirement 

All Systems 

Embletta Gold One high-speed (16550 UART) serial port for each device 

One USB 1.1 port (laptops require a powered hub) 

Embletta (Serial 
Communication) 

One high-speed (16550 UART) serial port for each device 

One PS/2 port 

Embletta USB (USB 
Communication) 

One USB 1.1, 2.0 port (laptops may require a powered hub) 

Embla titanium One 10/100 Ethernet NIC (for network configuration) 

One USB 1.1, 2.0 port (for USB configuration) 

(additional NIC required for network connectivity) 

Embla titanium (Wireless) Linksys® USBBT100 

or 

LM Technologies® LM541 

MDrive™ 

(N7000 & S4500) 

One 10/100 Ethernet NIC (for network configuration) 

(additional NIC required for network connectivity) 

MDrive™ (Wireless) IEEE 802.11g 

IEEE 802.11b 

Video Capture for analog 
video systems 

Winnov® Videum 1000 AV Plus (supports 32-bit operating 
systems only) 

StarTech USB S-Video and Composite Video Capture Cable with 
Audio (model SVID2USB2) (supports 64-bit operating systems 
only) 

Winnov 4100 AV (PCI) Winnov 4100 AV Xpress (PCIe) – 64-bit 
Operating system support 

Photic Device One high-speed (16550 UART) serial port per device (RemLogic 
3.2) 

One USB 1.1, 2.0 port (RemLogic 1.3) 

ResMed® Tx Link One 10/100 Ethernet NIC 

(additional NIC required for network connectivity) 

Embletta MPR One USB 2.0 port (for configuration) 

TX Proxy Unit One USB 2.0 port (for configuration) 

One isolated sub-network connection for each patient bedroom 
with a connection to the existing network. 
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Hardware Compatibility 

 Embla S4500 (MDrive/Communication Unit) 

 Embla N7000 (MDrive/Communication Unit) 

 Embla titanium 

 Embletta MPR  

 Embletta Gold 

 Embletta 128 

 ResMed Tx Link 

For additional firmware/device compatibility information, contact Technical Service at 
888.662.7632 or at Ottawa.TechnicalSupport@natus.com. 

Driver* 
*Not applicable to the License free version of RemLogic 

Component All Systems 

WebCamXP  

(for use with an IP camera) 

5.5.0.8 and higher 

Go to www.webcamxp.com/download.aspx to download and obtain a license to use 
WebCamXP. 

Firmware 

Component Firmware Included in RemLogic Install 

Embla Communication 
Unit 

FWCOM006-0114 Communication Unit firmware 1.3.3:104 or 
higher 

Embletta Gold FWCOM014-010300-B19 or higher 

Embletta FWCOM007-070400-B244 (Version 7.4, Build 244) or higher 

Embla titanium 2010.02 or higher 

Embla MDrive FWCOM016-1.0.0.11 or higher 

Embletta MPR FWCOM020-1.2.0.9 or higher 

Tx Proxy Unit FWCOM021-1.2.0.7 or higher 

ST/ST+ Proxy FWCOM025-1.0.0.6 or higher 

mailto:Ottawa.TechnicalSupport@natus.com
http://www.webcamxp.com/download.aspx
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Installing RemLogic 

The RemLogic 3.4 installation transparently upgrades RemLogic 1.2 (or higher) in the United 
States and 2.0 (or higher) in the rest of the world while retaining current software settings and 
resources. Any version prior to RemLogic 1.2/2.0 must be uninstalled before proceeding with 
the RemLogic 3.4 installation. The recording profiles that are delivered with RemLogic 3.4 must 
be used for customized profiles. For additional assistance, contact Technical Support at 
888.662.7632 or Ottawa.TechSupport@natus.com. 

RemLogic is compatible with most editions of Windows XP, and Windows 7 operating systems. 
RemLogic is also compatible with Microsoft Office 2003 Professional, Microsoft Office 2007 
Professional, Microsoft Office 2010, Microsoft Office 2013, and Microsoft Office 2016 (Microsoft 
Office 32-bit only). For more information about compatibility, see System Requirements. 
 

 

Note: If you are running Windows 7 and see the User Account Control message while 
installing Embla software, click Continue or Allow to continue the installation. 

Getting Started 

Log into Windows with administrator privileges, and have the RemLogic 3.4 Installation CD 
ready. 

Verifying and Installing Prerequisites 

To verify and install prerequisite components: 

1. Close all programs, and log on with administrator privileges. 

2. Insert the RemLogic 3.4 installation CD into the CD/DVD drive. 

3. On the welcome screen, click Check Prerequisites. A green "✓" displays to the left of 

components included in the installation. 

4. Missing components display a red “x” to the left, and an Install Now link displays to the 
right. 

5. Click Install Now, and follow the setup instructions to install missing components. 

6. Repeat this procedure for all missing prerequisite components. You might need to restart 
the computer during or following the installation process. 

Installing RemLogic 3.4 

 

Note: The recording profiles that are delivered with RemLogic 3.4 must be used for 
customized profiles. For assistance, contact Technical Support at 888.662.7632 or 
Ottawa.TechSupport@natus.com. 

To install RemLogic 3.4: 

1. Close all programs, and log on with administrator privileges. 

2. Insert the RemLogic 3.4 Installation CD into the CD/DVD drive. 

3. Click Install RemLogic 3.4. 

mailto:Ottawa.TechSupport@natus.com
mailto:Ottawa.TechSupport@natus.com


RemLogic™ 3.4            Instructions for Use 

9                     

4. The RemLogic Installation wizard displays. Do one of the following: 

 If you are installing RemLogic 3.4, and not upgrading from an earlier version of 
RemLogic, click Next. 

 If you are upgrading from an earlier version of RemLogic, click Next, then proceed to 
the second bullet of Step 6. 

5. On the Choose Setup Type screen, click one of the following installation options, then 
click Next: 

 Typical: Installs features required to acquire, score, analyze, and report PSG data 
and tools for managing recorded data. 

 Complete: Installs all program features. This option requires the most space on the 
hard drive. 

 Custom: Allows you to customize the installation, and add or remove install 
components.  See Installation Components for additional details. 

6. Note one of the following: 

 If you selected Typical or Complete, proceed to Step 7. 

 If you selected Custom, or are proceeding from step 4, click the arrow to the left of 
the install components you want to add or remove, then select one of the following 
options: 

 Will be installed on local hard drive. Select this option to install the feature 
only. 

 Entire feature will be installed on local hard drive. Select this option to 
install the feature and all sub-features. 

 Entire feature will be unavailable. Select this option to remove a 
component. 

7. Click Next. 

8. Click Install. 

 Windows XP Users: During the Embla titanium software support installation, a 
warning message (indicating that the drivers have not yet passed Windows Logo 
Testing) displays twice. To proceed, click Continue Anyway. 

 Windows 7 Users: During the Embla titanium software support installation, a 
warning message (indicating that Windows cannot verify the publisher of the driver 
software) displays twice. To proceed, click Install this driver anyway. 

9. Click Finish to exit the Installation wizard. 

10. Click Exit to close the Welcome screen. 

11. Restart the computer to complete the installation. 
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Installation Components 

Licensing 

The following are included in the custom or complete installation: 

 United States 
License 

International 
License 

Licensed License 
Free 

CSB Analyzer  X X  

CAP Scoring Assistant  X X  

Data Management Module X X X X 

Photic X X X  

ResMed Tx Link X X X  

Embla titanium X X X  

Demonstration Device X X X  

Generic Data Export X X X  

Event Import X X X  

Scoring Export X X X  

Designer Plug-In for Microsoft Office X X X X 

Inter-Scorer Comparison X X X X 

Phase View X X X  

Timer X X X  

REMbrandt™ Viewer X X X X 

Reports 

The following reports are also part of the custom or complete installation: 

 United States 
License 

International 
License 

Licensed License 
Free 

CAP Report  X X  

Compare Scorings X X X  

EEG X X X  

HRV Report X X X X 

Hypnogram Report X X X  

MWT Report X X X  

Oximetry Report X X X X 

Oxygen Titration Report X X X  
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 United States 
License 

International 
License 

Licensed License 
Free 

PLM Report X X X X 

Sleep Stage Report X X X X 

Sleep Statistics Report X X X  

Summary Graph X X X X 

The following reports are a part of a typical installation: 

 United States 
License 

International 
License 

Licensed License 
Free 

Event Report X X X X 

HRV Statistics - Comments X X X  

MSLT and MWT Reports X X X  

Pediatric Polysomnography Report X X X  

Polygraphy Report X X X X 

Polysomnography Report X X X  

ResMed Device Report X X X X 

Short Polygraphy Report X X X X 

Short Polysomnography Report X X X  

Split Night Report X X X  

Summary Graph X X X X 

Technote Report X X X X 

Titration Report PSG X X X X 

Post-Installation Optimization for Windows 7* 
*Applicable to the Licensed version of RemLogic Only 

The following post-installation steps optimize the Windows 7 operating systems for use with 
RemLogic 3.4. You can grant auto-archive folder access to all users or one or more specific 
users, and preserve your custom settings from the software version from which you are 
upgrading. 

Granting Auto-Archive Folder Access* 

To grant folder access to all users: 

1. Close all programs, and log on with administrator privileges. 

2. Click Start, right-click Network, then click Properties. 
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3. Enable file sharing: 

a. Under Sharing and Discovery, expand File sharing. 

b. Click Turn on file sharing, then click Apply. 

4. Disable password protected sharing: 

a. Expand Password protected sharing. 

b. Click Turn off password sharing, then click Apply. 

5. Disable the Windows Firewall: 

a. In the left pane, under See also, click Windows Firewall. 

b. Click Change settings. 

c. Click Off, then click OK. 

6. Navigate to the destination folder. 

7. Right-click the folder, then select Share. 

8. Do one of the following: 

a. To grant access to all users, select Everyone (All users in this list) from the 
list, then click Add. 

b. To grant access to a specific user, select a user from the list, then click Add. 

9. Under Permission Level, click Reader, then select Full Control. 

10. Click Share. 

11. Click Done. 

Starting and Closing RemLogic 

To open RemLogic, do one of the following: 

 Double-click the RemLogic desktop icon . 

 From the Windows start menu, select Programs | Embla | RemLogic. 

To close RemLogic, do one of the following: 

 Click the  in the upper-right corner of the application window. 

 On the File menu, click Exit. 

RemLogic is designed for easy access to the data acquisition and analysis tools. The work 
environment can be divided into two main areas: the Workspace area on the left and the 
Workpad area on the right. 
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Daylight Savings Adjustment* 
*Applicable to the Licensed version of RemLogic Only 

Disable automatic daylight savings adjustments on the host computer if it will occur during a 
study's recording time. After the study, enable the daylight savings adjustment on the host 
computer, and RemLogic's clock will automatically adjust. 

License Management 

You can activate, renew, and return your RemLogic license using the Embla License Wizard. 
When you want to renew or return your RemLogic license, you can manually launch the wizard 
from the About dialog. 

Activating a RemLogic License 

You must activate your RemLogic license once the RemLogic software has been installed. Have 
the serial number provided with the install package ready. 

To activate the RemLogic license: 

1. Do one of the following: 

 If you are running Windows XP, click Start, point to Programs, point to Embla, 
then click Embla License Wizard. 

 If you are running Windows 7, click Start, click All Programs, click Embla, then 
click Embla License Wizard. 

2. Enter the 28-digit serial number provided with your install package. 
3. Enter your organization name, then click Next. 
4. Do one of the following: 

 To activate your license over the Internet: 

 Click Over the Internet, then click Next. 

 To activate your license by phone: 

a. Click By telephone via support personnel, then click Next. 

b. Select your location from the list, and have the activation request code at 
the bottom of the wizard page ready. 

c. Call Technical Support using the numbers on the page and provide the 
activation request code. Click Next. 

d. Type the authorization code provided by Technical Support, then click 
Next. 



Instructions for Use                 RemLogic™ 3.4 

               14 

 To activate your license by email: 

a. Click By email, then click Next. 

b. Click the email link to open your default email client. The activation 
request code at the bottom of the wizard page is present in the message 
body. Click Send. You will receive a confirmation email with the 
authorization code. 

c. Type the authorization code, then click Next. 

5. Click Finish. 

Renewing a RemLogic License 

By renewing your license, you can extend the license period. 

To renew a RemLogic license: 

1. On the Help menu, click About. 

2. Click License. 

3. Click Manage. 

4. Click Renew RemLogic license, then click Next. 

5. Select your location from the list, and have the renewal request code at the bottom of the 
wizard page ready. 

6. Call Technical Support using the numbers on the page and provide the activation 
request code. Click Next. 

7. Type the authorization code provided by Technical Support, then click Next. 

8. Click Finish. 

Licensed Components 

The type of license you purchased determines the license period, as well as components and 
functionality available in the application. The following table outlines licensed components and 
corresponding workflow tasks.  

Licensed 
Component 

Tasks 

CAP/CSB 

This feature is currently 
unavailable in the United 
States. 

 Perform CAP and CSB analyses. 

 Create CAP reports. 

Pleth 

This feature is currently 
unavailable in the United 
States. 

 Marks autonomic arousal events  

 Generates the Pleth Amplitude optional trace displaying peak-to-
peak amplitude of each waveform in the Pleth Trace. 

 Optionally generates artifact events 
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Licensed 
Component 

Tasks 

Scoring Assistant 

This feature is currently 
unavailable in the United 
States. 

 Stages sleep according to current scoring guidelines 

Video Acquisition  Record video with a video acquisition device. 

Online PSG  Record online using the Embla S4500, Embla N7000, and Embla 
titanium amplifiers. 

Online Embletta  Record online using the Embletta, Embletta Gold, and Embletta 
MPR. 

EEG  Perform routine EEG procedures using the Photic Controller toolbar. 

 Create EEG reports. 

To see a list of currently licensed components: 

1. On the Help menu, click About. 

2. Click License. 

3. Under Optional Components, note the selected boxes. These components are licensed. 

To add or remove licensed components, see Returning a RemLogic License. 

Returning a RemLogic License 

You must return your RemLogic license, or transfer your license to another computer, to add or 
remove licensed components. 

To return a RemLogic license: 

1. On the Help menu, click About. 
2. Click License. 
3. Click Manage. 
4. Depending on the software installed, click either Return RemLogic license or Return 

RemLogic-e license, then click Next. 
5. Do one of the following: 

 To deactivate your license over the Internet: 

 Click Over the Internet, then click Next. 

 To deactivate your license by phone: 

a. Click By telephone via support personnel, then click Next. 

b. Select your location from the list, and have the activation request code at 
the bottom of the wizard page ready. 

c. Call Technical Support using the numbers on the page, and provide the 
serial number and license code when prompted. Click Next. 
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 To deactivate your license by email: 

a. Click By email, then click Next. 

b. Click the email link to open your default email client. The activation 
request code at the bottom of the wizard page is present in the message 
body. Click Send. You will receive a confirmation email. 

6. Click Finish. 
7. Do one of the following: 

 If you are transferring a license to another computer, install RemLogic on the 
new computer, and have the serial number provided with the install package 
ready. See Activating a RemLogic License for instructions. 

 If you are adding or removing licensed components, contact Technical Support 
for information. You will receive a new serial number to activate RemLogic. See 
Activating a RemLogic License for instructions. 

Recording Device Setup 

Recording devices and components can be installed and configured to work seamlessly with 
RemLogic. 

For device installation instructions and information, refer to the respective clinical manual for 
each device. 

Automatic Detection of New Embletta or Embletta Gold Devices 

By default, the Device Manager automatically detects recording devices when they are 
connected to the computer. This setting can be modified in the Options dialog. 

To activate/deactivate automatic device detection: 

1. On the Tools menu, click Options. 

2. In the left pane, click Advanced. 

3. Do one of the following: 

 To detect new devices and refresh the device status automatically, select the 
Detect new devices and refresh device status automatically check box. 
When this option is selected, the Device Manager automatically recognizes new 
devices, activates the Device Wizard, and updates the status of devices. 

 To manually add devices and refresh the device status, clear the Detect new 
devices and refresh device status automatically check box. 

Installing the Embletta Device Driver 

Installing a USB device driver is required to allow the operating system to communicate with 
Embletta devices. When an Embletta device is connected to the computer with the USB 
download cable for the first time, you will be prompted for a device driver for the new device. 
Although the device driver is installed with the software used to program the Embletta, the driver 
requires activation for each connected device and for each unique USB connection to the 
computer. 
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Windows 7 

To complete the installation of the device driver: 

 Connect the Embletta device to a USB port on the computer. The arrow on the cable 
device connector should face the front. Windows 7 detects the device, and displays the 
following message: 

 

After the device automatically installs, the following message displays: 

 

The Embletta device can now be used with the system. 

Windows XP Professional 

To complete the installation of the device driver: 

1. Connect the Embletta device to a USB port on the computer. The arrow on the cable 
device connector should face the front. Windows XP detects the device, and displays the 
following message: 

 

2. In the Found New Hardware Wizard, select Yes, this time only, then click Next. 

3. Select Install the software automatically, then click Next. 

4. Click Finish. 

The Embletta device can now be used with the system. 

Installing the Embletta 

Before a recording can be programmed with an Embletta recorder, the device must be 
introduced to the application. This introduction is automated with the assistance of the New 
Device Wizard. 

To install an Embletta device: 

1. Open RemLogic. 

2. Connect the USB/Download Cable to the computer. 
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3. Connect an Embletta to the USB/Download Cable. The New Device Wizard 
automatically detects the device. 

4. Click Next to continue. 

5. Select the Embletta device, then click Next. 

 

6. Type a name for the new device, then click Next. An overview of device properties 
displays. 

7. Click Finish to close the wizard. 

An Embletta icon  with the name provided displays in the Device Manager, to the left of the 
Operations Sheet. 

 

Note: To record online using the Embla S4500, Embla N7000, Embletta, Embletta 
MPR, and Embla titanium amplifiers, you must activate the Online PSG license 
component. See License Management for more information. 

Installing the Embletta Gold 

Before a recording can be programmed with an Embletta Gold, the device must be introduced to 
the application. This introduction is automated with the assistance of the New Device Wizard. 

To install the Embletta Gold: 

1. Open RemLogic. 

2. Connect the USB/Download Cable to the computer. 

3. Connect the Embletta Gold to the USB/Download Cable. The New Device Wizard 
automatically detects the device. 

4. Click Next to continue. 

5. Select the Embletta Gold device, then click Next. 

 

6. Type a name for the new device, then click Next. The device properties summary 
displays. 

7. Click Finish to close the wizard. 

An Embletta Gold icon   with the name provided displays in the Device Manager, to the left of 
the Operations Sheet. 

 

Note: To record online using the Embla S4500, Embla N7000, Embletta, Embletta 
MPR, and Embla titanium amplifiers, you must activate the Online PSG license 
component. See License Management for more information. 
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Installing a Power Embla Device* 
*Not available with the License free version of RemLogic 

Power Emblas include the Embla N7000 and Embla S4500 devices. 

After a Power Embla device is connected, the device can be installed in RemLogic. Refer to the 
appropriate clinical manual (located on the RemLogic installation CD) for detailed information 
about how to connect the system units: 

 Embla N7000 Clinical Manual 

 Embla S4500 Clinical Manual 

To install a Power Embla device: 

1. Open RemLogic. 

2. Open the Device Manager. 

3. On the Device Manager bar, click Devices, then click Add Device. 

The New device wizard displays. 

4. Select Automatically scan for new devices, then click Next. 

5. The wizard displays a list of the Embla systems that were detected on the network. 
Select the device you want to add, then click Next. 

 

6. Type in a name for the new device, then click Next. 

7. Click Finish to complete the installation. 

An Embla Bedside Unit icon  with the provided name displays in the Device Manager, to the 
left of the Operations Sheet. To view the properties of the Communication Unit / MDrive, right-
click the Bedside Unit icon, then click Properties. For more information, see Communications 
Unit / MDrive Properties in the following location in the RemLogic online help: Getting Started | 
Recording Device Setup | Power Embla. 

Installing the Embletta MPR 

To begin using the Embletta MPR device, you must first configure the device for use.  To allow 
the use of the Embletta MPR PG in conjunction with the TX Proxy Unit (for online or ambulatory 
recordings) the two devices need to be configured to communicate to each other. Refer to the 
Embletta MPR Clinical Manual for details on how to pair two devices to communicate with each 
other. 

Before a recording can be programmed with an Embletta MPR, the device must be introduced 
to the RemLogic application.  

To install the Embletta MPR: 

1. Open RemLogic. 
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2. Do one of the following: 

If you are collecting Then 

Ambulatory Studies Connect the USB cable to the Embletta MPR. 

Online Studies Pair the Embletta MPR with a TX Proxy Unit using the 
Configuration tool, and ensure the TX Proxy Unit is connected 
to the Local Area Network (LAN) of the recording computer. 

3. Open the Device Manager. 

4. On the Device Manager bar, click Devices, then click Add Device.... 

 

The New device wizard displays. 

5. Select Automatically scan for new devices, then click Next. The wizard displays a list 
of devices detected on the network. 

6. Select the device, then click Next. 

 

 If collecting an ambulatory study or if you plan to download data from the device, 
select the Model type of Embletta MPR. 

 If collecting an online study, select the Model type of TX Proxy. 

Type a name for the device, then click Next. 

7. Click Finish to complete the installation. 

An Embletta MPR icon   with the name provided displays in the Device Manager, to the left of 
the Operations Sheet. 

 

Note: To record online, you must connect the Embletta MPR to the TX Proxy Unit 
wirelessly and activate the Online PSG license component. See License Management 
for more information. 

Installing the Embla titanium* 
*Not available with the License free version of RemLogic 

The Embla titanium is a PSG signal amplifier with an integrated LCD screen for signal display, 
impedance checking, and patient data entry. Embla titanium is connected to the local area 
network (LAN) and RemLogic through an Ethernet cable or wirelessly through a Bluetooth 
adapter. Information about both methods is presented below. 
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Installing the Embla titanium through Ethernet Cable* 

To install the Embla titanium: 

1. Open RemLogic. If it detects the new Embla titanium, the New Device Wizard 
automatically opens and displays a list of Embla devices it detects on the network. 

2. Select the device, then click Next. 

 

3. Type a name for the device, then click Next. 

4. Click Finish to complete the installation. 

An Embla titanium icon  with the name provided displays in the Device Manager, to the left of 
the Operations Sheet. 

 

Installing the Embla titanium through the Bluetooth Adapter* 

Before installing the Embla titanium 
wirelessly, you must connect the 
Bluetooth adapter to RemLogic. For 
information about installing a Bluetooth 
adapter, see Bluetooth Adapter (Embla 
titanium). 

To install Embla titanium: 

1. Open RemLogic. 

2. Ensure the Embla titanium is 
connected to the collecting 
computer through the Bluetooth 
serial link. 

3. In the Device Manager, select 
Device | Settings | Embla 
titanium. 

4. In the Titanium Settings dialog box, select the Bluetooth tab. 

5. In the Select Addition Port section, confirm the port for the Bluetooth is listed in the 
Detected Ports list. If it is not, complete the following steps: 

 From the Available Ports drop-down list, select the port for the Bluetooth. 

 Click Add to move the port for the Bluetooth to the Selected Ports list. 

6. Click OK to close the Titanium Settings dialog box. If it detects the new Embla titanium 
device, the New Device Wizard opens. 

7. Click Next in the first page of the New Device Wizard. 

8. From the list of detected Embla devices, select Embla titanium, then click Next. 
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9. Type a name for the device (for example, Wireless titanium), then click Next. 

10. Click Finish to complete the installation. 

 

Note: A warning message will indicate the Embla titanium drivers have not yet passed 
Windows Logo Testing. Click Continue Anyway to proceed. 

Installing the Bluetooth Adapter* 
*Not available with the License free version of RemLogic 

RemLogic can communicate with the Bluetooth-enabled Embla titanium amplifier through a 
wireless connection to configure, initiate, and complete online recordings. A Bluetooth adapter is 
required to establish a wireless connection. The Linksys USBBT100 and the LM Technologies 
LM541 Bluetooth adapters are supported for using the Embla titanium in a wireless 
configuration. 

 

Note: The Embla titanium requires firmware version 2010.02 to be compatible with 
RemLogic 3.4 and higher. 

In optimum conditions, Bluetooth technology works within a range of 30 feet. Physical obstacles 
(such as metal and walls) or radio interference from nearby electrical equipment (such as 
wireless LAN devices and cordless phones) can affect performance. 

You can install the Linksys USB and the LM Technologies Bluetooth Adapters on computers 
with Windows XP and Windows 7 operating systems. Instructions for installing the Bluetooth 
adapter on the Windows operating systems are included below. 

After a wireless connection is established between the computer and the Bluetooth adapter, you 
can install the Embla titanium on RemLogic through the Bluetooth adapter. For more 
information, see Installing the Embla titanium through the Bluetooth Adapter. 

Installing the Bluetooth Adapter (Windows XP, Windows 7)* 

Follow the directions below to install the Bluetooth adapter on 
Windows operating systems. 

1. Insert the Bluetooth adapter into the USB port of the 
computer. 

2. Windows automatically installs the required Bluetooth 
driver. After installation, Windows displays a Bluetooth icon 
in the task bar. 

3. Search for the Embla titanium device by completing the following steps: 

a. Ensure the titanium device is turned on, and the radio is active. 

b. Right-click the Bluetooth icon  in the system tray, then select Add a device. 

4. Pair the devices by completing the following steps: 

a. Choose the option to pair by entering the device's pairing code. 
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Windows 7 

 

Windows XP 

b. When prompted, type passkey 0000 to authenticate the connection. 

c. Once the pairing is successful, the following message displays: 

 

Windows 7 

 

Windows XP 

d. Click Close or Finish. 

After a wireless connection is established between the computer and the Bluetooth adapter, you 
can install the Embla titanium on RemLogic through the Bluetooth adapter. For more 
information, see Installing the Embla titanium through the Bluetooth Adapter. 

Installing ResMed Tx Link* 
*Not available with the License free version of RemLogic 

The ResMed Tx Link is added with the complete or custom installations of RemLogic 3.1 or 
higher. You can add Tx Link as a composite device with any amplifier listed below, or it can 
operate as a stand-alone device. It is compatible with the following Embla amplifiers: 

 Embletta (online mode only) 

 Embletta Gold (online mode only) 
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 Embla titanium (online mode only) 

 MDrive (with an Ethernet connection to the LAN) 

 Embla communication units 

 Embletta MPR (online mode only – ResMed Therapy Device Setting disabled) 

The ResMed Tx Link must be connected to the same local area network (LAN) as the recording 
computer. You must install the ResMed Tx Link through a complete or custom installation of 
RemLogic. Additionally, ResMed EasyCare Tx software, version 3.0 or higher, is required to use 
Tx Link. 

 

Tip: RemLogic communicates with all Tx Link devices connected to the same 
computer network. If multiple Tx Link devices are installed on the same network, it is 
recommended that each patient bedroom is isolated with a single subnet. 

Before adding a new device, ensure the device is connected to the acquisition computer and the 
Device Manager is open: 

 On the View menu, point to Workspace, then click Devices. 

To install the ResMed Tx Link: 

1. Open RemLogic. 

2. Open the Device Manager. 

3. On the Device Manager bar, click Devices, then click Add Device. 

 

The New device wizard displays. 

4. Click Automatically scan for new devices, then click Next. New device items are listed 
under Device Type. Each new device is identifiable by its name (device type), model, 
serial number, and connection IP address. 

 

5. Select Tx Link Device, then click Next. 

6. Type a name for the device you are adding, then click Next. 

7. Click Finish to complete the wizard. 

A PAP icon  with the name you provided displays in the Device Manager, to the left of the 
Operations Sheet. 
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Note: Tx Link is available only if a ResMed therapy device is attached to it. 

Installing the MDrive* 
*Not available with the License free version of RemLogic 

The MDrive is a PSG signal amplifier with an integrated LCD screen for signal display and 
impedance checking. It is compatible with the following Embla bedside units: 

 S4500  N7000 

RemLogic 3.4 and higher can control several MDrive functions. For more information, see 
Controlling the MDrive with RemLogic. 

To install the MDrive: 

1. Open RemLogic. 

2. Open the Device Manager. 

3. On the Device Manager bar, click Devices, then click Add Device. 

 

The New device wizard displays. 

4. Select Automatically scan for new devices, then click Next. The wizard displays a list 
of devices detected on the network. 

5. Select the device, then click Next. 

 

6. Type a name for the device, then click Next. 

7. Click Finish to complete the installation. 

An MDrive icon  with the name provided displays in the Device Manager, to the left of the 
Operations Sheet. To view the properties of the MDrive device, right-click the MDrive icon, then 
click Properties. For more information, see MDrive Properties in the following location in the 
RemLogic online help: Getting Started | Recording Device Setup | MDrive. 

 

Note: A warning message indicates the Embla MDrive drivers have not yet passed 
Windows Logo Testing. Click Continue Anyway to proceed. 
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Note: To record online using the Embla S4500, Embla N7000, Embletta, Embletta 
MPR, and Embla titanium amplifiers, you must activate the Online PSG license 
component. See License Management for more information. 

  

 

Note: An MDrive cannot be deleted from RemLogic while it is in use. 

Installing a Video Capture Device* 
*Not available with the License free version of RemLogic 

You can add and configure a video camera for use with RemLogic. Before adding a video 
capture device in RemLogic, it must be connected to the acquisition computer. Follow the 
instructions that came with the video capture device to install it and the necessary applications. 

Installing a Video Capture Device* 

To install a video capture device: 

1. Open RemLogic. 

2. Open the Device Manager. 

3. On the Device Manager bar, click Devices, then click Add Device. 

 

The New device wizard displays. 

4. Select Automatically scan for new devices (Recommended), then click Next. The 
New Device Wizard searches for available acquisition devices. 

5. From the list of device types, select a video capture device and click Next. Selecting the 
default video device is not recommended (the recommended device connection is 
Wavelength Division Multiplexing (WDM)). 

 

 

7. Type a descriptive name for the video capture device, then click Next. 

8. Click Finish to complete the New Device Wizard. 

A video device icon  with the new name displays in the Device Manager to the left of the 
Operations Sheet. To view the properties of the video capture device, right-click the video icon, 
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then click Properties. It is important to properly configure the video properties before starting a 
recording. For more information, see Video Properties in the following location in the RemLogic 
online help: Collecting Data | Video Capture. 

It is not possible to record with a video capture device without recording traces. The video 
capture device must be combined with a recording device by creating a composite device. See 
Installing a Composite Device. 

Contact Technical Support for additional information on setting up and configuring the video 
capture devices. 

Installing a Photic Device* 

*Not available with the License free version of RemLogic 

The photic stimulator is a solid-state electronic device for generating short duration flashes of 
white light. In an EEG, this is used to assess a patient’s photosensitivity—in other words, 
sensitivity to flashing lights. 

To install a photic device: 

1. Open RemLogic. 

2. Open the Device Manager. 

3. Connect the photic lamp to the computer's COM port or a simulated COM port (through 
Ethernet connection or USB port) using the serial cable. 

4. On the Device Manager bar, click Devices, then click Add Device. 

 

5. Click Manually add a new device, then click Next. 

6. Click Photic Device, then click Next. 

7. From the COM Port list, select a communication port, then click Next. 

8. Enter a name for the device (for example, Photic Device), then click Next. 

9. Click Finish. 

Installing a Composite Device* 
*Not available with the License free version of RemLogic 

A composite device is composed of more than one device (for example, Embla S4500 and 
video capture device), and must be manually added using the New Device wizard. 

To install a composite device: 

1. Open RemLogic. 

2. Open the Device Manager. 

mailto:Ottawa.TechSupport@natus.com
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3. On the Device Manager bar, click Devices, then click Add Device. 

 

The New device wizard displays. 

4. Select Manually add a new device (Advanced), then click Next. 

 

5. From the list of device types, select Composite Device, then click Next. 

 

6. Click Add. 

7. Select one of the available devices (for example, Embla), then click OK. 

8. Click Add again, then select an additional device (for example, video). 

9. Click OK. 

10. Type in a descriptive name for the new device (for example, Embla 2 with Video), then 
click Next. 

11. Click Finish to complete the wizard. 

A composite device icon  with the new name displays in the Device Manager to the left of the 
Operations Sheet. To view the properties of the composite device, right-click the device, then 
click Properties. 

Device Settings 

Setting the Download Options 

Ambulatory studies recorded with the Embletta, Embletta Gold, Embletta MPR and Embla 
titanium units have the option of setting the download options when setting up the device.  This 
helps with downloading recorded studies and transferring study data to a central network or 
local location.  To view the methods available for download, see Downloading Data. 

To access the download settings for your ambulatory device: 

1. On the View menu, point to Workspace, then click Devices. 

2. On the Device Manager bar, select Devices | Settings | [Ambulatory Device Name]. 
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3. Select the Options tab and modify to your desired configuration according to the table 
below. 

Available Option Description 

Download Data 
Location 

A text data field which contains a list of available data locations in 
RemLogic. When a study is downloaded, the study files will be saved 
to this data location.  The default data location is C:\RemLogic 
Recordings.  

Transform to EDF 
format 

If this item is checked, each downloaded study will be transformed to 
EDF format and saved. 

 

Note: If this option is selected, all button events will be lost 
upon download and conversion. 

Erase data from 
device after 
download 

If this item is checked, the study will be removed from the device 
storage after it has been downloaded. 

Transfer 
downloaded data 

If this item is checked, all downloaded data files will be transferred to 
a central location automatically. The central location can be a file 
folder on local machine, network, or on a FTP server.  The following 
options become available: 

Network/Local 
location 

Specifies the path of the transfer destination. This 
text field can be populated with the button on the 
right that displays a folder selection dialog and 
returns with a user selected folder. 

FTP site / User 
Name/Password 

Specifies an FTP site as the transfer 
destination.  From here you can enter your User 
Name which is your FTP account name. As well, 
you can enter your Password.  A “*” is displayed in 
the UI for each character that is entered. 

Coded folder 
name 

If this item is selected, the study will be transferred 
into a folder that is named with a numerical string 
rather than a patient’s name. See Coded Folders 
for additional information. 
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Available Option Description 

Human-
readable folder 
name 

If this item is selected, the study will be transferred 
into a folder that is named in a format that is 
defined in the text box located on the right. The 
four buttons on the bottom of this dialog can insert 
a formatting string into the format text box on the 
above line.  The formatting string will be added to 
the box in the order they are selected, but in 
reverse order.  For example, to get the following 
string “{Last Name}, {First Name}  {DD-MM-YY} 
[{Patient ID}]” you must select the Patient ID first, 
then the Start Time, Then the First Name, and 
finally the Last Name. 

The following characters are not permitted in this 
data field ‘\’, ‘/’, ‘:’, ‘*’, ‘?’, ‘"’, ‘<’, ‘>’, ‘|’.  See 
Human-Readable Folders for further information. 

Delete local copy 
after successful 
transfer 

If this item is checked, the downloaded study files will be deleted from 
the local download data location after they are transferred. This option 
is only available when the Transfer downloaded data check box is 
checked. 

Embletta 

In the Embletta Device Type Settings dialog box, you can edit Embletta proxy labels and select 
proxies used in the Recording Wizard. You can also indicate whether you want to use start and 
stop times from the last ambulatory study. If the start time would occur in the past, RemLogic 
adjusts the date that displays in the Recording Wizard to the next date in the future with the 
desired time. 

To modify the Embletta device type settings: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta to open the Embletta Device 
Type Settings dialog box. 

3. To modify the proxy label in the Proxies tab: 

a. Click the proxy, then click Edit. 

b. Type a new label description, then click OK. 

4. To make a proxy available in the Recording Wizard, select its check box. 

5. To omit a proxy from the Recording Wizard, clear its check box. 

6. Click OK. 

To use the start and stop times from the last ambulatory recording: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta to open the Embletta Device 
Type Settings dialog box. 
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3. Click the Recording tab. 

4. Select the Use last ambulatory study time setup check box. 

5. Click OK. 

Embletta Gold 

In the Embletta Device Type Settings dialog box, you can add, edit, or delete sensor definitions 
for the differential pressure sensor and a variety of DC sensors. You can also indicate whether 
you want to use start and stop times from the last ambulatory study. If the start time would occur 
in the past, RemLogic adjusts the date that displays in the Recording Wizard to the next date in 
the future with the desired time. Additionally, studies with multiple sessions display with the 
same between sessions as the previous study. 

To add or edit an Embletta Gold sensor definition: 

1. On the View menu, point to Workspace, and then click Devices. 

2. Click Devices, point to Settings, then click Embletta Gold. 

3. Do one of the following: 

 Click the sensor definition on which you want to base the new definition, then 
click New. 

 Click the sensor definition you want to edit, then click Edit. Proceed to step 6. 

4. In the Name box, enter a name for the sensor. 

5. Do one of the following: 

 If this definition is for a DC sensor, click DC. 

 If this is definition is for a differential pressure sensor, click Differential 
Pressure. 

6. Configure the sensor properties according to the following table: 

To Do This 

Modify the unit 
displayed. 

1. Click the General tab. 

2. Under Display, in the Unit box, type the unit type (for 
example, V, W). 

3. From the Sub-Unit list, select the subunit, if applicable. 

Modify the default 
range displayed. 

1. Click the General tab. 

2. Under Default Range, in the Min box, type the minimum 
value permissible. 

3. Under Default Range, in the Max box, type the maximum 
value permissible. 
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To Do This 

Modify the input 
signal voltage range. 

1. Click the Signal tab. 

2. Under Voltage Range, in the Min box, type the minimum 
value permissible. 

3. Under Voltage Range, in the Max box, type the maximum 
value permissible. 

4. From the Unit list, select a unit type. 

Add a signal type. 1. Click the Signal Types tab. 

2. Click Add. 

3. From the Signal Type list, select a signal type. 

4. Click OK. 

Transform the signal 
derived from the 
sensor by specifying 
a physical range. 

1. Click the Transform tab. 

2. Click Use physical range. 

3. Under Physical Range, select a unit type from the Unit list. 

4. In the Min box, type the minimum value permissible. 

5. In the Max box, type the maximum value permissible. 

Transform the signal 
derived from the 
sensor using the 
linear interpolation 
method. 

1. Click the Transform tab. 

2. Click Linear interpolation. 

3. Under Physical Range, select a unit type from the Unit list. 

4. In the Min box, type the minimum value permissible. 

5. In the Max box, type the maximum value permissible. 

6. Under Measured, double-click the cell, and type the 
measured voltage. 

7. Under Actual, double-click the cell, and type the actual 
voltage. The function pane updates accordingly. 

Transform the signal 
derived from the 
sensor using a 
predefined function. 

1. Click the Transform tab. 

2. Click Custom. 

3. Under Physical Range, select a unit type from the Unit list. 

4. In the Min box, type the minimum value permissible. 

5. In the Max box, type the maximum value permissible. 

6. Under f(x), enter a function defining the sensor signal 
transformation. 
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To delete an Embletta Gold sensor definition: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta Gold. 

3. Click the sensor definition you want to delete, then click Delete. 

4. Click Yes. 

To use the start and stop times from the last ambulatory recording: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta Gold to open the Embletta Gold 
Device Type Settings dialog box. 

3. Click the Recording tab. 

4. Select the Use last ambulatory study time setup check box. 

5. Click OK. 

Power Embla* 

*Not available with the License free version of RemLogic 

Use the Device Profile Editor to edit, create, and delete Device Profiles and Sensors for the 
Embla N7000 and Embla S4500 devices. 

To access the Device Profile Editor dialog: 

1. On the View menu, point to Workspace, then click Devices. 

2. On the Device Manager bar, select Devices | Settings | Embla Communication Unit 
or MDrive | Profile Editor. 

3. From the Device type list, select the device you want to view. 

Embletta MPR 

In the Embletta Device Type Settings dialog box, you can add, edit, or delete sensor definitions. 
You can also indicate whether you want to use start and stop times from the last ambulatory 
study. If the start time would occur in the past, RemLogic adjusts the date that displays in the 
Recording Wizard to the next date in the future with the desired time. Additionally, studies with 
multiple sessions display with the same between sessions as the previous study. 

To add or edit an Embletta MPR sensor definition: 

1. On the View menu, point to Workspace, and then click Devices. 

2. Click Devices, point to Settings, then click Embletta MPR. 

3. Click on the Sensors Tab, and select the sensor definition on which you want to base 
the new definition, then click New. 

4. In the Name box, enter a name for the sensor. 

5. From the drop-down menu, select the Type of signal it is: unipolar or bipolar 

6. Configure the sensor properties according to the following table: 
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To Do This 

Modify the default 
range displayed. 

1. Click the General tab. 

2. Under Default Range, in the Min box, type the minimum value 
permissible. 

3. Under Default Range, in the Max box, type the maximum value 
permissible. 

4. From the Unit list, select a unit type. 

Modify the input 
signal voltage range. 

1. Click the Signal tab. 

2. Under Voltage Range, in the Min box, type the minimum value 
permissible. 

3. Under Voltage Range, in the Max box, type the maximum value 
permissible. 

4. From the Unit list, select a unit type. 

Add a signal type. 1. Click the Signal Types tab. 

2. Click Add. 

3. From the Signal Type list, select a signal type. 

4. Click OK. 

Transform the signal 
derived from the 
sensor using the 
linear interpolation 
method. 

1. Click the Transform tab. 

2. Click Linear interpolation. 

3. Under Linear interpolation, select a unit type from the Unit list. 

4. Under Measured, double-click the cell, and type the measured 
voltage. 

5. Under Actual, double-click the cell, and type the actual voltage. 
The function pane updates accordingly. 

Transform the signal 
derived from the 
sensor using a 
predefined function. 

1. Click the Transform tab. 

2. Click Custom. 

3. Under Physical Range, select a unit type from the Unit list. 

4. Under f(x), enter a function defining the sensor signal 
transformation. 

To delete an Embletta MPR sensor definition: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta MPR. 

3. Click on the Sensors Tab, and select the sensor definition you want to delete, then click 
Delete. 

4. Click Yes. 



RemLogic™ 3.4            Instructions for Use 

35                     

To use the recording wizard to start recording: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta MPR to open the Embletta MPR 
Settings dialog box. 

3. Click the General tab. 

4. Select the Use Recording Wizard to start recording check box. 

5. Click OK. 

To use the start and stop times from the last ambulatory recording: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta MPR to open the Embletta MPR 
Settings dialog box. 

3. Click the General tab. 

4. Select the Use last ambulatory study time setup check box. 

5. Click OK. 

To remove notifications when downloading an existing study: 

1. On the View menu, point to Workspace, then click Devices. 

2. Click Devices, point to Settings, then click Embletta MPR to open the Embletta MPR 
Settings dialog box. 

3. Click the General tab. 

4. Select the Do not warn when downloading a recording which already exists check 
box. 

5. Click OK. 

Embla titanium* 

*Not available with the License free version of RemLogic 

Use the Titanium Settings dialog box to edit, create, and delete Device Profiles and Sensors for 
the Embla titanium device. 

To access the Titanium Settings dialog box: 

1. Open the Device Manager. 

2. On the Device Manager bar, select Devices | Settings | Embla titanium. 

To configure the Bluetooth adapter: 

1. Ensure the Embla titanium is connected to the collecting computer through the Bluetooth 
serial link. 

2. In the Device Manager, select Devices | Settings | Embla titanium. 

3. In the Titanium Settings dialog box, select the Bluetooth tab. 
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4. In the Select Addition Port section, confirm the port for the Bluetooth is listed in the 
Detected Ports list. If it is not, complete the following steps: 

 From the Available Ports drop-down list, select the port for the Bluetooth. 

 Click Add to move the port for the Bluetooth to the Selected Ports list. 

 

5. Click OK to close the Titanium Settings dialog box. If it detects the new Embla titanium 
device, the New Device Wizard opens. 

6. Click Next in the first page of the New Device Wizard. 

7. From the list of detected Embla devices, select Embla titanium, then click Next. 

8. Type a name for the device (for example, Wireless titanium), then click Next. 

9. Click Finish to complete the installation. 

Device Profiles* 

*Not available with the License free version of RemLogic 

A device profile defines which channels and signals the Embla devices will record. Device 
profiles are very flexible, and can include a wide range of sensor types. Device profiles are also 
commonly known as montages. 

Record with a default device profile installed with RemLogic, or create customized profiles. 

Default Device Profiles* 

Profiles assist you in performing typical sleep studies with various recording devices. RemLogic 
is installed with several device profiles, as outlined in the following table. 
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Profile Description Device 

Embla 32 
Channel EEG / 
MDrive 32 
Channel EEG 

A referential 32 channel EEG profile for the Embla 
N7000. The profile has one EKG channel assigned to 
input channel 1 on the Bedside Unit (bipolar channel). 
X1 is used as a common reference. 

Embla N7000 

Embla N7000 
PSG / MDrive 
N7000 PSG 

Standard PSG profile for the N7000 system. Includes 
all channels needed for a routine PSG recording: EEG 
(M1, M2, F3, F4, C3, C4, O1, O2), EOG (E1, E2), Chin 
EMG (left, right, Upper midline), Limb EMG (right and 
left tibialis), EKG, respiratory effort (abdomen and 
thorax), nasal pressure, thermistor, snore, position, 
oxygen saturation, pulse, and plethysmogram. X1 is 
used as a common reference. 

Embla N7000 

Embla Photic 
EEG 

Referential 32 channel EEG profile. One EKG channel 
assigned to input channel 1 on the bedside unit 
(bipolar channel) for photic. X1 is used as a common 
reference. 

Embla N7000 

Embla S4500 
PSG/ MDrive 
S4500 PSG  

Standard PSG profile for the S4500 system. This 
profile includes all channels needed for a routine PSG 
recording: EEG (M1, M2, F3, F4, C3, C4, O1, O2), 
EOG (E1, E2), Chin EMG (left, right, Upper midline), 
Limb EMG (right and left tibialis), EKG, respiratory 
effort (abdomen and thorax), nasal pressure, 
thermistor, snore, position, oxygen saturation, pulse, 
and plethysmogram. 

Embla S4500 

Routine PSG Standard PSG profile for the titanium system. Includes 
all channels needed for a routine PSG recording: EEG 
(M1, M2, F3, F4, C3, C4, O1, O2), EOG (E1, E2), Chin 
EMG (left, right, Upper midline), Limb EMG( right and 
left tibialis), EKG, respiratory effort (abdomen and 
thorax), nasal pressure, thermistor, snore, position, 
oxygen saturation, pulse, and plethysmogram. 

Embla titanium 

Basic PSG Standard PSG profile for the titanium system. Includes 
the following channels for PSG recording: EEG (M1, 
M2, C3, C4, O1, O2), EOG (E1, E2), EMG (submental, 
right and left tibialis), EKG, respiratory effort (abdomen 
and thorax), nasal pressure, thermistor, snore, 
position, oxygen saturation, pulse, and 
plethysmogram. 

Embla titanium 

PAP Titration Includes the following 26 channels for recording: EEG 
(M1, M2, F3, F4,C3, C4, 01, 02); EOG (E1, E2); 
ChinR, ChinL, ChinA; EKG; left and right leg; snoring; 
CPress; CFlow; respiratory effort (abdomen and 
thorax); differential pressure; plethysmogram; position; 
oxygen saturation; and heart rate. 

Embla titanium 
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Profile Description Device 

Photic EEG Includes the following 25 channels for recording: F3, 
F4, C3, C4, 01, 02, A1, A2; EOG (E1, E2); ChinR, 
ChinL, ChinA; EKG; left and right leg; thermistor; 
snoring; respiratory effort (abdomen and thorax); nasal 
pressure; plethysmogram; position; oxygen saturation; 
and heart rate. 

Embla titanium 

Embla titanium Device Profiles* 
*Not available with the License free version of RemLogic 

In the Titanium Settings dialog box, you can create and add new device profiles to the list of 
profiles for selection when starting a recording. You can create any number of profiles. Creating 
your own profiles can save you from customizing the profiles each time you start a recording in 
the Recording Wizard. In the profile, you can determine which channels to record and what 
sensors to use. When you first open the Device Profile Editor dialog, only the default device 
profile displays. This profile can be edited. 

Viewing a Device Profile* 

To view a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, select Devices | Settings | Embla titanium. 

3. Double-click the profile you want to view. 

Creating a Device Profile* 

To create a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, select Devices | Settings | Embla titanium. 

3. Click New. 

4. Click the General tab. 

5. In the Name box, enter a name for the profile. 

6. Modify the profile settings as required. 

7. Click OK. 

Editing a Device Profile* 

To create/edit a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, select Devices | Settings | Embla titanium. 

3. To edit an existing profile, select the appropriate profile in the Device Profile tab, then 
click Edit. 
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4. In the General tab of the Embla titanium Device Profile Properties dialog box, modify 
the profile settings as required: 

 In the Name box, edit the name of the new profile (optional). 

 To add or remove a channel from the profile, select or clear the appropriate check 
box. 

 To rename a channel, select it, then click the label name (for example, F3). Type a 
new label name, then press ENTER. 

 To modify the sensor or signal selection, select the appropriate item, click the 
drop-down arrow, then select a new item. 

 To enter a comment or description to a sensor item, select it, then click the 
Comments column cell. 

5. Click OK. 

 

Note: If a channel program and sensor are incompatible, a message displays, and the 
profile will not save. Incompatible sensors are highlighted in red. Modify the sensors or 
channel program, then click OK. To view a summary of the profile, click the Info tab. 

General Tab Properties 

Property Description/Procedure 

Label The channel label identifies the trace on the screen. The label column contains 
an on/off check box and the channel label. Select or clear the check box to 
indicate if data is to be recorded on that channel. The channel label is user-
definable. All label names must be unique, otherwise the recording template 
cannot save. Keep the names short and descriptive. To change the label, 
select the desired channel, then click on the label field. A box in which you can 
type the new label displays. You can also automatically assign EEG labels. 
Selecting the sensor, signal, and reference first automatically completes the 
label field. To avoid the software from automatically overwriting the label, press 
CTRL while selecting the signal type. 

Sensor Displays the sensor type to be used on the designated channel. To choose a 
different sensor type, select the appropriate channel. Click the arrow   next to 
the sensor name and select a sensor from the context menu. 

Channel 
Displays the number of channels supported by the recording device. The 
numbering indicates the system channel capacity, and does not reflect the 
ordering of the traces displayed on the screen during online recording or 
review. Display preferences, such as channel spacing and channel order, are 
managed by Workpad Sheets. If the order of channels, spacing, colors, or 
settings should be different, Workpad Sheets can be modified to accommodate 
individual preferences. 
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Property Description/Procedure 

Signal Once a sensor type is selected, the signal drop-down menu will reflect all 
available signal options for the selected sensor, and displays a default signal 
type in the Signal column. To change the signal type, click the arrow   next to 
the signal type and select a signal from the menu. The signal type is used by 
the analysis tools to locate the data they require. For example, the sleep apnea 
analysis requires a sensor with the signal type Resp-Flow Cannula Nasal to 
locate the nasal cannula airflow signal. All inputs using the same main sensor 
type have the same sampling rate. Although sampling rates can be very 
different from one sensor type (flow) to another (EEG), maintaining the same 
sampling rate within a sensor group allows re-referencing. 

Comments To add or edit a comment, select the appropriate channel and click the 
comment. A box displays where you can type a comment. For example, you 
can use this field to write notes about where to place the sensors. 

Connect 
Channel 25 to 
ISO Box 

This option is selected if the optional titanium DC Isolation Box was connected 
to the titanium for recording data from devices using mains power (AC Power) 
on Channel 25. 

Connect 
Channel 26 to 
ISO Box 

This option is selected if the optional titanium DC Isolation Box was connected 
to the titanium for recording data from devices using mains power (AC Power) 
on Channel 26. 

Deleting a Device Profile* 

To delete a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, click Devices, point to Settings, then click Embla 
titanium. 

3. Click the profile you want to delete, then click Delete. 

4. Click Yes. The profile is removed from the Device Profile list and the Embla Recording 
Wizard. 

5. Click OK. 

Power Embla Device Profiles* 
*Not available with the License free version of RemLogic 

This information applies to the Embla N7000 and Embla S4500. 

New device profiles can be created and added to the list of profiles for selection when starting a 
recording. You can create any number of profiles. Custom profiles save you from having to 
customize the profiles each time a recording is started in the Recording Wizard. In the profile, 
you can determine which channels to record, what sensors to use, whether to run an impedance 
test and the calibration test signal, and so on. Existing device profiles, except the default 
profiles, can also be edited. Profiles can be created for routine study types, quick start, and 
studies requiring special sensors or additional channels. 
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Tip: Power Embla default profiles are write-protected and cannot be viewed or edited. 
To view the properties of a default profile, select the profile, then click Clone. Cloned 
versions are exact copies of the original that can be viewed and edited. 

Viewing a Device Profile* 

To view a device profile, you must clone it. For more information, see Cloning a Device Profile. 

To view a device profile: 

1. On the View menu, point to Workspace, then click Devices. 

2. In the Device Manager, click Devices, point to Settings, then click Embla 
Communication Unit. 

3. From the Device type list, select the device. 

4. Do one of the following: 

 If you previously cloned a profile, proceed to step 5. 

 If you have not previously cloned the profile, click it, then click Clone. 

5. Click the cloned profile, then click Edit. 

Cloning a Device Profile* 

This information applies to the Embla N7000 and Embla S4500. 

Copies can be made of default and customized profiles. Power Embla default profiles are write-
protected and cannot be viewed or edited. Cloning a default device profile creates an exact 
copy or clone that can be renamed and edited. 

To clone a device profile: 

1. On the View menu, point to Workspace, then click Devices. 

2. In the Device Manager, click Devices, point to Settings, then click Embla 
Communication Unit. 

3. From the Device type list, select the device. 

4. In the pane below, click the profile, then click Clone. 

5. Click Close. 

Editing a Device Profile* 

To edit a device profile: 

1. On the View menu, point to Workspace, then click Devices. 

2. In the Device Manager, click Devices, point to Settings, then click Embla 
Communication Unit. 

3. From the Device type list, select the device. 

4. In the pane below, click the profile, then click Edit. 
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5. Define the properties of device profile. The following describes applicable tabs for each 
device: 

 Embla N7000: General, Unipolar, Bipolar, Auxiliary, Patient Unit, Photic 

 Embla S4500: General, Unipolar and Resp, Bipolar, Auxiliary, Oximeter 

The profile is saved and added to the list of device profiles in the Recording Wizard. 

Power Embla PSG Properties Dialog Tabs* 

General Tab 

Use the General tab to create a new profile name and description. If you are editing an existing 
profile, you can change the description on this tab. 

General Tab Properties 

Property Description/Procedure 

Name Type a descriptive name for the device profile. 

Description (Optional) Write a description of the profile in this field—for example, 
what channels will be recorded. This information displays in the 
Recording Wizard. 

Allow impedance test By default, this option is selected to allow for electrode impedance 
testing. If it is not be possible to perform an impedance test—for 
example, in the case of patients with pacemakers—the clear the check 
box. 

Perform impedance 
test at the start of the 
recording 

By default, this option is selected so an electrode impedance test starts 
automatically each time a recording is started or resumed. Clear the 
check box if you do not want to automatically perform an impedance test 
at the start of each recording. 

Allow calibration test 
signal 

By default, this option is selected so a calibration test signal can be 
activated to verify the gain for the Bedside Unit channels. Clear the 
check box if it should not be possible to activate the calibration test 
signal. 

Run the calibration 
test signal at the 
start of the recording 

Check this box to automatically activate the calibration test signal at the 
beginning of each recording. 

Unipolar Tab 

Applies to the Embla N7000. 

Use the Unipolar tab to select which unipolar channels to record and to modify channel 
properties (such as label, signal type, and sampling rate). 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 
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Unipolar and Resp Tab 

Applies to the Embla S4500. 

Use the Unipolar and Resp tab to select which unipolar and respiratory channels to record and 
to modify channel properties (such as label, signal type, and sampling rate). 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 

Bipolar Tab 

Applies to the Embla N7000 and Embla S4500. 

Use the Bipolar tab to select which bipolar channels to record and to modify channel properties 
(such as label, signal type, and sampling rate). 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 

Auxiliary Tab 

Applies to the Embla N7000 and Embla S4500. 

Use the Auxiliary tab to select which auxiliary channels to record and to modify channel 
properties (such as label, signal type, and sampling rate). 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 

Photic Tab 

Applies to the Embla N7000. 

Use the Photic tab to modify channel properties (label, signal type, and sampling rate). When 
the photic stimulator is activated, a corresponding trace appears. The trace has a value of 1 if 
the photic stimulator is on, and a value of 0 if the photic stimulator is off. 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 

The default Embla profiles are write-protected and cannot be edited. 

Patient Unit Tab 

Applies to the Embla N7000. 

Use the Patient Unit tab to select which channels should be recorded with the Patient Unit and 
to modify channel properties (such as label, signal type, and sampling rate). 

 Select Proxy: Identifies which proxy to use in the recording. Click the arrow  to select 
a proxy from the list. 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 
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Oximeter Tab 

Applies to the Embla S4500. 

Use the Oximeter tab to select which oximeter channels to record and to modify channel 
properties (such as label, signal type, and sampling rate). 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 

Deleting a Device Profile* 

This information applies to the Embla N7000 and Embla S4500. 

Deleting a device profile removes it from the Device Manager and Recording Wizard. 

To delete a device profile: 

1. On the View menu, point to Workspace, then click Devices. 

2. In the Device Manager, click Devices, point to Settings, then click Embla 
Communication Unit. 

3. From the Device type list, select the device. 

4. In the pane below, click the profile, then click Delete. 

5. Click Yes. 

6. Click OK. 

Power Embla Channel Properties* 
*Not available with the License free version of RemLogic 

This information applies to the Embla N7000 and Embla S4500. 

In the Device Profile Editor dialog, you can modify the channel properties of Power Embla 
profiles. 

 

Note: Because default profiles are write-protected, you must make a copy or clone 
before editing the properties. See Cloning a Device Profile for more information. 

Embla N7000* 

You can modify the channel properties on the tab sheets of the Profile Properties dialog. 

To change channel properties: 

1. On the View menu, point to Workspace, then click Devices. 

2. In the Device Manager, click Devices, point to Settings, then click Embla 
Communication Unit. 

3. From the Device type list, select a profile. 

4. In the pane below, click a profile, then click Edit. Because default profiles are write-
protected, you must make a copy or clone before editing the properties. See Cloning a 
Device Profile for more information. 
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5. Click the tab containing the channel. 

6. Double-click the channel. 

 

The Channel Properties displays according to the selected channel. 

7. Modify the settings according to the following table. 

Channel Properties 

Property Description/Procedure 

Label The channel label identifies the trace on the screen. All label names must be 
unique, otherwise the device profile cannot be saved. It is important to keep 
the names short and descriptive. Ensure that no two channels have the 
same label name. 

Sensor Selects the sensor type to be used on the designated channel. Click , and 
select a sensor from the list. 

Signal Type Once a sensor type is selected, the signal drop-down context menu reflects 
all available signal options for the selected sensor. To change the signal 
type, click , and select a signal from the list. Make sure that the sensor and 
signal type are correct. The analysis tools use the signal type to locate the 
data they require. For example, the sleep apnea analysis looks for a sensor 
with the signal type Resp-Flow Cannula Nasal to locate the nasal cannula 
airflow signal. 

Sampling Rate The sampling rate drop-down context menu reflects the sensor and device 
type selected. For example, an EEG sensor can be sampled at 2000Hz (on 
1-2 channels (max)), with 500Hz as the highest rate on the remaining inputs) 
with the Embla N7000. Click , and select a different sampling rate from the 
list. 

Reference Unipolar signals are measured against a common reference. Correct 
references are essential for re-referencing traces. Select this check box if the 
channel should be used as a reference. If more than one channel is defined 
as the reference, the average of these channels is used. For example, if M1 
and M2 are defined as the reference, the average signal of both channels 
are used as the actual reference. 
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Embla S4500* 

To change channel properties: 

1. On the View menu, point to Workspace, then click Devices. 

2. In the Device Manager, click Devices, point to Settings, then click Embla 
Communication Unit. 

3. From the Device type list, select a profile. 

4. In the pane below, click a profile, then click Edit. Because default profiles are write-
protected, you must make a copy or clone before editing the properties. See Cloning a 
Device Profile for more information. 

5. Click the tab containing the channel. 

6. Double-click the channel. 

 

The Channel Properties displays according to the selected channel. 

7. Modify the settings according to the following table. 

Channel Properties 

Property Description/Procedure 

Label The channel label identifies the trace on the screen. All label names must be 
unique, otherwise the device profile cannot be saved. It is important to keep 
the names short and descriptive. Ensure that no two channels have the 
same label name. 

Sensor Selects the sensor type to be used on the designated channel. Click the 
arrow , and select a sensor from the list. 

Signal Type Once a sensor type is selected, the signal drop-down context menu reflects 
all available signal options for the selected sensor. To change the signal 
type, click the arrow , and select a signal from the list. Make sure that the 
sensor and signal type are correct. The analysis tools use the signal type to 
locate the data they require. For example, the sleep apnea analysis looks for 
a sensor with the signal type Resp-Flow Cannula Nasal to locate the nasal 
cannula airflow signal. 

Sampling Rate The sampling rate drop-down context menu reflects the sensor and device 
type selected. The highest sampling rate available is 500Hz. Click the arrow 

, and select a different sampling rate from the list. 
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Embla S4500 devices have a fixed reference channel. See the Embla S4500 Clinical Manual for 
more information. 

Embletta MPR Device Profiles 

In the Embletta MPR Settings dialog box, you can create and add new device profiles to the list 
of profiles for selection when starting a recording. You can create any number of profiles. 
Creating your own profiles can save you from customizing the profiles each time you start a 
recording in the Recording Wizard. In the profile, you can determine which channels to record 
and what sensors to use. When you first open the Device Profile Editor dialog, the default 
device profiles are the only profiles which display. There are seven Embletta MPR default 
device profiles provided with the RemLogic software.  These profiles can be edited. 

 EB MPR – Autostart no Audio 

 EB MPR – Scheduled Audio 

 EB MPRPG – Ambulatory Autostart no 
Audio 

 EB MPRPG – Ambulatory Scheduled 
with Audio 

 EB MPRPG – Online with Audio 

 EB MPR-ST – Ambulatory 

 EB MPR-ST+ – Online 

Viewing a Device Profile 

To view a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, select Devices | Settings | Embletta MPR. 

3. Double-click the profile you want to view. 

Creating a Device Profile 

To create a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, select Devices | Settings | Embletta MPR. 

3. Click New. 

4. Click the General tab. 

5. In the Name box, enter a name for the profile. 

6. If desired, type a description for your profile in the Description box. 

7. Modify the profile settings as required.  The following tabs are available and can be used 
for defining the properties of the device profile: General, Base/PG Unit, Tx Proxy, ST / 
ST+, and Ambulatory Recording. 

8. Click OK. 



Instructions for Use                 RemLogic™ 3.4 

               48 

Editing a Device Profile 

To edit a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, select Devices | Settings | Embletta MPR. 

3. To edit an existing profile, select the appropriate profile in the Device Profile tab, then 
click Edit. 

4. Define the properties of device the profile. The following tabs are available and can be 
used for defining the properties of the profile: General, Base/PG Unit, Tx Proxy, ST / 
ST+, and Ambulatory Recording. 

5. Click OK. 

The profile is saved and added to the list of device profiles in the Recording Wizard. 

Deleting a Device Profile 

To delete a device profile: 

1. Open the Device Manager. 

2. On the Device Manager bar, click Devices, point to Settings, then click Embletta MPR. 

3. Click the profile you want to delete, then click Delete. 

4. Click Yes. The profile is removed from the Device Profile list and the Embla Recording 
Wizard. 

5. Click OK. 

Embletta MPR Properties Dialog Tabs 

In the Embletta MPR Properties Dialog box, you can modify your desired profiles to reflect the 
needs of your lab.  To access the Embletta MPR Properties Dialog box, you need only select 
either New or Edit from the Device Profile Editor. 

General Tab Properties 

Use the General tab to create a new profile name and description. If you are editing an existing 
profile, you can change the description on this tab. 

Property Description/Procedure 

Name Type a descriptive name for the device profile. 

Description (Optional) Write a description of the profile in this field—for 
example, what channels will be recorded. This information 
displays in the Recording Wizard. 
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Property Description/Procedure 

Perform Automatic 
Impedance Test 

Select the check box if you want to automatically perform the 
impedance test at the beginning of each recording. This option is 
only available if the Embletta MPR PG unit is being used and is 
selected under the Base/PG Unit tab. 

 Ambulatory  Studies – The test begins after 90 seconds of 
recording and lasts for 30 seconds. 

 Online Studies – The test begins after 120 seconds of 
recording and lasts for 30 seconds. 

Perform Automatic 
Calibration Test 

Select the check box if you want to automatically perform the 
calibration test at the beginning of each recording.  This option is 
only available if the Embletta MPR PG unit is being used and is 
selected under the Base/PG Unit tab.  

 Ambulatory Studies – The test begins after 30 seconds of 
recording and lasts for 30 seconds. 

 Online Studies – The test begins 30 seconds after the 
start of recording and lasts for 60 seconds. 

Display patient initials on 
MPR device 

By selecting this check box, only the patient’s initials will be 
shown on the LCD display screen during both online and 
ambulatory studies.  

Download Audio Select the check box to download the audio collected with the 
Embletta MPR unit. 

Base/PG Unit Tab Properties 

Use the Base/PG Unit tab to select which channels to record and to modify channel properties 
(such as label, signal type, and sampling rate). 

 Select one of the following buttons to determine which type of channels/profile the 
Embletta MPR study will use as a basis for collection:  

To perform: Select: 

An ambulatory study with an Embletta MPR base unit. Embletta MPR – Ambulatory 

An ambulatory study with an Embletta MPR PG unit (with 
or without a TX Proxy Unit or ST/ST+ Proxy). 

Embletta MPR PG – Ambulatory 

An online* study using the TX Proxy Unit (with or without 
an ST/ST+ Proxy). 

*This option is only available in the licensed version of RemLogic. 

Embletta MPR PG – Online* 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 
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Channel Properties 

Property Description/Procedure 

Label The channel label identifies the trace on the screen. All label names 
must be unique, otherwise the device profile cannot be saved. It is 
important to keep the names short and descriptive. Ensure that no two 
channels have the same label name. 

Sensor Selects the sensor type to be used on the designated channel. Click  , 
and select a sensor from the list.  

Signal Type Once a sensor type is selected, the signal drop-down context menu 
reflects all available signal options for the selected sensor. To change 
the signal type, click  , and select a signal from the list. Make sure 
that the sensor and signal type are correct. The analysis tools use the 
signal type to locate the data they require. For example, the sleep 
apnea analysis looks for a sensor with the signal type Resp-Flow 
Cannula Nasal to locate the nasal cannula airflow signal. 

  

TX Proxy Tab Properties 

Use the TX Proxy tab to select which DC channels to record and to modify channel properties 
(such as label, signal type, and sampling rate). If the Embletta MPR – Ambulatory button is 
selected in the Base/PG Unit Tab this tab will be unavailable. In the license free version of 
RemLogic, this tab is only available when the TX Proxy is used in an ambulatory study. Online 
recording is available in the licensed version of RemLogic only.  See License Management for 
more information. 

 Select the Use TX Proxy check box to use the TX Proxy. 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 

 To use a ResMed Therapy device or to collect Differential Pressure, select the 
appropriate check box. Currently, this will only work with the ResMed S8 or S9.  All other 
ResMed therapy devices may have issues when used with the Embletta MPR paired 
with the TX Proxy. 

 

Note: If using the TX Proxy Unit with the ResMed Tx Link, the ResMed Therapy 
Device setting should be disabled.  To disable this setting: open the profile being used 
or create a new one; browse to the TX Proxy tab; and clear the check box next to 
ResMed Therapy Device.  See Creating a Device Profile or Editing a Device Profile 
for further details. 

ST/ST+ Tab Properties 

Use the ST/ST+ tab to select which additional channels to record and to modify channel 
properties (such as label, signal type, and sampling rate). If the Embletta MPR – Ambulatory 
button is selected in the Base/PG Unit Tab this tab will be unavailable. In the license free 
version of RemLogic, this tab is only available when the ST/ST+ Proxy is used in an ambulatory 
study. Online recording is available in the licensed version of RemLogic only.  See License 
Management for more information. 
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 Select the Use ST/ST+ check box to use the ST or ST+ Proxy. 

 Select the type of Proxy being used by clicking on the radio button beside it.  The ST 
Proxy collects up to 8 additional channels; and the ST+ Proxy can collect up to an 
additional 16 channels. 

 Channels on which data will be recorded have a check mark in the ID column. 

 Double-click any channel to change its properties. 

Channel Properties 

Property Description/Procedure 

Label The channel label identifies the trace on the screen. All label names 
must be unique, otherwise the device profile cannot be saved. It is 
important to keep the names short and descriptive. Ensure that no two 
channels have the same label name. 

Sensor Selects the sensor type to be used on the designated channel. Click , 
and select a sensor from the list.  

Signal Type Once a sensor type is selected, the signal drop-down context menu 
reflects all available signal options for the selected sensor. To change 
the signal type, click , and select a signal from the list. Make sure that 
the sensor and signal type are correct. The analysis tools use the 
signal type to locate the data they require. For example, the sleep 
apnea analysis looks for a sensor with the signal type Resp-Flow 
Cannula Nasal to locate the nasal cannula airflow signal. 

  

 

Note: The C3 and C4 sensors on the ST Proxy are referenced to M2 internally and 
should not be re-referenced in the profile or software setup. 

Ambulatory Recording Tab Properties 

Use the Ambulatory Recording tab to modify the ambulatory study settings. If the Embletta 
MPR PG – Online button is selected under the Base/PG Unit Tab, this tab will be 
unavailable.  The information from this tab will only be used when the Use last ambulatory 
study time setup on the General Tab of the Embletta MPR Settings dialog is unchecked.  See 
Device Settings | Embletta MPR for details on changing this setting. 

Property Description/Procedure 

Start Automatically Select this radio button to begin the study once the unit has been 
unplugged from the computer and the Oximetry senor or XactTrace 
belts begin to send a valid signal. 

Use Start and Stop 
Time 

Selects this radio button to set a specific start and stop time for each 
ambulatory study.  To activate a start/stop time, select the check box to 
the left of the start date.  

 Pre-set the Start date, Start Time, Stop time, or Duration for all 
studies using this profile. 

 Setup multiple studies which will automatically be added to the 
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Property Description/Procedure 

device when using this profile. If the check box next to the 
start/stop time is deselected, the start/stop time will not be used 
for the ambulatory recording. 

 Program up to three (3) start/stop times for an ambulatory 
Embletta MPR or Embletta MPR PG unit.  For an ambulatory 
study with the TX Proxy Unit, only two (2) start/stop times can 
be programmed.  For an ambulatory study with the ST/ST+ 
Proxy, only one (1) start/stop time can be programmed. 

 

Note: The maximum duration of an ambulatory study with the 
TX Proxy Unit is eight (8) hours.  For an ambulatory study 
using the ST/ST+ Proxy, the maximum study duration is 10 
hours. 

Embletta MPR Channel Properties 

In the Device Profile Editor dialog, you can modify the channel properties of Embletta MPR 
profiles. You can modify the channel properties on the tab sheets of the Profile Properties 
dialog. 

To change channel properties: 

1. On the View menu, point to Workspace, then click Devices. 

2. In the Device Manager, click Devices, point to Settings, then click Embletta MPR. 

3. From the Device Profile list, select a profile and then click Edit. 

4. Click one of the following tabs depending on the desired channels: 

 Base/PG Unit Tab 

 TX Proxy Tab 

 ST/ST+ Tab 

 

5. Double-click the channel.  The Channel Properties Dialog displays according to the 
selected channel. 
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6. Modify the settings according to the following table: 

Channel Properties 

Property Description/Procedure 

Label The channel label identifies the trace on the screen. All label names must be unique, 
otherwise the device profile cannot be saved. It is important to keep the names short 
and descriptive. Ensure that no two channels have the same label name. 

Sensor Selects the sensor type to be used on the designated channel. Click  , and select a 
sensor from the list. 

Signal 
Type 

Once a sensor type is selected, the signal drop-down context menu reflects all 
available signal options for the selected sensor. To change the signal type, click  , 
and select a signal from the list. Make sure that the sensor and signal type are 
correct. The analysis tools use the signal type to locate the data they require. For 
example, the sleep apnea analysis looks for a sensor with the signal type Resp-Flow 
Cannula Nasal to locate the nasal cannula airflow signal. 

Configuration File Setup* 
*Not available with the License free version of RemLogic 

The RemLogic configuration settings and configuration files, such as event definitions and 
device sensor definitions, can be exported to a central location, and then imported from that 
location by RemLogic onto another machine.  This will enable all beds to be running the same 
configuration settings and files without having to recreate them on each individual machine. 

 

Note: If you run the export/import without first setting up the Configuration File 
Location, the default import location will be set to “C:\Embla Config.” 

Set up Configuration File Location* 

In order to export or import the configuration files, you will first need to define a central file 
location. 

To define the configuration file location: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click on Advanced or single-click the “+” beside it. 

3. In the left pane, single-click on Miscellaneous. 

4. In the right pane, type the destination of the desired Workspace into the Configuration 

Files data field or single-click on the ellipses  to the right of the data field to browse 
to the location manually.  
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Export Configuration Files* 

Once the central file location has been defined for the configuration files, you can export the 
existing files to that location. 
 

 

Note: The import/export feature does not include the automatic backup section or data 
locations under this section.  These will need to be configured on each system 
manually. 

 

To export configuration files: 

1. On the File menu, click Export, and then click Configuration.... 

2. Select the configuration files that you would like to export by selecting the check boxes 
next to the available options: 

Export option: Description: 

Sheet templates and 
Workspaces 

Exports all of the available sheet templates and 
Workspaces. 

Event and signal types, 
event groups 

Exports event and signal types as well as event groups. 

Analysis and Association 
settings 

Exports the Analysis and Association settings. 

Custom Reports Exports all custom reports. 

Options Settings Exports the options settings. 

Device Configuration Files Exports the configuration files for the selected device.  The 
listed devices are dependent on the types of devices 
currently installed on the system.  Depending on the 
selected device you have the option to export the Sensor 
definition files or the Profiles by checking the appropriate 
box. 

You can export all available device types by selecting the 
data item – All Device Types. 

3. Once the selections have been made, you can begin the export by clicking OK.  To 
cancel the export, click Cancel. 

 

Note: Running the export/import for the configuration files will overwrite any existing 
files in the destination folder.  

4. Once the OK button has been selected, a warning dialog box will be displayed 
confirming the overwriting of the existing files. 

 Click Yes to continue.   

 Click No to cancel the export and return to the Export configuration Files dialog. 
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5. A second confirmation message is displayed when the Yes button has been selected. 

 Click Yes to continue and remove the existing configuration files from the 
destination folder and replace them with the currently selected groups of files. 
With this selection, the files from the destination folder are deleted permanently 
prior to placing the exported files into the empty folder. 

 Click No to keep the files that were not overwritten in the export of the new 
files.  With this option, only the selected groups of files are replaced with the new 
files.  

6. Click OK.  The selected file groups will be copied to the following sub-folders under the 
destination folder as setup in the Configuration File Location. 

File Group Folder/File Name in Configuration File 
Location 

Sheet templates and Workspaces Sheet Templates 

Event and signal types, event groups EventSignalSettings 

Analysis and Association settings AnalysisSettings 

Reports Reports 

Options Settings Settings\SettingsRegistryFile.reg 

Settings\[referenced file name] 

Sensor Definition Files Titanium Titanium Sensors 

Embletta EmblettaGold Sensors 

MDrive MDrive Sensors 

Profiles Titanium Titanium Profiles 

Embletta N/A 

MDrive MDrive Profiles 

Import Configuration Files* 

To import configuration files: 

1. On the File menu, click Import, and then click Configurations. 

2. Select the configuration files that you would like to export by selecting the check boxes 
next to the desired options.  The options that are available are the same as with the 
export process.  See Step #2 under Configuration File Location for further information. 

3. Once the selections have been made, you can begin the import by clicking OK.  To 
cancel the import, click Cancel. 

 

Note: Running the export/import will overwrite the existing RemLogic configuration 
files with the selected files.  
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4. Once the OK button has been selected, a warning dialog box will be displayed 
confirming the overwriting of the existing files.  Do one of the following: 

 Click Yes to continue.   

 Click No to cancel the import and return to the Import Configuration Files dialog. 

5. When the Yes button is selected, a second confirmation message is displayed.  Click 
OK and restart RemLogic to ensure the changes take effect. 

 

Note: If you run the export/import without first setting up the Configuration File 
Location, the default import location will be set to “C:\Embla Config.” 

  

 

Note: The import/export feature does not include the automatic backup section or data 
locations under this section.  These will need to be configured on each system 
manually. 
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Work Environment 
When the application is installed, a RemLogic icon displays on your desktop. Starting RemLogic 
displays the application start window. 

 

1 Toolbars RemLogic toolbars allow you to change the appearance of the 
work environment, view trace information, insert and search for 
events, control and play back recordings, and manipulate traces 
within Workpad Sheets. For more information, see RemLogic 
Toolbars. 

2 Recording Manager The Recording Manager, located in the Workspace Area, 
provides an overview of recording folders and files, sorted 
alphabetically by patient name, or chronologically by recording 
date. For more information, see Recording Manager. 
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3 Event Palette The Event Palette allows you to select and mark events on a 
Workpad Sheet with a single mouse click or keystroke, navigate 
between events or event associations marked in the 
Workpad.  The licensed version of RemLogic also allows you to 
insert and navigate between tech notes. For more information, 
see Event Palette. 

4 Analysis Settings 
Manager 

The Analysis Settings Manager allows you to select default or 
custom settings for computer assisted analysis and customize 
analysis parameters. For more information, see Analysis Settings 
Manager. 

5 Device Manager The Device Manager monitors recording devices, and allows you 
to add and identify new recording devices using the New Device 
Wizard. For more information, see Device Manager. 

6 Operations and 
Workpad Sheets 

Workpad Sheets display recorded signals and visual data 
settings, including the time interval, axis values, filters, trace 
number, sequence, and color. Events are marked on Workpad 
Sheets. For more information, see Workpad Sheets. 

Operations Sheet 

The Operations sheet, RemLogic's action sheet, displays by default you open the application. 

 
RemLogic Operations Sheet, displaying patient information. 

 
RemLogic License free Operations Sheet 

Operations sheet buttons, including Patient Information, Device Control, Prepare Recorder, 
Download Data, Analysis, Reporting and Data Management (for Enterprise users), provide 
access to main functions. The buttons are blue when active, and gray when inactive. 
 

Button Description 

Patient Information Opens the Patient Information dialog box, in which you can add and edit 
patient demographic/biometric details. 



RemLogic™ 3.4            Instructions for Use 

59                     

Button Description 

Device Control* 

*Not available with the 
License free version of 
RemLogic 

Opens the Device Control panel, from which you can select a recording 
device, start, stop, and resume recordings, and download and transfer 
data. This button is available after you enter information on the patient 
undergoing the sleep study. 

Prepare Recorder 

Only available with the 
License free Version of 
RemLogic  

Opens the Device Control panel, from which you can select a recording 
device, and prepare it for ambulatory studies.  This button is available 
after you enter information on the patient undergoing the sleep study. 

Download Data 

Only available with the 
License free Version of 
RemLogic 

Downloads the selected study from the recorder to your active recordings 
folder.  Using this download option does not open a Workspace. 

Analysis Opens the Analysis panel, from which you can select and perform the 
computer assisted analysis of recorded data using the Respiration 
Analyzer and PLM Analyzer. Additional analyzers are available in the 
Analysis menu in the menu bar. See Analyzing Data for a list of 
RemLogic's analyzers. 

Reporting 

Items marked with an “*” 
are not available with the 
License free Version of 
RemLogic 

Opens the Reporting panel, from which you can select and create the 
following reports: Polysomnography*, Polygraphy (Respiration and 
Oximetry), Split Night*, PLM, MSLT*, Titration Report PSG*, and 
Technote. 

Data Management Opens the Data Management panel, from which you can retrieve patient 
and study information and publish scored sleep studies. Available to 
users with an Embla Enterprise license. 

The Operations Sheet contains a Patient Information box, which is empty until you click 
Patient Information and enter information. When you open a data folder with recorded data, 
the box displays the name and ID of the relevant patient. 

You can retrieve information on scheduled patients, publish scored sleep studies, and search on 
the published data by clicking Data Management. 

The Operations sheet tab  is at the bottom of the Operations sheet. Clicking the tab 
opens the Operations Sheet. 
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RemLogic Toolbars 

RemLogic features nine toolbars that provide shortcuts to menu commands. By default, all 
toolbars display at the top of the program window, below the menu bar. You can show, hide, 
move, and reset toolbars.  Not all toolbars or buttons are available with the license free version 
of RemLogic. 

Standard 

 

Button Description 

 

Opens a new Workpad. 

 

Opens the patient folder storage location. 

 

Saves the current Workpad. 

 

Copies the current selection to Windows Clipboard. 

 

Undoes the last action. 

 

Redoes the last action. 

 

Displays the Print dialog. 

 

Displays the Patient Information dialog. 

Tools* 

Items marked with an “*” are not available with the License free version of RemLogic 

 

Button Description 

 

Magnifies a trace so it becomes the only visible trace in the Workpad. 

 

Displays relative amplitude and time between two points in a trace. 

 

Displays absolute amplitude of a certain position in a trace. 

 

Displays the timer.* 

 

Displays/hides Recording Manager. 

 

Displays/hides Device Manager. 
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Button Description 

 

Displays/hides Analysis Settings Manager. 

 

Displays/hides Event Palette. 

 

Displays/hides Analysis Pane. 

 

Displays the Workpad in full screen view, removing the Workspace Area. 

 

Vertically splits the Workpad.* 

 

Horizontally splits the Workpad.* 

 

Displays the Workpad in RemAxis View. 

Events 

 

Button Description 

 

Searches for events within the active trace. 

 

Finds the previous event in recording. 

 

Finds the next event in recording. 

 

Finds the first event in recording. 

 

Finds the last event in recording. 

 

Finds the previous event of same type. 

 

Finds the next event of same type. 

 

Finds all events that match the selected event type. 

 

Stops/continues the scoring session. 

 

Turns the Event Palette insertion mode on/off. 

 

Turns the Single Click insertion mode on/off. 
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Controls* 
Items marked with an “*” are not available with the License free version of RemLogic 

 

Button Description 

 

Stops the current online recording. 

 

Starts the real-time scrolling playback mode.* 

 

Starts the real-time interval playback mode.* 

 

Starts the playback at the current point in the recording. 

 

Plays the recording in fast forward mode. 

 

Plays the recording fast forward, one screen at a time. 

 

Pauses the playback. 

 

Turns the video playback on/off.* 

 

Turns the Embletta MPR audio on/off. This will only be enabled if there are 
audio clips that have been properly annotated in the recording folder.  These 
get created when downloading a study from the MPR.  If audio playback is 
selected, the button will appear pressed. To adjust the volume for the 
Embletta MPR audio, select the small down arrow to the right of the Embletta 

MPR audio button . Slide the bar up and down to raise and lower the 
volume on the Embletta MPR audio.  If both audio and video were collected 
together from a camera, but there are no audio clips, this button will not be 
enabled.  Video collected with the audio will be played back together and is 
controlled only with the video playback button. 

 

 

Starts the impedance test.* 

 

Starts the calibration test signal.* 
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Preview 

 

Button Description 

 

Available Preview list. The drop-down menu specifies the preview 
options available for the connected device.  

 

Note: Only available for the Embletta, Embletta Gold, 
Titanium, and Embletta MPR Units. 

Observations* 
*Not available with the License free version of RemLogic 

 

Button Description 

 

Opens the Initial Observations chart. This button is available when the Enable Initial 
Observations option is turned on in the Observations settings. 

 

Adds a Tech Note. 

 

Opens the Collection Observation chart. This button is available when the Enable 
Collection Observations option is turned on in the Observations settings, and the 
Lights Off event marker is added to the Workpad Sheet. 
In analysis, this button opens the Collection Observation chart nearest to the current 
time in the study, or opens the first Collection Observation chart when you are viewing 
a report or the Overview Sheet. 

 

Opens the Summary Observations chart. This button is available when the Enable 
Summary Observations option is turned on in the Observations settings. 

 

Generates and displays the Observation report. 

Photic Controller* 
*Not available with the License free version of RemLogic 

 

Button Description 

 

Starts intermittent photic stimulation (IPS). 

 

Stops IPS. 



Instructions for Use                 RemLogic™ 3.4 

               64 

Button Description 

 

IPS mode list. Options specify how IPS is controlled. 

 

Decreases the frequency of the photic flash. 

 

Text box value that represents the current frequency of the photic flash in 
hertz. 

 

Increases the frequency of the photic flash. 

Trace 

 

Button Description 

 

Displays Add/Remove Traces dialog box, where traces are added to/removed from 
sheets. 

 

Displays trace values. 

 

Inverts the active trace. 

 

Displays Trace Properties dialog box, where the filter settings are set. 

 

Automatically scales traces within panes. 

View History* 
*Not available with the License free version of RemLogic 

 

Button Description 

 

Starts the recording of actions that modify the way raw data is viewed in all open 
Workpads during data acquisition. See View as Recorded in the following location in 
the RemLogic online help: Work Environment | Workpad Area | Workpad Views | 
Workpad History. 

 

Starts the recording of actions that modify the digital display during a scoring session. 
See View as Scored in the following location in the RemLogic online help: Work 
Environment | Workpad Area | Workpad Views | Workpad History. 

 

Starts the recording of the current scoring session. See Recording a Scoring Session. 
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Show/Hide a Toolbar 

To show or hide a toolbar: 

1. On the View menu, point to Workspace, then click Toolbars. 

2. Do one of the following: 

 To show a toolbar, select the check box next to the toolbar name. 

 To hide a toolbar, clear the check box next to the toolbar name. 

Moving a Toolbar 

You can position a toolbar anywhere in the program window. 

To move a toolbar: 

1. Position the pointer over the handle on the left of the first toolbar button. 

2. Drag the toolbar to the new location in the program window. 

Resetting Toolbars 

You can reset the toolbars to their original settings and on-screen positions. 

To reset the toolbars: 

1. On the View menu, point to Workspace, then click Toolbars. 

2. Click Reset. 

Workspace Area 

Analysis Settings Manager 

The Analysis Settings Manager (labeled Analysis) allows you to analyze a recording, using 
default or custom settings. 

 

Analysis Settings Manager 

The Analysis Settings dialog box lists analysis parameters, where they can be customized. 
Access the Analysis Settings dialog box by clicking Analysis, then selecting Settings. 
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Opening/Closing the Analysis Settings Manager 

To open or display the Analysis Settings Manager, do one of the following: 

 Click Toggle Analysis Settings   on the Tools toolbar. 

 On the View menu, point to Workspace, then click Analysis Settings. 

To close the Analysis Settings Manager, do one of the following: 

 Click Toggle Analysis Settings   on the Tools toolbar. 

 Click Close  on the Analysis Manager bar. 

Analysis Settings Manager Properties 

In the Analysis Settings dialog box, customize the analysis parameters used by the computer 
assisted analyzers. 

To access analysis settings: 

 On the Analysis Settings Manager bar, click Analysis, then click Settings. 

To modify parameter values: 

 In the Profile list, click Custom. For more information, see Analysis Parameters. 

 

Device Manager 

The Device Manager is located in the start window to the left of the Operations Sheet and is 
titled Devices. The Device Manager monitors the recording devices that are used with 
RemLogic. The Device Manager includes a New Device Wizard that assists in adding and 
identifying new recording devices in the application. 
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Opening/Closing the Device Manager 

To open the Device Manager, do one of the following: 

 Click Toggle Devices  on the toolbar. 

 On the View menu, point to Workspace, then click Devices. 

To close the Device Manager, do one of the following: 

 Click Toggle Devices  on the toolbar. 

 Click Close  on the Devices bar. 

Device Manager Icons 

Each device in the Device Manager is identified with an icon that displays the current status of 
the device. 

Icon Properties 

no 
symbol 

The device is connected, but presently untasked. 

 

The device is programmed. 

 

The device is in a recording mode. 

 The device contains data to be downloaded.  This is displayed to the left of the unit 
icon. 

 

The recording is downloading / importing. 

 

The device is disconnected. 

 The device is in use at another workstation. 

 The device is in calibration mode. 

 

The device is in impedance check mode. 

 The device is in preview mode. 

With the Device Manager, you can add devices, view and modify device settings, and refresh 
the current device list. 
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Adding a Device 

The New Device Wizard activates by default whenever RemLogic detects a new Embletta 
device. Manually, click Add Device to activate the New Device Wizard. In addition to the 
previously listed devices, the New Device Wizard can add the Embla N7000 and Embla S4500 
systems; video capture devices; ResMed™ Tx Link; and composite devices. 

Refreshing a Device 

The Refresh command displays the current status of all devices by scanning and sorting 
devices in the Device Manager. 

To refresh a device: 

 Click Devices, then click Refresh. 

Renaming a Device 

You can rename devices listed in the Device Manager. 

To rename a device: 

1. In the Device Manager, right-click the device. 

2. Click Rename and type the new name for the device. 

 

Deleting a Device 

You can remove a device no longer used in connection with the application from the Device 
Manager. 

To delete a device: 

1. In the Device Manager, right-click the device. 

2. Click Delete. 

Recording Manager 

By default, the Recording Manager is located to the left of the Operations Sheet, and is 
identified by the label Recordings. The Recording Manager monitors and updates any changes 
in recorded data in the active storage locations as specified in the Options dialog. 

To access Data Location settings: 

1. On the Tools menu, click Options. 
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2. In the left pane, double-click Data Management. 

 

Recording Manager displaying an archive cache location and other data locations. 

Opening/Closing the Recording Manager 

To open the Recording Manager, do one of the following: 

 Click Toggle Recordings   on the toolbar. 

 On the View menu, point to Workspace, then click Recordings. 

To close the Recording Manager, do one of the following: 

 Click Toggle Recordings   on the toolbar. 

 Click the  on the Recording Manager bar. 

Recording Manager Icons 

An icon identifies each folder or file type in the Recording Manager. 

Icon Properties 

 

Data Location Folder. Storage location for patient folders. For more information, see 
Data Locations. 

 

Patient Folder. Identified by the patient name and ID. Contains patient folders and files. 

 

Recording Folder. Identified by the date and time of recording. Contains Workpads, 
documents, and a raw data folder. Right-click this folder to import a file, archive a 
recording, delete a recording, join recordings, and view recording properties. 

 

Workpad File. Contains sheets that were reviewed or analyzed. Saved Workpad files are 
added to the appropriate Patient folder. Each time you open the Raw Data folder, it is 
opened as a new Workpad. Every recording can be saved as many different Workpads 
(for example, Scored 1, Scored 2). You can save your analysis of a recording in a 
Workpad file and return to it later (by double-clicking the Workpad file icon) for further 
review and analysis. 

 

Documents Folder. Stores patient documents including exported reports, Microsoft® 
Word™ documents, transcriptions, and images. Right-click this icon to import a file. 
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Icon Properties 

 

Raw Data Folder. Contains recorded data sorted alphabetically. Double-click this icon to 
open a new Workpad with the raw data. 

Displaying and Sorting Recordings 

You can store recordings in active and non-active data locations. For more information about 
assigning active data locations, see Data Locations. 

By default, you can view recordings stored in both data locations in the Recording Manager. 
With the Recording Manager Arrange feature, you can modify the recording list to include only 
active data location recordings or all recordings (active and non-active), and you can sort files 
by patient name and recording date. 

To show recordings stored at all data locations (active and non-active): 

 On the Recordings list, point to Arrange, then select Show All Locations. The active 
data location displays in bold type. 

To show only recordings stored at the active data location: 

 On the Recordings list, point to Arrange, then cancel the Show All Locations 
selection. 

To sort recordings: 

 From the Recordings list, point to Arrange. 

 Do one of the following: 

To Sort Do This 

Patient Folders alphabetically by patient 
name from A to Z. 

1. Click Arrange by Patient Name. 

2. Click Sort by Patient Name. 

3. Click Sort Ascending. 

Patient Folders alphabetically by patient 
name from Z to A. 

1. Click Arrange by Patient Name. 

2. Click Sort by Patient Name. 

3. Click Sort Descending. 

Patient folders chronologically by 
recording date from newest to oldest. 

1. Click Arrange by Patient Name. 

2. Click Sort by Recording Date. 

3. Click Sort Ascending. 

Patient folders chronologically by 
recording date from oldest to newest. 

1. Click Arrange by Patient Name. 

2. Click Sort by Recording Date. 

3. Click Sort Descending. 
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To Sort Do This 

Study folders chronologically by recording 
date from newest to oldest. 

1. Click Arrange by Recording Date. 

2. Click Sort by Recording Date. 

3. Click Sort Ascending. 

Study folders chronologically by recording 
date from oldest to newest. 

1. Click Arrange by Recording Date. 

2. Click Sort by Recording Date. 

3. Click Sort Descending. 

Study folders alphabetically by patient 
name from A to Z. 

1. Click Arrange by Recording Date. 

2. Click Sort by Patient Name. 

3. Click Sort Ascending. 

Study folders alphabetically by patient 
name from Z to A. 

1. Click Arrange by Recording Date. 

2. Click Sort by Patient Name. 

3. Click Sort Descending. 

Importing a Recording 

The Recording Manager makes it possible to import recordings from your PC, removable media 
(such as a CD / DVD), or a computer network, for example. 

To import a recording: 

1. Click Recordings on the Recording Manager bar. 

2. Click Import. 

3. Browse to and select the recording you want to import. 

4. Click OK. 

The recording is added to the active data location in the Recording Manager. 

Importing Recordings from a CD / DVD 

When you are importing many recordings into RemLogic, it is more convenient to copy and 
paste them from a CD onto the computer's hard drive. 

To import recordings from a CD or DVD: 

1. Insert the CD / DVD into the computer. 

2. Open the desktop of the computer, then double-click My Computer. 

3. Double-click the Compact Disc (D:) drive to display the recordings on the CD / DVD. 

4. Copy the folder and paste it into the data storage location of the computer—for example, 
C:\RemLogic Recordings. 
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Refreshing the Recording Manager 

To refresh the list of Patient folders: 

1. Click Recordings on the Recording Manager bar. 

2. Click Refresh. 

The Patient folders are scanned and rearranged. 

With the Recording folder, you can import files, archive recordings, delete recordings, join two 
recordings together*, and verify recording properties. 

 

Recording Folder Options, Licensed version of RemLogic  

 

Recording Folder Options, License free version of RemLogic 

Recording Properties 

The Recording Properties window displays an overview of a recording's GUID (a numerical 
string to protect the patient's information), location (where it is stored on your computer), size, 
time, duration, type, and number of channels used in the recording. 

To access the Recording Properties window: 

1. Right-click the appropriate Recording folder . 

2. Click Properties. 

Importing a File 

You can import files and add them to a Patient folder. Imported files can be of types such as 
recordings, reports, Word documents, transcriptions, and pictures. 

To import a file: 

1. In the Recording Manager, right-click the Recording folder  of the appropriate patient. 

2. Click Import File. 

3. The Import dialog box displays. Find and select the correct file. 

4. Click Open. 

The selected file is imported and placed in the Documents folder   of the selected patient 
folder. 

Archiving a Recording 

The archiving function is used for long-term storage of recordings and related files. Recordings 
are archived using the Archive wizard, but all archive location adjustments are made in Tools | 
Options | Data Locations. 
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To archive a study: 

1. In the Recording Manager, right-click the Recording folder  containing the recording 
you want to archive, then click Archive. 

2. Follow the steps of the wizard to archive the recording. 

Deleting a Recording 

The delete function erases the selected Recording folder, recorded data, and all other 
documents in that folder. To be able to delete recordings, the delete function must be active. Go 
to Tools | Options | Data Management | Data Locations and select Allow user to delete 
recordings. 

 

To delete a recording: 

1. In the Recording Manager, right-click the Recording folder  to be deleted. 

2. Click Delete. 

3. Click OK. 

The Recording folder and all its contents are erased. If only one Recording folder is located in a 
Patient folder, the delete function erases both the Recording folder and the Patient folder. 

It is recommended that the Delete recordings function is made available only as necessary to 
prevent accidental deletions. Deleted Recordings are deleted from RemLogic and sent to the 
Recycle Bin. 

 

Note: If you are using Embla Enterprise, and you attempt to delete the last online copy 
of a study, a warning informs you of this. If the recording history database is 
unavailable, a warning informs you that the database is unavailable, and the study you 
are deleting might be the last online copy. 

Joining Recordings* 

*Not available with the License free version of RemLogic 

The Join With option activates the Join Recordings Wizard. This wizard assists you in joining 
two recordings belonging to the same patient together. This feature can be helpful in cases 
where a new recording was started for the patient, instead of resuming the patient's previously 
started recording, for example. You can join the two recordings together, analyzed them, and 
save them as one recording. 

To join recordings: 

1. Right-click the Recording Folder containing the study you want to use as the primary 
recording. 

2. Click Join With. 

3. Follow the steps as outlined in the Recording wizard. 
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Workspace Templates 

A template contains user-defined settings for the presentation and layout of a recording. 
Templates save you from having to recreate your preferred Workspace setup each time you 
view a recording. You can define the following elements in a Workspace template: 

 The number of sheets used 

 Sheet names, and their order in the Workpad 

 Information displayed in a sheet (such as traces, graphs, and scaling) 

 Settings for analysis views, such as Pressure Monitor, the Event Radar, and Hypnogram 

 Toolbar positions, and whether or not a toolbar is visible 

 Workspace settings for the recording manager, event palette, and analysis settings 
manager 

You can locally store workplace templates on a workstation, or make them available to multiple 
workstations by storing them on a network. You can save a Workspace, or load and edit an 
existing Workspace template. 

The default Workspace can be found in one of the following locations: 

Windows XP Users: C:\Documents and Settings\All Users\Application 
Data\Embla\RemLogic\Sheet Templates\Embla Default.ESWT 

Windows 7 Users: C:\ProgramData\Embla\RemLogic\Sheet Templates\Embla Default.ESWT 

Changing the Default Workspace 

The default Workspace can be changed to a previously saved Workspace. 

To change the default Workspace: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click on Advanced or single-click the “+” beside it. 

3. In the left pane, single-click on Miscellaneous. 

4. In the right pane, type the destination of the desired default Workspace into the Default 

Workspace data field or single-click on the ellipses   to the right of the data field to 
browse to the location manually. 

5. Click OK. 

 

Note: If the specified location is invalid, an error message will be displayed, and the 
dialog box will remain open until a valid location is provided. 

Saving a Workspace as a Template 

To save a new Workspace template: 

1. Do one of the following: 

 To save an existing template (that was modified) under a new name: 

On the View menu, click Save as Workplace Template. 
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 To save the Workspace layout as a new template: 

On the View menu, click Save Workplace Template. 

2. Specify a location for the template by selecting the template type. Click Next. 

 Local Template: Select this option to make the template accessible on the 
current workstation. 

 Workgroup Template: Select this option to make the template accessible to all 
the workstations on your network. 

3. In the Name box, type a name for the template. Type a description of the template in the 
Description box, or if this is an existing template, type a new name by overwriting the 
existing text in the Name and Description text boxes. 

4. Click Next. Confirm the template location, name, and description. 

5. Click Finish to close the wizard. 

Loading a Workspace Template 

To load a Workspace template: 

1. On the View menu, click Load Workspace Template. 

2. In the View Workspace Template dialog, select a template from the list, then click Load. 

Renaming a Workspace Template 

To rename a Workspace template: 

1. On the View menu, click Edit Workspace Templates. The Edit Workspace Templates 
dialog box displays. 

2. Select the template you wish to edit, then click Edit. The Template Properties dialog box 
displays. 

 

 Name: Type a new name for the template. 

 Description: Write or change the description of the template. 

3. Click OK, then click Close. 
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Updating a Workspace Template 

A Workspace template can be modified and updated. Each time you change a Workspace 
template, it must be saved. 

To update Workspace templates: 

 On the View menu, click Save Workspace Template. 

The changes in the Workpad are saved to the template. 

Reverting a Workspace Template* 

If you change the appearance of a Workspace template and realize you do not want to keep the 
edits, you can undo the changes, and revert to the latest copy of the template that was saved. 

 

Note: If you select the Revert To Workspace Template command, you will lose any 
changes you made to the appearance of the template. 

To revert a Workspace template: 

1. On the View menu, click Revert to Workspace Template. 

2. A confirmation dialog box displays. Click the appropriate option to revert the template. 

The most recent version of the template replaces the Workspace. 

Deleting a Workspace Template 

You can delete a Workspace template that is no longer used from RemLogic. 

To delete a Workspace template: 

1. On the View menu, click Edit Workspace Templates. 

2. Select a template from the list, then click Delete. 

3. A confirmation dialog displays confirming that you want to delete the selected 
template.  Click Yes to proceed with deleting the template.  Click No to cancel the delete 
and return to the Edit Workspace Template dialog. 

4. Click Close. 

Sharing a Workspace Template 

You can store Workspace template settings on a network (on a server or shared drive). Your 
preferred visual settings are accessible to each computer on the network. If you upgrade from a 
previous version of RemLogic, the network location previously specified will not change. If you 
installed RemLogic for the first time, the default location for workgroup templates is:  

 Windows XP Users: C:\Documents and Settings\All Users\Application 
Data\Embla\RemLogic\Sheet Templates 

 Windows 7 Users: C:\ProgramData\Embla\RemLogic\Sheet Templates 

Changing the file path to a server or shared drive location is recommended. 

To change the network location for workgroup Workspace templates: 
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1. On the Tools menu, click Options. 

2. In the left pane, double-click on Advanced or single-click the “+” beside it, and single-
click on Miscellaneous. 

3. In the right pane, type the destination of the desired Workspace template into the 

Workgroup Templates data field or single-click on the ellipses  to the right of the 
data field to browse to the location manually. 

4. Click OK. 

All new workgroup Workspace templates are stored at this location. 

Workpad Area 

Workpad Sheets 

Workpads contain one or more Workpad Sheets, which are individual work areas. Workpad 
Sheets contain the recorded signals and visual data settings (for example, time interval, axis 
values, filters, trace number, sequence, and color). You can customize and save visual settings 
for one or even several different sheets. 

 

A Workpad Sheet displaying four traces. 

When you open a recording for the first time, RemLogic automatically inserts the default sheets 
into the new Workpad:  

 If you are running the licensed version of RemLogic, the sheets inserted are: Embla 
PSG (EmblaPSG), Embla Respiratory (EmblaResp), and Embla PSG Calibration Test 
(EmblaPSG CalTest). The first two templates recognize all of Embla's recording devices 
and most commonly used sensors. For example, if you use Piezo respiratory sensors 
during collection, the data from these sensors display when you open the study in 
RemLogic; likewise, if you use XactTrace™ sensors, the Embla template recognizes the 
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derived traces, and displays them correctly. The Embla PSG Cal Test sheet differs from 
the Embla PSG and Embla Respiratory templates in that it displays machine calibration 
waveforms of bipolar EEG, EKG, and EMG traces.  

 

Note: Derived traces from the XactTrace™ belts must be selected using the 
Tools | Options | Advanced menu.  Once the desired traces have been 
selected, they will be displayed in the Workpad Sheet accordingly.  

 If you are running the license free version of the software, the sheets inserted are: 
Respiratory and sheet 1 – Customizable.  The sheet 1 – Customizable is the only one of 
the two that you can make changes to and save using the process described under 
Updating a Workpad Sheet Template.  All changes made to the Respiratory worksheet 
can only be saved using the Saving a Workpad Sheet as a Template process. 

Opening an existing Workpad displays all sheets open during the last save. 

Each Workpad Sheet tab is located at the base of the Workpad area. Click on a sheet tab to 
display the respective sheet. 

 

You can create new sheets in several ways, including inserting or copying the default sheets, 
inserting new blank sheets, and cloning existing sheets. 

Saving a Workpad Sheet 

Any recording that was reviewed and analyzed can be saved as a Workpad file. When a 
Workpad is closed, RemLogic asks if the changes made to the recording, which can include the 
scoring and analysis information entered into the recording, should be saved. It also saves 
changes made to the sheet or template that was used for viewing the traces. You can save and 
store a customized sheet along with other sheets or reports as a Workpad file within the Patient 
folder. Depending upon how many Workpads are opened, RemLogic will add a number to the 
Workpad label, such as "Workpad5." You can give the Workpad a more meaningful label, such 
as "Scored." 

To save a Workpad Sheet: 

1. On the File menu, click Save As. 

2. Type a name for the Workpad. 

3. Click OK. 

The set of sheets are saved as a Workpad file , and stored under the appropriate patient 
folder in the Recording Manager. 

Auto-Saving Workpads 

By default, changes to the current Workpad are automatically saved at a regular time interval. 
You can customize the auto-save time interval. You can also disable the auto-save function. 

To enable autosave: 

1. On the Tools menu, click Options. 

2. In the left pane, click Advanced. 
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3. Select the Autosave Workpads every x minutes check box. 

4. Enter the autosave frequency in minutes. 

5. Click OK. 

To save Workpads to other locations outside of the recording folder: 

 Select the Allow saving Workpads outside of the recording folder check box. 

 

Note: Saving a recording as a Workpad does not affect the Raw Data folder. 
Additionally, if any changes were made to the Workpad, RemLogic always prompts 
you if the data must be saved before closing. 

Inserting an Existing Workpad Sheet 

To insert a default sheet: 

1. Right-click any sheet tab. 

2. Click Insert, then from the list of default sheets, select a sheet type. 

A new sheet displays in the Workpad, with its own sheet tab. 

 

Inserting a Blank Workpad Sheet 

Inserting a blank sheet allows you to create a sheet and choose which traces to include in it. 

1. Right-click any sheet tab. 

2. Point to Insert. 

3. Click Blank Sheet. The Add/Remove Traces dialog box displays. 

4. To select the traces to be included in the new sheet, do one of the following: 

 Select the check boxes next to the traces to be added to the sheet. 

 Click Check All to add all the traces on the list to the sheet. 

 Click New if you want to define a new trace and add it to the sheet. 

5. Click OK. 

The selected traces display in a new sheet with its own sheet tab, New Sheet. 

 

Cloning a Workpad Sheet 

You can make an exact copy of a selected sheet by cloning it. 

1. Make the appropriate changes to any sheet (for example, adjust trace size, number, and 
color). 

2. Right-click the sheet tab of the sheet to be cloned. 

3. Click Clone. 
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A new sheet that is identical to the selected sheet displays in the Workpad with its own sheet 
tab. 

 

 

Tip: If you clone a default Embla Workpad Sheet (Embla PSG or Embla Resp), the 
dynamic properties present in the original sheet will be lost. If you open a newly recorded 
study in the template, only recorder and sensor channels already present in the template 
will be recognized. You can, however, manually add the missing signal channels. 

Deleting a Workpad Sheet 

You can delete a Workpad Sheet that is no longer needed from the Workpad. 

To delete a sheet: 

1. Do one of the following: 

 Right-click the sheet tab of the sheet, 
then click Delete. 

 Click Close   above the time axis in 
the upper-right corner of the sheet. 

2. A confirmation messages asks if you are sure 
you want to delete the sheet from the Workpad; click Yes. 

Printing a Workpad Sheet 

You can print Workpad Sheets from RemLogic both page-by-page and on continuous paper. 

To print a Workpad Sheet: 

1. On the File menu, click Page Setup. 

2. Optionally, specify any print options that are available for your printer. Click OK. 

3. Do one of the following: 

 Click Print  on the toolbar. 

 On the File menu, click Print. 

4. The Print dialog box displays. Specify the print options available: 

 Workpad range: These settings control what portion of the data in the Workpad 
is sent to the printer. 

 All: Print all data in the Workpad. 

 Screen: Print the data visible on the screen. 

 Time: Print the data within the time range specified by the from and to 
boxes. 

 Options: 

 Scale panes to fit vertically: Scale the panes so all traces are 
condensed or expanded to fit on one page. 



RemLogic™ 3.4            Instructions for Use 

81                     

 Scale time to fit horizontally: Scale the time range to be printed to fit on 
one page. 

 Print events: Include any events you marked into the Workpad in the 
printout. 

 Print gridlines: Include Any gridlines you inserted into the Workpad in 
the printout. 

 Print trace labels: Include the trace labels on the amplitude axis in the 
printout. 

 Print range: These settings affect which pages from the specified Workpad 
range are to be printed. 

 All: Prints all the pages. 

 Pages: Prints a range of pages specified by the from and to boxes. 

 Copies/Number of copies: Select how many copies of the printout you 
want. 

 Collate: If you are printing more than one copy, select this option for the 
printer to arrange the copies in numerical sequences. 

5. Click OK. 

The printed sheet reflects the settings of the time and amplitude axes in the Workpad. For 
example, if the time axis is set to show 3cm/s, the printed sheet also uses that scale. Therefore, 
the traces you see on the screen might not fit on one page. 

To make a printout where all traces fit on one page, select Scale panes to fit vertically in the 
Print dialog. 

Workpad Sheet Properties 

In addition to saving a set of traces in a specific order, a sheet holds information about the sheet 
name, grid settings, and colors. Changing the properties only affects the current sheet in the 
open study. The changes made to the sheet's properties can be saved. To make sheets with 
settings that will persist between studies, see Workpad Sheet Templates. 

To change sheet properties: 

1. Right-click the sheet tab, then click Properties. 

2. See below for a detailed explanation of each tab. 

3. Click OK. 

General, Grid, and Colors Tab Options 

General, Grid, and Colors Tabs 

Use the General tab to change the 
sheet name or add basic description 
of the sheet. Changes made to the 
name and description of a sheet are 
stored in the current Workpad only. 

 Name: Type a name for the sheet. This name 
display on the sheet's tab. 

 Description: Enter a description of the sheet. 
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General, Grid, and Colors Tabs 

Use the Grid tab to insert or remove 
gridlines from a sheet. By default, 
major gridlines from both the axes 
display in the sheet. You can enable 
minor gridlines or hide gridlines 
altogether.  

 Show major/minor gridlines: Select the check 
boxes to display gridlines in the sheet. To hide the 
gridlines, clear the check boxes. 

Use the Colors tab to change the color 
settings of a sheet. 

 Trace: Click the color box, and select a color for 
the active trace. 

 Gridlines: Click the color boxes, and select a color 
for the major and the minor gridlines. 

 Background: Click the color box, and select a 
color for the background of the sheet. 

Workpad Sheet Templates 

Sheet templates provide you with a means to save the settings you defined for the visual 
presentation of traces (if you create an Overview Sheet template, you can define graphs, as 
well). For example, a sheet template specifies what traces are shown, their order, the colors, 
pane sizes, and more. The template can save you from recreating the format each time you 
view a recording. Sleep technologists can also create their own templates to view the data in the 
way they find most convenient. A sheet template can be saved and used as a model for 
displaying sheets from other recordings. 

You can store the templates locally on one workstation, or make them available on all 
workstations by storing them on a network. If you create a sheet template that you will use 
frequently, you can save it so it will automatically display every time you open new data. 

When you open a recording for the first time, RemLogic automatically inserts the default sheets 
into the new Workpad:  

 If you are running the licensed version of RemLogic, the sheets inserted are: Embla 
PSG (EmblaPSG), Embla Respiratory (EmblaResp), and Embla PSG Calibration Test 
(EmblaPSG CalTest). The first two templates recognize all of Embla's recording devices 
and most commonly used sensors. For example, if you use Piezo respiratory sensors 
during collection, the data from these sensors display when you open the study in 
RemLogic; likewise, if you use XactTrace™ sensors, the Embla template recognizes the 
derived traces, and displays them correctly. The Embla PSG Cal Test sheet differs from 
the Embla PSG and Embla Respiratory templates in that it displays machine calibration 
waveforms of bipolar EEG, EKG, and EMG traces.  

 

Note: Derived traces from the XactTrace™ belts must be selected using the 
Tools | Options | Advanced menu.  Once the desired traces have been 
selected, they will be displayed in the Workpad Sheet accordingly.  

 If you are running the license free version of the software, the sheets inserted are: 
Respiratory and sheet 1 – Customizable.  The sheet 1 – Customizable is the only one of 
the two that you can make changes to and save using the process described under 
Updating a Workpad Sheet Template.  All changes made to the Respiratory worksheet 
can only be saved using the Saving a Workpad Sheet as a Template process. 
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Note: Modifying a default Embla Workpad Sheet (Embla PSG, Embla Resp, and 
EmblaPSG CalTest) and saving it as a template overwrites dynamic properties 
present in the original sheet. Consequently, when you open recorded studies in the 
template, only recorder and sensor channels present in the template are recognized 
and displayed. To correct the issue, add any missing signal channels. 

Sheet templates allow you to view data with your preferred settings. You can create a template 
in two ways: by creating a new template, or by saving an existing customized sheet as a 
template. 

Saving a Workpad Sheet as a Template 

To save a Workpad Sheet as a template: 

1. Do one of the following: 

 On the View menu, click Edit Sheet Templates. Click New. 

 Right-click the tab of the Workpad Sheet you want to save as a template, then 
click Save As Template. 

2. Click Next. 

3. Specify a location for the template by selecting the template type. 

 Local Template: Select this option to make the template accessible on the 
current workstation. 

 Workgroup Template: Select this option to make the template accessible to all 
the workstations on your network. 

 This template is designed for use as a Live View Layout: Select this option to 
make the layout a template for the Live View Window. 

4. Click Next. 

5. Select a Workpad Sheet on which to base the template, then click Next. 

6. In the Name box, type a name for the template. 

7. Type a description of the template in the Description box, then click Next. 

 

8. Confirm the template location, name, and description. Click Finish. 

9. Click Close. 
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To insert a Workpad Sheet based on the template, right-click any Workpad Sheet tab, point to 
Insert, then click the new template. 

 

Note: Modifying a default Embla Workpad Sheet (Embla PSG, Embla Resp, and 
EmblaPSG CalTest) and saving it as a template overwrites dynamic properties 
present in the original sheet. Consequently, when you open recorded studies in the 
template, only recorder and sensor channels present in the template are recognized 
and displayed. To correct the issue, add any missing signal channels. 

Renaming a Workpad Sheet Template 

To rename a sheet template: 

1. On the View menu, click Edit Sheet Templates. 

2. Select the template to be edited, then click Edit. 

 

 Name: Type a new name for the template. 

 Description: Write or change the description of the template. 

3. Click OK, then click Close. 

Updating a Workpad Sheet Template 

You can modify a sheet template. Each time you change a sheet template, it must be updated 
to save the changes. 

To update sheet templates: 

1. Right-click the tab of the modified template. 

2. Click Save Sheet Template. 

3. Click Yes. 

Reverting a Workpad Sheet Template 

If you do not want to keep the edits for a sheet template, you can undo the changes and revert 
to the latest saved copy of the template. 

 

Note: If you select the Revert to Workspace Template command, you will lose all 
the changes you made to the appearance of the template since you last saved it. 

To revert a sheet template: 

1. Right-click the tab of the sheet to which you want to revert. 
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2. Click Revert to Sheet Template. 

3. Click Yes. 

Deleting a Workpad Sheet Template* 

*Not available with the License free version of RemLogic 

You can delete from RemLogic a sheet template that is no longer used. 

To delete a sheet template: 

1. On the View menu, click Edit Sheet Templates. 

2. Click the template you want to delete, then click Delete. 
Enterprise Users: If you delete the Publishing Overview Sheet Template, RemLogic 
selects a default Publishing Overview Sheet template, unless you specify a new one. 

3. Click Yes. 

Sharing Workpad Sheet Templates 

Sheet template settings can be stored on a network (on a server or shared drive). This means 
that your preferred visual settings are accessible to each computer on the network. If you 
upgrade from a previous version of RemLogic, the network location previously specified will not 
change. 

The default location for workgroup templates is:  

 Windows XP Users: C:\Documents and Settings\All Users\Application 
Data\Embla\RemLogic\Sheet Templates 

 Windows 7 Users: C:\ProgramData\Embla\RemLogic\Sheet Templates  

Changing the file path to a server or shared drive location is recommended. 

To change the network location for workgroup sheet templates: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Advanced, or single-click the “+” beside it, and single-click 
on Miscellaneous. 

3. Enter the file path, or click Browse to search for and select the appropriate network 
location. 

4. Click OK. 

All new workgroup sheet templates are stored at this location. 

Overview Sheet 

The Overview Sheet is a Workpad Sheet that provides a summary of an entire recording, 
including signal trends, events, and traces, on one sheet. Workpads sheets update dynamically 
when the synchronization marker (located on the time axis at the top of the sheet) navigates to 
specific points in the recording. 

On the Overview Sheet, you can add event traces and graphs, or create graph groups to add 
graphs specific to the analysis type. The Amplitude Axis bar displays to the left of the traces on 
the Overview Sheet. For more information, see Amplitude Axis. 
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Note: Filter and Calibration properties cannot be adjusted in the Overview Sheet. 

Inserting an Overview Sheet 

To insert an Overview Sheet: 

1. Right-click any sheet tab in the Workpad area. 

2. Click Insert. 

3. Click Overview Sheet. A blank sheet displays: 

 

4. To add traces to the Overview Sheet: 

 Select the check boxes of the traces you want to add, then click OK. 

 To add all available traces to the Overview Sheet, click Check All, then click OK. 

 To add a New trace (This feature is not available with the License free version of 
RemLogic.): 

 Click New, and select trace type from the Main type list. 

 In the Signal pane, click a signal. 

 In the Reference 1 pane, select the first reference. 

 In the Reference 2 pane, select the second reference (if applicable). 

 Click OK. 

5. To add graphs to the Overview Sheet: 

 Click the Graphs tab, select a graph group from the list, select the check boxes 
of the graphs you want to add, then click OK. For more information, see Event 
Graph Groups in the following location in the RemLogic online help: Work 
Environment | Workpad Area. 

Deleting an Overview Sheet 

To delete an Overview Sheet: 

 Right-click the Overview Sheet tab, then click Delete. 

Navigating a Recording 

The Overview Sheet synchronizes with the trace displays in the other sheets in your Workpad. 
You can use the Overview Sheet to quickly jump to different locations in the recording. 

The Overview Sheet displays a synchronization marker  on the time axis at the top of the 
sheet. It allows you to navigate to a specific time during a recording to display an event or point 
of interest. 
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As the synchronization marker moves to a new point on the time axis, a line appears, indicating the location of the marker. 

To jump to a location in the recording: 

1. Click on the synchronization marker on the time axis at the top of the Overview Sheet. 

2. Drag the marker to the point on the time axis that corresponds to an event or point of 
interest. 

All sheets in the Workpad synchronize based on the time selected. 

 

Tip: Press TAB to move to the next graph or trace on the Overview Sheet. To move to 
the previous graph or trace, press SHIFT + TAB. 

Time Display During Collection* 

*Not available with the License free version of RemLogic 

You can use the Overview Sheet to view scored events during data collection. As events are 
scored, they display on the Overview Sheet according to previously added event graphs. 

At the start of a recording, the Overview Sheet displays one hour of data. After an hour of 
recording, the sheet displays two hours, with the second hour starting at the center of the sheet. 
After two hours, the sheet displays three hours, with the third hour beginning in the center of the 
sheet, and so on. By the end of the recording, the entire study displays. 
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Adding a Trace 

To add a trace to an existing Overview Sheet: 

1. Click Traces  on the toolbar. 

2. Do one of the following: 

 Select the check box of the trace you want to add. 

 To add a New trace, click New, and select trace type from the Main type 
list.  This feature is not available with the License free version of RemLogic. 

a. In the Signal pane, click a signal. 

b. In the Reference 1 pane, select the first reference. 

c. In the Reference 2 pane, select the second reference (if applicable). 

d. Click OK. 

3. Click OK. 

Removing a Trace 

To remove a trace from an Overview Sheet: 

1. On the Data menu, click Add/Remove Traces/Graphs. 

2. Clear the check box of the trace you want to remove. 

3. Click OK. 

Adding a Graph 

To add a trace to an existing Overview Sheet: 

1. Click Traces  on the toolbar. 

2. Click the Graphs tab. 

3. Select a graph group from the menu, then select the check box of the graph you want to 
add. 

4. Click OK. For more information, see Event Graph Groups in the following location in 
the RemLogic online help: Work Environment | Workpad Area. 

You can save the selection of traces and graphs as a sheet template for future use. For more 
information, see Sheet Templates. For information about activating, adding, and removing 
traces, see Traces. 

Removing a Graph 

To remove a graph from an Overview Sheet: 

1. On the Data menu, click Add/Remove Traces/Graphs. 

2. Click the Graphs tab. 

3. Clear the check box of the graph you want to remove. 
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4. Click OK. 

Moving a Trace/Graph 

To move a trace on the Overview Sheet: 

1. Place the pointer directly over the trace name. 

2. Drag the trace to the new position . 

 

Tip: To remove a trace/graph and its pane, right-click the trace, then click Delete 
Pane. 

Overview Sheet Layout 

Using the Overview Sheet, you can display event graphs and traces together in a single 
Overview Sheet, or use the split Workpad feature to view data from two Workpad Sheets in a 
single screen. 

When a graph displays, it appears in the color specified for the Event bar and trace highlight. 
You can alter the display color by editing the properties for the event. For more information, see 
Event Types. 

Event Graph Display 

The Overview Sheet allows you to display event graphs in two ways: horizontally and vertically. 

Horizontal Display 

By default, the event graph displays horizontally. The beginning and end of each event is 
represented by short vertical lines, with a horizontal line between them. Short events appear as 
a single, thicker line: 

Vertical Display 

You can change the display to present event graphs vertically. With the vertical display, the 
duration of events is indicated by the height of the lines that represent the events. You can 
adjust the graph using the bar that displays on the left when you display the time graph. 

 

Displaying Graphs and Traces Together 

You can display events and related traces together in the Overview Sheet. This way, you can 
view all instances of an event that occurred during the night in conjunction with the trace upon 
which the event was scored. 



Instructions for Use                 RemLogic™ 3.4 

               90 

 

In this figure, an SpO2 trace displays along with a Desaturation event graph, showing all the desaturations scored on this trace 
during the study. The Analysis Start and Stop times, as well as Artifacts marked during the study, also display. 

Displaying Graphs and Traces Using a Split Screen* 

*Not available with the License free version of RemLogic 

You can customize the Workpad to display the Overview Sheet and another sheet together 
using the split Workpad feature. The split Workpad can include the Overview Sheet displaying 
event graphs, and another sheet containing the traces you are currently scoring. The events you 
score display in the Overview Sheet. For more information, see Split Workpad Views in the 
following location in the RemLogic online help: Work Environment | Workpad Area | Workpad 
Views. 

 

In this figure, the Overview Sheet displays Respiratory Arousal, CPAP pressure, and Apnea events. SpO2 and PAP pressure traces 
display in the Respiratory sheet, where they were scored. 

 

Tip: You can save customized Overview Sheets and Workpads as Sheet Templates or 
Workspace Templates. 
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Displaying Graph Groups 

When you display graphs as part of a group, each event in the group displays in the color 
specified in the Event Type properties (Event bar and trace highlight color). Using contrasting 
colors allows you to differentiate between the related, but distinct, graphs. 

 

In this example, an Apnea graph group displays. Each event and corresponding trace in the group has its own color, making it easy 
to identify specific events, like Obstructive, Central, or Mixed Apnea. 

 

Tip: When viewing an eight hour study, a limited amount of data within each one 
minute segment in the Overview Sheet displays. If more than one event is scored 
within a one minute segment, the event graphs might overlap. 

Traces 

Traces are the visible representations of recorded signals. A trace displays in a pane located in 
a sheet. You can change properties of every trace, such as amplitude and filtering. Further, you 
can adjust the number of traces, their order in the sheet, how they are grouped, and more. 

 

An active trace. 

Activating a Trace 

Click on a trace to make it active. By default, an active trace displays in blue; however, you can 
change the color. The status bar at the bottom of the screen displays the properties of the active 
trace. 

 

Status bar showing the EKG trace as active. Its frequency is 200Hz, the epoch number is 1, the patient name is Normal Patient, the 
study is Ambulatory, the ID is 123456, and the recording duration is almost 9 hours. 

To change the active trace color: 

1. Right-click a sheet tab, then click Properties. 

2. Click the Colors tab. 

3. Under Trace, click the Active color box. 

4. Click a color. 

5. Click OK twice. 
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Adding a Trace 

You can add one or more traces to a Workpad Sheet. 

To add a trace: 

1. Click Traces  on the toolbar. 

2. Do one of the following: 

 Select the check boxes of the traces you want to add to the Workpad Sheet. 

 Click Check All to add all traces from the list. 

 To define a new trace, click New. 

3. Click OK. 

Removing a Trace 

You can remove traces from a Workpad Sheet in two ways. The Add/Remove Traces function 
can remove a single trace or all recorded traces from a sheet. 

To remove a trace from a Workpad Sheet: 

1. Click Traces  on the toolbar. 

2. Do one of the following: 

 Clear the check boxes of the traces you want to remove. 

 Click Uncheck All to clear all check boxes. 

3. Click OK. 

Copying a Trace 

You can copy trace values to the clipboard. 

To copy trace values to the clipboard: 

1. Select the portion of a trace containing the values you want to copy. 

2. On the Edit menu, click Copy. 

3. Press CTRL + V to paste the clipboard contents in any Windows application. 

Moving a Trace 

To move a trace within a pane: 

1. Place the pointer on the trace you want to move. The pointer changes to a hand . 

2. Drag the trace to the new position in the pane . 
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Magnifying a Trace 

To zoom in on a trace: 

1. Click Zoom  on the toolbar. 

2. Click on a section of the trace. 

3. To revert to normal view, press ESC. 

Inverting a Trace 

You can invert traces around the zero axis on any Workpad Sheet but the Overview Sheet. This 
action is practical when you connect bipolar channels, such as EKG. 

To invert a trace: 

1. Activate the trace. 

2. Click Invert  on the toolbar. 

Creating a Trace by Re-Referencing Signals* 

*Not available with the License free version of RemLogic 

You can re-reference signals to create new traces derivations. 

To create a trace by re-referencing signals: 

1. Click Traces  on the toolbar. 

2. Click New. 

3. From the Main type list, select a type for the new trace. Based on the Main type 
selection, the available signals and references display below. 

4. Select the Signal and Reference. For EEG and EOG Main types, select two references. 

5. Click OK. 

The new derivation displays in the Add/Remove Traces dialog box, and is available to add to 
any Workpad Sheet in the Patient folder. 

Scaling a Trace to Fit the Pane Size 

You can scale traces so they are adjusted to the size of the pane. 

To fit a trace within a pane: 

 Right-click the trace, then click Scale to Fit. 

Centering a Trace 

You can center traces within their panes. The trace is centered without changing the amplitude 
axis settings. 

To center a trace in a pane: 

 Right-click the trace, then click Center. 
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Auto-Adjusting Traces 

You can automatically adjust traces to fit within their panes. The auto-adjust function 
automatically adjusts the trace once on each page during playback or review. 

To auto-adjust traces: 

1. Right-click the trace, then click Properties. 

2. Click the Scale tab. 

3. Do one of the following: 

1. To display traces without centering and scaling, under Auto-Adjust, click 
Disabled. 

2. To center traces, under Auto-Adjust, click Center. 

3. To scale traces to fit the pane, under Auto-Adjust, click Scale to fit. 

To toggle auto-adjust on or off: 

Click Toggle Auto-Adjust   on the toolbar. Clicking this button will affect traces with Auto-
Adjust enabled only. 

 

Tip: If you use auto-adjust for some traces, it might be difficult to notice amplitude 
changes. 

Trace Values 

You can display the actual signal sampling values of the trace. These values are visible 
regardless of the time scale settings. 

To show or hide trace values: 

1. Activate the trace. 

2. Do one of the following: 

 Click Show Values   on the toolbar. 

 Right-click the trace, then select Show Values/Hide Values. 

 

Traces Sheet 

A traces sheet includes all available traces. 

To insert a Traces sheet: 

 Right-click any sheet tab, point to Insert, then click Traces. 
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Tip: You can move between traces on the sheet by using TAB and SHIFT. Press TAB 
to jump to the next trace. Press TAB + SHIFT to jump to the previous trace. 

Trace Properties 

You can modify the properties of a trace in the Trace Properties dialog box to optimize the 
display of the trace. You can change the amplitude scales for the trace, turn on or off gridlines, 
rename or filter traces. These functions affect the sheet only, not the original recorded signals in 

the Raw Data folder . Modification of traces affects the whole trace, and can also impact the 
analysis of sheets. 

To change the trace properties: 

1. Right-click the appropriate trace, then click Properties. The Trace Properties dialog box 
displays. 

2. Make the desired adjustments on the General, Scale, View, Format, Filters and 
Calibration tabs. See below for more information. 

3. Click OK. 

 

Note: Filter and Calibration properties cannot be adjusted in the Overview Sheet. 

General Tab 

The General tab displays the trace name, signal type, data sampling rate, and recording 
channel number. You can modify the trace name on this tab sheet. 

 

General Tab – Licensed Version of RemLogic 

 

General Tab – License free Version of RemLogic 

 In the Trace name box, type the desired name. 

The new trace name displays on the amplitude axis. 

Scale Tab 

The Scale tab allows you to set the high and low scale values for the trace and limit the axis 
range. 



Instructions for Use                 RemLogic™ 3.4 

               96 

Scale Tab Properties 

Property Description/Procedure 

Scale In Low value and High value, type the preferred low and high values, respectively, 
for the amplitude scale. These values adjust the range of the trace's amplitude axis. 
The low and high values do not limit the display range of the amplitude axis. 

Limit 
Axis 
Range 

Choosing this option limits the amplitude axis display range. No values above or 
below the given limit display. This display limit assists in avoiding unwanted 
amplitude adjustments for signals out of range due to artifacts. For example, an 
SpO2 trace with axis limit range from 0–100 results in the following display: 

  

Auto-
Adjust 

Auto-scaling or auto-centering of traces can be enabled for each individual trace. 
These options are active during playback and review. You can store the trace 
adjustments with a sheet template so that a specific channel is automatically 

adjusted. You can turn this feature on and off by clicking Toggle Auto-Adjust  
on the toolbar. The auto scale function should be used sparingly, as it might distract 
from when the amplitude is increasing or decreasing. 

Auto-Adjust options: 

 Disabled: The trace is not automatically adjusted; that is, it displays off center 
and unscaled. 

 Center: The trace is automatically vertically centered in the pane without 
changing its amplitude. 

 Scale to fit: The trace is scaled to fit within the pane. 

  

 

Scale Tab – Licensed Version of RemLogic 

 

Scale Tab – License free Version of RemLogic 
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View Tab 

You can change the color of the trace, the display elements, and the view of the amplitude axis. 

View Tab Properties 

Property Description/Procedure 

Display 
elements 

Select Show major gridlines and Show minor gridlines to enable the major and minor 
trace gridlines of the trace. The Show values option displays the actual sampled 
values of the trace. 

Color Click this box to select a color from the Color palette. You can make a custom color 
by clicking Define Custom Color. 

Axis 
View 

You can arrange the trace label from horizontal to vertical on the amplitude axis. 

  

 

View Tab – Licensed Version of RemLogic 

 

View Tab – License free Version of RemLogic 

Format Tab 

 

Format Tab – Licensed Version of RemLogic 

 

Format Tab – License free Version of RemLogic 

This property determines the format of the numbers on the amplitude axis. You can change the 
amplitude unit prefix, or the number of decimals displayed when values display on a trace. For 
more information, see Amplitude Axis. 
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Filters Tab 

By default, no filters are applied to a trace; however, you can apply filters as needed. 

 

Filters Tab – Licensed Version of RemLogic 

 

Filters Tab – License free Version of RemLogic 

Filters Tab Properties 

Property Description/Procedure 

Band 
limitation 
filters 

You can set both high and low cut band limitation filters. High cut eliminates all 
frequencies above a given limit, and low cut eliminates all frequencies below a given 
limit. In the example, all frequencies below 10 Hz and above 70 Hz are eliminated 
from the trace. 

Notch 
filter 

You can apply a notch filter to a trace. A notch filter is a narrow filter that eliminates 
one specific frequency in the data. This is useful to reject the possible impact of the 
50/60 Hz from the mains power (note that this can also be done for individual 
sensors during acquisition with the Embla). 

Calibration Tab* 

*Not available with the License free version of RemLogic 

All calibrated points added to a signal during online 
calibration display in the Calibration tab of the Trace 
Properties dialog. For instructions about calibrating 
signals during acquisition, see Online Calibration in the 
Collecting Data section of the RemLogic online help. 

Changing the Properties of Multiple Traces 

You can select several traces at once and change their properties using the CTRL + SHIFT and 
your mouse. 

To change the properties of multiple traces: 

1. Select the traces you want to change by pressing CTRL and clicking the desired traces. 
Alternatively, to select a group of traces, highlight the first trace you want to select with 
your mouse. Press SHIFT and select the last trace you want to select. All traces 
between the first and last trace are selected. 

2. The traces you selected will turn blue, or the default color you selected for active traces. 

3. Right-click, then click Properties. The Trace Properties dialog box displays. 
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4. Make the desired adjustments on the Scale, View, and Filters tabs. See above for more 
information. 

When you change the properties for multiple traces, you cannot change details on the General, 
Format or Calibration tabs. These properties must be individually set for each trace. 

The properties you choose are applied to all the traces you selected. 

Trace Groups 

Grouping Traces 

You can rearrange traces on a Workpad Sheet as well as group, and rearrange similar and 
dissimilar types in one pane. 

Grouping Similar Traces 

You can group together traces of the same signal type, such as abdomen and thorax, in one 
pane. 

To group similar traces: 

 Right-click the trace, then click Group. 

To ungroup similar traces: 

 Right-click the trace, then click Ungroup. 

Grouping Different Trace Types 

You can group together traces of dissimilar signal types (for example, flattening and flow) in one 
pane by moving a trace from one pane to another. 

To group dissimilar traces: 

1. Position the pointer over the trace. The pointer changes to: . 

2. Press SHIFT + CTRL. 

3. Drag the trace to the new position. The empty pane is automatically deleted. 

 

Note: To reverse this action, right-click inside the pane containing the two traces, then 
select Separate Traces. 

Ungrouping Traces 

To ungroup traces: 

 Right-click any trace in the group, then click Ungroup. 

Removing a Trace from a Group 

You can remove a trace from a group, or place it on a separate pane in the sheet. 

To remove a trace from a group (and sheet): 

 Right-click the trace, then click Remove Trace. 
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Separating a Trace from a Group 

To separate a trace from a group: 

 Right-click the trace, then click Separate Trace. The trace is removed from the grouped 
pane and displays in a separate pane. 

Arranging Traces 

When several traces are placed in one pane, you can rearrange and space them evenly within 
the pane. This function is useful when working with multiple EEG traces in one pane. There are 
two ways to do this: 

 Click the mouse inside the appropriate pane. On the Data menu, click Arrange. 

 Right-click the background of the appropriate pane, then click Arrange. 

Clicking Pane Number  (in the lower-left corner of the Workpad area) displays a list where 
you can choose the number of panes to display. 

Renaming a Trace Group 

The default name on the amplitude axis of grouped traces is based on the signal type of the 
traces. You can change the group name on the amplitude axis. 

To rename a trace group: 

1. Right-click the amplitude axis, then click Properties. 

2. In the Name box, type a new name for the trace group. 

3. Click OK. 

Trace Group Axis Gain 

To set the axis gain of trace group: 

1. Right-click the amplitude axis, then click Properties. 

2. Click the Gain tab. 

3. From the Unit of Measure list, select an option. 

4. In the Gain Value box, type a value. 

5. Click OK. 

Trace Group Layout 

You can adjust the distance between each trace in a grouped pane by inserting or deleting gaps 
between the traces. 

To insert or remove gaps: 

1. Right-click the amplitude axis, then click Properties. 

2. Click the Layout tab. 

3. Select the trace below the space you want to insert a gap, then click Insert Gap. 

4. To remove a gap, select the gap, then click Remove Gap. 
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5. If selected traces in the group were separated from the grouped pane, those traces can 
be added back to the group. Click Add Traces. Select the check boxes in front of the 
desired traces, then click OK. 

6. You can rearrange the gaps by highlighting the gap, then using the up and arrow keys to 
change the position of the gap and the traces. 

Trace Filters 

You can adjust the filter properties of a trace in several ways. Filter adjustments applied to a 
grouped trace are also applied to other traces in the group. To modify the settings of an 
individual trace in a group, first ungroup the traces. 

When a trace is filtered, a new trace is created from the original, and displayed in the Workpad. 
To view the original trace in the Workpad, it must be added manually. 

To adjust the filter properties: 

1. Select the trace. 

2. Do one of the following: 

 Click Filter Settings   on the toolbar.  The Trace Properties dialog displays. 
Make the desired changes, then click OK. 

 Right-click the trace, then select Filters. Select the desired values, or click Other 
to display the Trace Properties dialog box, where you can enter the desired 
frequency. Click OK. 

 

 

Event Graphs 

Two types of event graphs display on the Overview Sheet: On/Off graphs and Multiple Event 
graphs. On/Off graphs indicate the start, end, and duration of an event, such as PAP titration. 

Multiple Event graphs, such as the Hypnogram graph, display data based on several events 
(seven sleep stage-related events). 
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Items marked with an “*” are not available with the License free version of RemLogic 

Name Type Description 

Analysis On/Off Analysis Start/Stop event. Indicates the section of a 
recording marked for computer assisted analysis. 

Export* On/Off Export Start/Stop event. Indicates the section of a recording 
marked for export. 

Room Air On/Off Room Air Start/Stop event. Indicates the beginning, end, 
and duration of the pretreatment (pre-PAP) section of a 
split-night study. 

PAP On On/Off PAP Start/Stop event. Indicates the beginning, end, and 
duration of the PAP titration section of a split-night study. 

Optimal 
Pressure 

On/Off Optimal Pressure Start/Stop event. Indicates the beginning, 
end, and duration of the optimal PAP pressure section of a 
split-night study. 

Lights* On/Off Lights Off/On event. Indicates when room lights are turned 
off and on during a study. 

Video Edit* Multiple Event This graph is generated based on three events: video edit 
mark in, mark out, and clip. 

PAP/Bilevel Multiple Event Based on PAP and Bilevel events. 

Position Multiple Event Based on seven body position events: Unknown, Transition, 
Supine, Left, Prone, Right, and Up. 

Hypnogram* Multiple Event Based on the events of the sleep staging palettes (Adult, 
Pediatric, and Infant). 

Graph Gridlines 

Graph gridlines extend from the axis across the plotting area. 

To show/hide major graph gridlines: 

1. Right-click the graph, then click Properties. 

2. Do one of the following: 

 To show major graph gridlines, under Display Elements, select the Show Major 
Gridlines check box. 

 To hide major graph gridlines, under Display Elements, clear the Show Major 
Gridlines check box. 

3. Click OK. 

To show/hide minor graph gridlines: 

1. Right-click the graph, then click Properties. 
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2. Do one of the following: 

 To show minor graph gridlines, under Display Elements, select the Show Minor 
Gridlines check box. 

 To hide minor graph gridlines, under Display Elements, clear the Show Minor 
Gridlines check box. 

3. Click OK. 

Time Axis 

The time axis, which displays the recording time and time interval in a Workpad, is the 
horizontal axis at the top of a Workpad. You can change the time interval displayed and the unit 
of time displayed (seconds, minutes, and hours) on the time axis. For advanced changes of 
scroll range for the time interval in a Workpad Sheet, see Workpad Display in the following 
location in the RemLogic online help: Work Environment | Workpad Area | Workpad Views. 

 

Time axis, showing a 30 second time interval. 

To show or hide the time axis: 

1. Right-click the gray bar at the top of the sheet that shows the time interval. 

2. Click Show Axis or Hide Axis. 

 

Note: The time axis cannot be adjusted on the Overview Sheet. 

Time Axis Interval 

You can adjust the interval of the time axis. It can be helpful to change the time interval in the 
Workpad, depending on what trace you are viewing. 

To change the time axis interval: 

1. Place the pointer on the time axis. The pointer changes from a white arrow to: . 

2. Click to grab the axis , then move the hand left and right to change the time scale. 

Selecting Predefined Intervals 

You can adjust the time interval on the axis by selecting an interval from a predefined list. 

To select an interval from the list: 

1. Right-click the time axis. 

2. Select an interval from the list. 
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Using Arrow Keys 

You can change the interval on the time axis by using the keyboard. 

To increase the time axis gain (show less time): 

 Press SHIFT + RIGHT ARROW. 

To decrease the time axis gain (show more time): 

 Press SHIFT + LEFT ARROW. 

Time Interval List* 

*Not available with the License free version of RemLogic 

You can make your own list of time intervals to display in the time axis context menu. This is 
useful if you frequently change between several special time intervals. 

To make a list of time intervals: 

1. Double-click the time axis. 

2. Click the Spans tab. 

 Value: Type the value that you want to add to the time axis context menu. 

 Unit of measure: Click the drop-down list box, then select a unit for your new 
value. Click Add. The value is added to the Context menu list. 

 

3. To remove values from the list of intervals, select the value, then click Remove. 

4. To restore the RemLogic default time interval values, click Default values. 

5. Click OK. 

Time Axis Scale 

To change the scale of the time axis: 

1. Right-click the time axis. 

2. Click Properties to display the Time Axis Properties dialog box. 

3. Click the Scale tab. 
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 From: To change the start point of the interval in the Workpad, in the Date and 
Time boxes, enter the date and time of the recording you want to view. You are 
moved to the selected location in the recording. 

 In window: Type the time span to be displayed in the window. 

 Unit of measure: Click the drop-down list box, then select the time unit to be 
displayed on the time axis. 

 

4. Click OK. 

Time Axis Gridlines 

Vertical time gridlines assist in viewing the exact time of any occurrence in a Workpad. 

To display time gridlines: 

1. Right-click the time axis. 

2. Click Properties to display the Time Axis Properties dialog box. 

3. Click the Grid tab. 

4. To display major minor gridlines, select the Major gridlines check box. 

5. To display minor gridlines, select the Minor gridlines check box. 

6. Click OK. 

Time Axis Indication Bars 

You can indicate whether you want Indication Bars to display in the active or inactive areas of a 
split Workpad. You can also adjust the following characteristics for both active and inactive 
Indication Bars: 

 Color 

 Color transparency 

 Line thickness 

For more information about Indication Bars, see Split Workpad Synchronization in the 
following location of the RemLogic online help: Work Environment | Workpad Area | Workpad 
Views | Split Workpad Views. 

To indicate whether the Indication Bar displays in a split Workpad: 

1. Right-click the time axis. 
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2. Select Properties to display the Time Axis Properties dialog box. 

3. If needed, click the General tab. 

4. To display the Indication Bar in the active or inactive window, select the Indication bar 
check box for the corresponding window. Clear the Indication bar check box to remove 
it from a window. 

To change Indication Bar characteristics: 

1. Right-click the time axis. 

2. Select Properties to display the Time Axis Properties dialog box. 

3. If needed, click the General tab. 

 

4. Adjust a characteristic as described in the following table. 
 

Characteristic Adjustment 

Color Click the button to select a color in the Color dialog box. 

To create a color, click Define Custom Colors in the Color dialog 
box, then enter vales in the Hue, Sat (Saturation), and Lum 
(Luminosity) fields, or the Red, Green, and Blue fields. If desired, 
click Add to Custom Colors to add the color to your color palette. 

Click OK to return to the Color dialog box; then click OK to return to 
the Time Axis Properties dialog box. Finally, click OK to confirm your 
changes. 

Transparency Enter a value from 0 to 90 to indicate how dark or light you want the 
color to be. Zero is the darkest value; 90 is the lightest value. 

Thickness Enter value to indicate how thick you want the line to be. One is the 
thinnest value; 10 is the thickest value. 



RemLogic™ 3.4            Instructions for Use 

107                     

Amplitude Axis 

The amplitude axis is on the left side of each pane. Each pane has its own separate amplitude 
axis marked with the trace name, amplitude scale, and unit prefix type. You can change the 
view of the axis so the trace name replaces the amplitude scale. You can also adjust the axis to 
conform effectively to the versatility of different signals. 

Axis Gridlines 

To show or hide major gridlines: 

1. Right-click the amplitude axis, then click Properties. 

2. Click the View tab. 

3. Do one of the following: 

 To show major gridlines, select the Show major gridlines check box. 

 To hide major gridlines, clear the Show major gridlines check box. 

4. Click OK. 

To show or hide minor gridlines: 

1. Right-click the amplitude axis, then click Properties. 

2. Click the View tab. 

3. Do one of the following: 

 To show minor gridlines, select the Show minor gridlines check box. 

 To hide minor gridlines, clear the Show minor gridlines check box. 

4. Click OK. 

Axis Values 

To show or hide axis values: 

1. Right-click the amplitude axis, then click Properties. 

2. Click the View tab. 

3. Do one of the following: 

 To show axis values, select the Show values check box. 

 To hide axis values, clear the Show values check box. 

4. Click OK. 

Axis Categories* 

*Not available with the License free version of RemLogic 

You can create categories to describe the numeric values of a trace. For instance, position trace 
values ranging from 1-4 represent a specific body position. You can assign categories or 
descriptors, such as Supine, Left, Right, and Prone. (In this case, ensure the position sensor is 
mounted correctly so the traces are identified accurately.) 
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To create an amplitude axis category: 

1. Right-click the appropriate amplitude axis, then click Properties. 

2. Click the Categories tab. 

 

3. Select the Display Categories check box. 

4. Click Insert. 

5. In the Value box, type the amplitude value. 

6. Click the cell under Name, then type a name for the value. 

7. Click OK. 

The descriptive text replaces the numerical values on the amplitude axis. 

Axis Label Orientation 

The trace name can display either horizontally or vertically on the amplitude axis. 

To change the orientation of the axis label: 

1. Right-click the amplitude axis, then click Properties. 

2. Click the View tab. 

3. Do one of the following: 

 To display the axis label horizontally, click Horizontal labels. 

 To display the axis label vertically, click Vertical Labels. 

4. Click OK. 

Adjusting the Axis Scale 

You can adjust the scale of the amplitude axis so that it conforms to the signal you are viewing. 
There are various ways to change the amplitude size, and you can also have the application 
scale the amplitude size automatically. 
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Mouse Method 

To adjust the axis with your mouse: 

1. Place the pointer on the amplitude axis to be adjusted. The pointer changes from a white 

arrow to a hand . 

2. Click and hold the left mouse button. The hand grabs  the axis. Moving the mouse up 
and down changes the amplitude scale. 

Keyboard Method 

You can also change the axis gain using your keyboard. 

To increase the trace gain (decrease the trace size): 

 Press SHIFT + UP ARROW. 

To decrease the trace gain (increase the trace size): 

 Press SHIFT + DOWN ARROW. 

Context Menu Method 

You can adjust amplitude axis by selecting an amplitude size from a predefined list. 

To select a predefined amplitude size: 

1. Right-click the amplitude axis you want to adjust. 

2. Click the desired amplitude size. 

To specify an amplitude size: 

1. Right-click the amplitude axis of the appropriate trace. 

2. Click Properties. 

3. Under Scale, type low and high values. 

4. To limit the axis display range, select the Limit Axis Range check box. This option is 
preferable if you want to avoid amplitude adjustments for signals out of range due to 
artifacts. 

5. In the low value and high value boxes, type the limiting values. 

6. Click OK. 

Auto-Adjusting the Axis Scale 

You can auto-scale and auto-center traces. This functionality is active during playback and 
review. 

To enable auto-adjusting: 

1. Right-click the amplitude axis of the trace. 

2. Click Properties. 
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3. Under Auto-Adjust, select the desired option. 

 

 Disabled: The trace will not automatically adjust; that is, it displays off center and 
unscaled. 

 Center: The trace automatically centers vertically in the pane without changing 
its amplitude. 

 Scale to fit: The trace automatically scales to fit within the pane. 

 

Tip: The automatic trace adjustment can be quickly turned on and off by clicking 

Toggle Auto-Adjust   on the toolbar. Only traces that have auto-adjustment 
enabled in the Amplitude Axis Properties dialog box are affected. 

Formatting the Amplitude Axis 

You can change the format of the numbers on the amplitude scale. The amplitude unit prefix or 
the number of decimals that display when values are shown on a trace can be adjusted. 

To change the axis format: 

1. Right-click the amplitude axis you want to change, then click Properties. 

2. Click the Format tab. 

 

 Unit prefix: Specifies what prefix (milli-, micro-, and so on) to use for the axis 
scale. Select Automatic to have the application choose the most appropriate 
prefix for the values in the pane. Select Fixed if you want to lock the axis to a 
specific prefix. From the Unit list, select the desired prefix. 



RemLogic™ 3.4            Instructions for Use 

111                     

 Decimals: Specifies how many decimals to display in the axis scale. Select 
Automatic to have the application choose the appropriate number of decimals 
for the values in the pane. Select Fixed if you want to lock the display to a fixed 
number of decimals. Select Relative if you want the number of decimals to follow 
changes in the unit prefix. For example, using 2 decimals relative to mV yields 
the following display: 220.35 mV (2 decimals), 0.22035 V (5 decimals), 220350 
µV (0 decimals), and so on. 

3. Click OK. 

Live View Window 

When connected to an ambulatory device (Embletta or Embletta Gold via the 3-in-1 cable, 
Titanium, or Embletta MPR via wireless connection to the TX Proxy Unit), you can view the 
collected signals from the device using the Live View window.  This window is used for 
previewing the signals from the device in Monitor Mode only; when the Live View window is 
open, the signal data is not saved.  

When in the Live View Window, user controls are limited.  You can: view a limited number of 
toolbars and menus; change trace display properties and view layouts; switch between 
Workpads; start impedance tests; and begin calibration tests depending on the connected 
device. 

 

Tip: When a Live View window is open, a reminder that you are in Monitor Mode is 
displayed every 5 minutes.  The reminder can be closed by clicking OK. 

Configuring the Live View Window 

The layout of the Live View window can be configured to display your preferred settings.  Trace 
display properties are configured using a Live View Layout which is similar to a Workpad Sheet 
template.   

When running the licensed version of RemLogic, there are six predefined View Layouts 
available: 

 Default Live View – Titanium 

 Default Embletta Live View 

 Default Embletta Gold Live View  

 Embla MPR Preview 

 TX Online Live View 

 DX Online Live View 

The license free version of RemLogic includes two predefined View Layouts: 

 Preview layout (E) – Embletta  Embletta MPR Preview 

Additional View Layouts can be created and used based on personal preference. 

Creating a Live View Layout 

To create a live view layout it is important that the device type and the current sheet templates 
correspond to the desired unit to ensure all possible channels are available.   

To create a view Layout: 

1. Determine which ambulatory device you would like to use for the live view layout, and 
open a study collected from this type of device. 
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2. Right-click on the Workpad Sheet tab and use the menu to insert the default view layout 
for this device type.  

3. Modify the selected layout to fit your preferences. 

4. Save the view layout.  To do this, right-click on the Workpad Sheet tab and select one of 
the following: 

 To save the existing, modified template under a new name, select Save as Sheet 
Template….   

 To save the existing, modified template under the same name, select Save Sheet 
Template. 

5. The New Template Wizard opens.  Specify a location for the template by selecting the 
template type.  If you’re running the license version of RemLogic, select the This 
template is designed for use as a Live View Layout check box. 

 Local Template: Select this option to make the template accessible on the 
current workstation. 

 Workgroup Template: Select this option to make the template accessible to all 
the workstations on your network. 

6. In the Name box, overwrite the existing default layout name by typing a new name for 
the template. Do the same for the description of the template in the Description box. 

7. Select the Device Type that this template applies to using the drop down box. 

8. Click Next. Confirm the name and description. 

9. Click Finish to close the wizard.  

Modifying a Live View Layout 

To modify a live view layout: 

1. Determine the ambulatory device and open a study collected from this type of device. 

2. Right-click on the Workpad Sheet tab and use the menu to insert the desired view layout 
for modification.  

3. Make the desired changes. 

4. Right-click on the Workpad Sheet tab and click Save Sheet Template. 

5. A confirmation dialog appears confirming that you want to make the changes to the 
layout permanent.  Selecting Yes overwrites the original layout and saves your changes, 
and selecting No cancels the save and returns you to the RemLogic window. 

Managing Live View Window Layouts 

You can manage Live View Window layouts in several ways, including setting the active layout 
and editing, copying, or deleting existing layouts.  

To manage a layout: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click View Data, then single click Live View Layout.  
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3. From the Device Type drop-down menu in the right pane, select the device type that 
you would like to modify.  A list of available layouts is shown in the Live View templates 
window.  These templates are associated with the type of device being previewed. 

4. From here, you can choose how you would like to modify the layout. 

If you would like to: Select: 

Set the active layout 1. Select the desired layout in the right pane under Live 
View templates. 

2. Select the Set Active button. 

The Set Active button sets the selected view layout to be 
the current view.  This layout is used to display the Live 
View window when the preview is started. 

 

Note: The active layout is designated with an “*” 
in the Live View templates window. 

Edit an available layout 

  

1. Select the desired layout in the right pane under Live 
View templates. 

2. Select the Edit button. 

The Edit button displays the Template Properties for the 
selected view layout where you can adjust the Name or the 
description of the layout. 

Copy an available layout 

  

1. Select the desired layout in the right pane under Live 
View templates. 

2. Select the Copy button. 

The Copy button makes a copy of the selected view 
layout, and names it with “Copy of” and the original view 
layout name.  You can now edit the copied layout to 
change the name and description. 

Delete an available layout 1. Select the desired layout in the right pane under Live 
View templates. 

2. Select the Delete button. 

The Delete button removes the selected view layout from 
the computer.  This action cannot be undone.  

  

 

Note: If a button is grayed out, it could mean that the selected layout is set as read-
only and is not able to be modified or there is no layout currently selected. 
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Starting the Live View Window  

Provided the ambulatory device is connected and idle, you can preview the signals collected 
with the device in the Live View Window. 

 

Note: When the Live View Window is displayed, no corresponding entry will be added 
to the active recording location. 

To preview the signals and open the live view window: 

1. Connect your device to the computer and ensure that it is available in the Device 
Manager. 

2. Right-click on your device in the Device Manager, and select Preview to activate the 
Live View window. 

3. Depending on your connected device, you may need to configure the device before the 
Live View window will display. 

Items marked with an “*” are not available in the License free version of the RemLogic Software. 

If you are connecting to: You will need to: 

A Titanium* Select the device profile from the drop-down menu. 

An Embletta Gold Configure the Embletta Gold channel acquisition settings 
according to the following list: Respiration, ExG, DC Sensor, 
Signal Settings, Oximeter, Position/Activity, Snoring, 
Differential Pressure Sensor, and Thermistor as required. 

An Embletta Select the Proxy being used and the Configuration by using 
the drop down menus.  Click Next. 

Configure the Embletta channel acquisition settings 
according to the following list: Respiration, ExG, Oximeter, 
Position/Activity, and Signal Settings as required. 

Embletta MPR Select the device profile from the drop-down menu. 

4. Click OK to confirm the channel configuration and begin the preview. 

Closing the Live View Window 

When the Live View window is closed, any changes to the display properties will be stored 
permanently and will apply to the Live View window the next time it is opened. 

To close the Live View Window, do one of the following: 

 Click the  in the upper-right corner of the application window. 

 Click the Stop button   on the Controls toolbar.  

 On the File menu, click Exit. 

 

Note: When the Live View Window is closed, no corresponding entry will be added to 
the recent Workpads list at the bottom of the File menu. 
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Changing the Live View Window Layout 

While the Live View window is displayed you can change to a different pre-defined View Layout 

To change the layout for the live view window, do one of the 
following: 

 Select the new view from the drop-down menu on the View 
Layout Toolbar. 

 Set the new view as active using the Tools | Options menu.  For specific directions, see 
Managing Live View Window Layouts and reference the Set the active layout option. 
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Collecting Data 
This chapter provides information on preparing and performing ambulatory and online studies, 
patient charting, EEG procedures, and programming recording devices. 

 

Note: Prior to starting a recording, check the PC storage to ensure there is adequate 
space. 

Preparing a Study 

To prepare a study, you must enter information on the patient undergoing the study in the 
Patient Information dialog box in the Operations sheet. 

To prepare a study for a new patient: 

1. Click on the  New Workpad icon to open a new Workpad in RemLogic. 

2. On the Operations sheet, click Patient Information. 

Type the patient's name, ID number, date of birth, gender, and body metrics. 

 

Patient Information dialog box – Licensed Version of RemLogic 
 

 

Patient Information dialog box – License free Version of 
RemLogic 

3. Click the Home tab. Type the patient's address, telephone numbers, and email address. 

4. Click the Custom tab (This tab is only available in the licensed version of RemLogic). 
Type the values for customized patient information parameters to be used in reports. For 
more information, see the Adding Patient Information Fields section of in the following 
location in the RemLogic online help: Reporting | Active Reports. 

5. Click the Notes tab. Type comments or notes that you want to display in the comment 
section of RemLogic's active reports. 
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6. Click the Summary tab to review a summary of the patient information. 

7. Click OK. 

To prepare a study for a patient with an existing patient record: 

 In the Recording Manager, right-click the patient's folder, then click New Study. 

A Patient folder is created for the patient in the active data location in the Recording Manager. 

The Patient folder contains a Recording folder   labeled Unknown until the Embletta is 
prepared. 

Applicable to the Licensed version of RemLogic only: 

If the study will involve a flow generator, you can use the ResMed® Tx Link to automatically 
relay pressure and setting changes to RemLogic. For more information, see Using ResMed Tx 
Link. 

Online Studies* 
*Not available with the License free version of RemLogic 

Online studies are recorded with any of the following: 

 Embla N7000 (MDrive, Communication Unit) 

 Embla S4500 (MDrive, Communication Unit) 

 Embletta 

 Embla titanium amplifiers 

 Embletta MPR (when connected 
wirelessly to the TX Proxy Unit) 

  

  

 

Note: To record online using the Embla S4500, Embla N7000, Embletta, Embletta 
MPR, and Embla titanium amplifiers, you must activate the Online PSG license 
component. See License Management for more information. 

Starting an Online Study* 
*Not available with the License free version of RemLogic 

Before starting the study, connect the recording device, prepare the patient for the study 
according to the instructions in the appropriate clinical manual, and enter patient information. 

To start an online recording: 

1. On the Operations sheet, click Device Control. The Device Control dialog box displays. 

2. From the Available Devices list, select the appropriate device. 

 

3. From the Recording Types list, select Start Online. 

4. Click OK. The Recording Wizard displays. 
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5. Click Next to continue. 

6. Follow the wizard instructions to initialize the recording. 

During recording, data automatically saves to the patient's Raw Data folder. You can score and 
analyze data while the device is recording. 

 

Tip: You can also start an online recording by right-clicking the appropriate recording 
device in the Device Manager, then clicking Start Online. 

Stopping an Online Study* 
*Not available with the License free version of RemLogic 

You can stop and resume collection more than once during a study. To protect the collected 
data from loss or corruption, configure RemLogic to back up the recording on the network. For 
more information, see Automated Backup in the Managing Data section of the RemLogic 
online help. 

 

Note: Pause recordings by clicking Pause   on the toolbar. Pausing a recording 
does not interrupt data collection; it stops the playback of the recorded data. 

To stop an online study: 

1. Do one of the following: 

 On the Operations Sheet, click Device Control. The following message displays: 

 

Click OK to stop the recording. 

 Click Stop   on the Controls toolbar. A confirmation dialog box displays. 

2. To stop the recording, click Yes. You can also stop the recording by right-clicking the 
appropriate recording device in the Device Manager, then clicking Stop. 

3. If you configured RemLogic to prompt you to automatically back up recordings when 
collection stops, the following message displays: 
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To create a backup of the study, click Yes. To skip the backup, click No. 

4. If you resume collection after backing up a recording, the next time you stop the 
recording, the following message displays, giving you the option to overwrite the 
previous backup: 

 

 Click Yes to overwrite the previous 
backup. 

 Click No to create a new backup. 

 Click Cancel if you do not wish to back 
up the changes to the recording. 

  

 

 

Note: If you chose to not receive a prompt after collection, the same message 
displays, except Cancel is not available. If you want to access Cancel, select Only 
archive after collection with prompt (Tools | Options | Advanced). 

Resuming an Online Study* 
*Not available with the License free version of RemLogic 

If you stopped an online study, you can resume the study in the same Workpad. Signals that 
were transmitted during the interruption are not saved. 

To resume an online study: 

1. Open the appropriate Workpad. 

2. Do one of the following: 

 On the Operations Sheet, click Device Control. The following message displays: 

 

Click OK. 

 Right-click the appropriate recording device in the Device Manager, then click 
Resume Online. 

3. The Recording Wizard displays. Click Next to continue. 

4. Follow the instructions in the Recording Wizard to resume the study. 

Auto Resuming* 

If a recording device loses power or is disconnected temporarily, a Recording Interrupted event 
is marked on the Workpad Sheet. When power and connection to the recorder restores, the 
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recording automatically resumes, and a Recording Resumed event is marked. An audible 
warning sounds during the interruption. 

 

 

Note: The Auto Resume function might be unavailable with all recording devices. Some 
devices might need a firmware upgrade to support this. 

Attempting to resume recordings older than two hours results in a warning from the 
application. Following a power failure, it might take several minutes for RemLogic to 
recognize the recording device again. 

Saving an Online Study* 
*Not available with the License free version of RemLogic 

RemLogic recordings are automatically saved to the active data storage location specified, 
making them visible in the in the Recording Manager. By default, this location is C:\RemLogic 
Recordings. If you opt to show all data locations in the Recording Manager, the active location 
displays in bold. For more information, see Data Locations. 

A patient folder   is immediately created in the Recording Manager when you enter information 

for a new patient. Patient folders contain a Recording folder . This folder is labeled Unknown 
until a recording starts. 

Recording folders contain a Documents folder   and a Data folder . Recordings are 
automatically saved in the latter when a recording begins. If you modify raw data, as when the 

recording is marked with events, data is saved as a Workpad file in the Recording folder . 

To save an online recording: 

 Do one of the following: 

 Click Save . 

 Press CTRL + S. 
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Ambulatory Studies 

Before starting the recording, enter patient information (see Preparing a Study), and prepare the 
patient according to the instructions outlined in the device clinical manual. Only the Embla 
titanium, Embletta, Embletta Gold, and Embletta MPR devices support the ambulatory recording 
mode. 

RemLogic can display start and end times for the previous ambulatory study in the Recording 
Wizard, making the times available for scheduling the next ambulatory study. By default, this 
information does not display. For more information about enabling this feature, see the Embletta 
part of the Device Settings section in the RemLogic online help. 

A programmed recording cannot exceed 23.59 hours. 

See the following topics for information about programming a recording device: 

 Programming the Embla titanium 

 Programming the Embletta 

 Programming the Embletta Gold 

 Programming the Embletta MPR 

Programming the Embla titanium* 
*Not available with the License free version of RemLogic 

Once you enter the patient information, the titanium can be programmed for a recording. A 
programmed recording cannot exceed 23.59 hours. 

To program the Embla titanium for an ambulatory recording: 

1. Connect the Embla titanium to your computer using the provided cable. 

2. On the Operations sheet, click Device Control. 

3. From the Available Devices list, select the recorder. Ensure the recorder is connected 
to the computer. 

4. From the Recording Types list, select Ambulatory. 

5. Click OK, then click Next to continue. 

6. On the Device Profile list, select a device profile, then click Next. 
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7. Set the recording interval based on the options listed below, then click Next: 

 

 Set start time and duration: Select this option to set the start time and 

recording duration using the up and arrows  to set the correct time. Similarly, 
use the arrows to set the Duration (for example, 8 hours, 30 minutes). 

 Set start and stop time: Select this option to set the start and stop times using 
the up and arrows. 

 Start and stop manually: Select this option if you wish to start and stop the 
recording using the keypad on the Embla titanium. 

 If there is a difference between the Embla titanium's system's and the acquisition 
computer's clock time, click Update to synchronize the time. 

8. Click Next to run the Impedance Test. 
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 The impedance test is part of the Recording Setup wizard. It cannot be repeated 
at another time in the study. 

 When a channel's signal is of good quality, the value for the channel displays in 
KOhms. When the values are too high or too low, High or Low displays. High 
displays for values above 100 KOhms, and Low displays for values below 0.1 
KOhms. 

 Two values display for bipolar channels, positive leads first (Positive lead value / 
Negative lead value). 

 The Impedance screen uses color codes to indicate the results of the test: 

 Green: Acceptable; in the middle 70% of the supplied range 

 Yellow: Inside the acceptable range, but within 15% of the high or low 
values 

 Red: Unacceptable; above or below the acceptable range 

 Dark Gray: Channel is collected, but sensor definition states not to run the 
impedance check 

 Light Gray: Channel is not collected; impedance is not possible 

 Once the test is run, adjust any sensors that do not display acceptable results, 
and click Test Again to run the impedance test on the adjusted signals. When 
you are satisfied with the signal impedance, click Next.  
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 Click Finish to complete the ambulatory setup.  At this point, the RemLogic 
software is still connected to the titanium device, and goes into Preview Mode.  

 While in Preview Mode, you can re-run the impedance test or start a calibration 
test.  If you wish to run either test, right-click on the Embla titanium icon that 
appears in the Device Manager, and select the desired test from the displayed 
menu – e.g. Start Impedance Test / Start Calibration Test Signal.  Alternately, 

you can select the Impedance Test  or Calibration Test Signal  icons in 
the toolbar. 

 Close out of Preview Mode by selecting the Stop  icon. 

9. A confirmation message indicates the recorder was successfully programmed, and 
indicates the patient name and device profile. Disconnect the cable from the device. 

The Embla titanium begins recording based on the time you set in the Recording Wizard, unless 
you have opted for the manual start and stop time. See Downloading Data for information about 
downloading data from the Embla titanium. 

Programming the Embletta 

Once you enter the patient information, the Embletta can be programmed for a recording. A 
programmed recording cannot exceed 23.59 hours. 

 

Note: You must activate the Embletta Online license component to record online. See 
License Management for more information.  This feature is not available on the 
License free Version of RemLogic. 

Firmware build 242 or higher must be installed on the Embletta for the data to properly 
download to RemLogic .If the firmware is not current, you must download data to 
RemLogic with a serial cable, or the data will be lost. 

To program the Embletta for an ambulatory recording: 

1. Connect the Embletta to the computer using the USB download cable. For online 
recordings, use the PC extension cable. 

2. On the Operations sheet, click Device Control or Prepare Recorder (this opens the 
Device Control Box). 

 

3. From the Available Devices list, select the Embletta that is connected to the computer. 

4. From the Recording Types list, select Prepare Ambulatory, then click OK to start the 
Recording Wizard. 
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5. If you elected to base the next recording time on the last study's recording time (see 
Embletta in Device Settings in the RemLogic online help), the start and stop times for the 
last study display in their corresponding boxes. Set the recording interval based on the 
options listed below, then click Next. 

 

 If you want to start the recording immediately, leave all options clear, and click 
Next. The recording starts when the proxy is connected to the Embletta. 

 Start time, Stop time, Duration: Select the check boxes to accept the time that 
displays in the corresponding spin boxes, or to preprogram the recording interval. 
For example, to set the start time of the recording, select the Start time check 

box. If an item needs to be changed, select it, and use the up and arrows   to 
set the correct date or time. 

 Use external switch to start and stop: Select this option to allow the patient to 
control when to start and stop the recording. To start a recording, the patient 
must use a small object to press and hold the Start button on the Embletta until 
the green status light turns on. To stop the recording, the patient must press and 
hold the start button until the green status light turns off. 

6. Select the appropriate study mode, then click Next. 
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7. From the Proxy list, select the desired proxy. 

 

8. Review and modify the default study configuration, including whether signal settings are 
AASM Compliant or NON AASM Compliant. AASM Compliant signals have a higher 
sampling rate. Then click Next. 

9. The Recording Wizard measures the battery voltage. Ensure that the voltage is 
acceptably high. The battery light on the Embletta should be green. It is advisable to 
perform a sleep study with fully charged rechargeable batteries or new alkaline batteries. 
Click Next if the battery voltage is greater than or equal to 2.8 V. 

10. Click Finish to complete the wizard. The preparation progress displays, and a buzz 
sounds while the Embletta's memory clears. The Embletta shows a double-flashing 
yellow status light. 

11. Wait until an information dialog box that summarizes the study. Confirm that the 
Embletta is correctly programmed, then click OK. 

 

12. Disconnect the download cable from the Embletta, and briefly connect the proxy to verify 
the proxy is correct. 

The status light on the Embletta stops blinking when the cable is disconnected. The Embletta 
starts recording based on the recording time you set in the Recording Wizard. Take care to 
insert the proxy firmly. The Embletta beeps when the proxy was properly inserted and shows a 
double-flashing yellow status light. 

See Downloading Data for information on downloading data from the Embletta. 
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Programming the Embletta Gold 

You can prepare the Embletta Gold for ambulatory and online studies. A programmed recording 
cannot exceed 23.59 hours. 

 

Note: For detailed information on the Embletta Gold device, consult the Embletta Gold 
Clinical Manual, available on the RemLogic installation CD. 

Note: The Online capability is only available for the licensed version of the RemLogic 
software. 

Ambulatory Studies 

Before connecting and programming the Embletta Gold for an ambulatory study, you must 
install the device and enter patient information relevant to the study. See the following topics for 
more information: 

 Installing the Embletta Gold 

 Preparing a Study 

Connecting the Embletta Gold 

Desktop 

To connect the Embletta Gold to a desktop computer: 

1. Connect the isolated USB download cable to the Embletta Gold connection port (located 
to the right of the device status lights). 

2. Connect the isolated USB download cable connector to a computer USB port. 

Laptop 

When using the Embletta Gold with a laptop computer, use a self-powered USB hub to ensure 
the USB voltage is adequate for reliable interface and downloads. 

 

Caution: 

For continued patient isolation and protection, first connect the Embletta Gold to the 
isolated USB download cable, then connect the powered hub. 

To connect the Embletta Gold to a laptop computer: 

1. Connect the isolated USB download cable to the Embletta Gold connection port (located 
to the right of the device status lights). 

2. Connect the isolated USB download cable connector to a USB port on the powered USB 
hub. 

3. Plug the hub USB connector into a USB port on the computer. 

4. To power the USB hub, connect it to an electrical outlet. 

Programming the Embletta Gold 

Before programming the device, determine the position of the device on the patient. To conform 
to the default location setting Front, place the device on the patient's abdomen. If another 
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position is preferred, such as the left or right side, modify the default device location (front) 
before starting the recording. 

To modify the device location setting: 

1. On the Analysis menu, click Settings. 

2. In the Profile list, click Custom. 

3. In the left pane, double-click Position. 

4. In the right pane, double-click Location of Position Sensor, then click one of the 
following options: Left Side, Front, or Right Side. 

5. Click Close. 
 

 

Note: Always perform a sleep study with fully charged batteries. 

To program the Embletta Gold for an ambulatory study: 

1. On the Operations sheet, click Device Control. 

2. From the Available Devices list, select Embletta Gold. 

3. From the Recording Types list, select Prepare Ambulatory, then click OK. 

4. In the Multiple Recording Session page of the Recording Wizard, click Add. 

5. Do one of the following in the Add New Session dialog box: 

 To use an external switch to start and stop the recording, select the Use external 
switch to start and stop check box. You can start the recording manually by 
pressing the Embletta Gold start button until the left status light displays green. 
Proceed to step 7. 

 If you elected to base the next recording time on the last study's recording time 
(see Embletta Gold in Device Settings in the RemLogic online help), the start 
time for the last study (including multiple studies) displays in its corresponding 
box. Select the Start time check box, then click Next. 

 To specify a start time, select the Start time check box, then specify the 
month/day/year/hour/minute. The Embletta Gold automatically starts at the 
specified time once disconnected from the setup computer. 

6. Specify and stop time and recording duration, if desired. 

 If you elected to base the next recording time on the last study's recording time 
(see Embletta Gold in Device Settings in the RemLogic online help), the stop 
time for the last study (including multiple studies) displays in its corresponding 
box. Select the Stop time check box, then click Next. 

 To specify a stop time, select the Stop time check box, and specify the 
month/day/year/hour/minute. The Embletta Gold will automatically stop at the 
specified time. 

 To specify a recording duration, select the Duration check box, click the first 
digit, then type the duration in hours. Click the last two digits, and type the 
duration in minutes. 
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7. Click OK. 

8. In the Multiple Recording Session page of the Recording Wizard, do one of the following: 

 To add another recording session, repeat steps 4-7. 

 To continue, click Next. 

9. In the study mode page of the Recording Wizard, do one of the following, then click 
Next: 

 To record respiratory parameters using a nasal cannula that assists in the 
diagnosis of sleep-disordered breathing, click Diagnostic Study. 

 To record respiratory parameters and PAP mask pressure, click PAP/Bi-level 
Study. 

 To record respiratory parameters and ResMed Therapy Device flow generator 
signals, click ResMed Therapy Device Study. 

10. Configure the Embletta Gold channel acquisition settings according to the following 
table: 

To Record Do This 

The nasal cannula signal Under Respiration, select the Nasal Cannula check box. 

The Abdominal 
Respiratory Effort 
(XactTrace) signal 

Under Respiration, select the Abdomen Belt XactTrace 
check box. 

The Thoracic Respiratory 
Effort (XactTrace) signal 

Under Respiration, select the Thorax Belt XactTrace 
check box. 

The EKG signal Under ExG, select the ExG check box, then click EKG. 

The EEG signal Under ExG, select the ExG check box, then click EEG. 

The EMG signal Under ExG, select the ExG check box, then click EMG. 

A DC sensor signal Under DC Sensor, select the DC Sensor check box, then 
select a sensor from the list. By default, the last DC sensor 
selected for the study type is used. To add, edit, or delete a 
DC sensor definition, see Device Settings. 

A lower sampling rate In the Signal Settings section, select NON AASM 
Compliant to record with lower sampling rates, which result 
in faster study downloads and computer assisted analysis. 

Select AASM Compliant for a higher sampling rate, which is 
the signal quality suggested by the AASM manual for sleep 
studies. However, data download and computer assisted 
analysis take longer than the NON AASM Compliant 
setting. 

The SpO2 and Pulse 
signal derived from the 
oximeter 

Under Oximeter, select the SpO2 & Pulse check box. 
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To Record Do This 

The Pulse Waveform 
signal derived from the 
oximeter 

Under Oximeter, select the Pulse Waveform check box. 

The Gravity signal 
derived from the 
Position/Activity sensor 

Under Position/Activity, select the Gravity check box. 

The Snoring signal 
derived from the nasal 
cannula 

Under Snoring, select the Derived from nasal cannula 
check box. 

The Differential Pressure 
Sensor signal 

Under Differential Pressure Sensor, select the Differential 
Pressure Sensor check box. By default, the last differential 
pressure sensor selected for the study type is used. To add, 
edit, or delete a differential pressure sensor definition, see 
Device Settings. 

The Thermistor signal Select the Thermistor check box. 

11. Click Finish. A progress indicator displays. While the device memory clears, the 
Embletta Gold buzzes. 

Do not disconnect the Embletta Gold from the USB download cable until a message 
window indicates the Embletta Gold is programmed correctly, and the right status light 
flashes amber once every second. 

12. Disconnect the USB download cable from the setup computer. The right status light 
flashes amber twice in quick succession every second to indicate that a study is 
pending. The light stops flashing when the device starts recording at the programmed 
time. 

 

Tip: To add, edit, or delete a DC or differential pressure definition, see Device 
Settings. 

  

 

Note: Unplug the isolated USB cable from the Embletta Gold before starting a 
recording. If the USB cable is connected to the device, recordings will not start at a 
preprogrammed time or by pressing the external start button. 

Online Studies* 

*Not available with the License free version of RemLogic 

 

Note: You must activate the Embletta Online license component to record online. See 
License Management for more information. 

Before connecting and programming the Embletta Gold for an online study, you must install the 
device and enter patient information relevant to the study. See the following topics for more 
information: 

 Installing the Embletta Gold 
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 Preparing a Study 

Connecting the Embletta Gold* 

The Embletta Gold can be configured for attended online studies by connecting the device to 
the acquisition computer using the 3-in-1 cable. The cable has a built-in isolation unit for patient 
safety, and a quick-release connector that allows easy disconnection from the computer during 
the night. This online solution provides the same parameters as Embletta Gold diagnostic 
studies, and allows PAP mask pressure to be viewed during a PAP study. 

To connect the online Interface: 

1. Plug the cable serial connector into the serial port of the computer. If the computer does 
not have a serial port, a USB-to-serial adaptor is required. 

 

2. Connect the 3-pin connector of the 3-in-1 cable to the black 3-pin touchproof input of the 
Embletta Gold. 

 

Note: Online studies cannot be performed when using the ResMed Therapy Device, as 
the Embletta Gold requires the same 3-in-1 cable when configured for online studies. 

Disconnecting the Cable during a Study 

The 3-in-1 cable can be disconnected during a recording if the patient needs to leave the bed. 

To disconnect the cable: 

1. Slide the quick-release lock down (as shown). 
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2. Have the patient carry the Embletta Gold together with the cable isolation unit. 

3. When the patient returns to bed, reconnect the quick-release lock by lining up the 
arrows. 

When the 3-in-1 cable is reconnected, the recording automatically resumes and continues in the 
same Workpad. 

Programming the Embletta Gold* 

Before you program the device, determine the position of the device on the patient. To conform 
to default location setting Front, place the device on the patient's abdomen. If another position is 
preferred, such as the left or right side, modify the default device location (front) before starting 
the recording. 

To modify the device location setting: 

1. On the Analysis menu, click Settings. 

2. In the Profile list, click Custom. 

3. In the left pane, double-click Position. 

4. In the right pane, double-click Location of Position Sensor, then click one of the 
following options: Left Side, Front, or Right Side. 

5. Click Close. 
 

 

Note: Always perform a sleep study with fully charged batteries. 

To program the Embletta Gold for an online recording: 

1. On the Operations sheet, click Device Control. 

2. From the Available Devices list, select Embletta Gold. 

3. From the Recording Types list, select Start Online, then click OK. 

4. In the Multiple Recording Session page of the Recording Wizard, click Add. 

5. Do one of the following in the Add New Session dialog box: 

 To use an external switch to start and stop the recording, select the Use external 
switch to start and stop check box. You can start the recording manually by 
pressing the Embletta Gold start button until the left status light displays green. 
Proceed to step 7. 

 To specify a start time, select the Start time check box, then specify the 
month/day/year/hour/minute. The Embletta Gold automatically starts at the 
specified time once disconnected from the setup computer. 

6. Specify a stop time and recording duration, if desired. 

 To specify a stop time, select the Stop time check box, and specify the 
month/day/year/hour/minute. The Embletta Gold will automatically stop at the 
specified time. 
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 To specify a recording duration, select the Duration check box, click the first 
digit, and type the duration in hours. Click the last two digits, and type the 
duration in minutes. 

7. Click OK. 

8. In the Multiple Recording Session page of the Recording Wizard, do one of the following: 

 To add another recording session, repeat steps 4-7. 

 To continue, click Next. 

9. In the study mode page of the Recording Wizard, do one of the following: 

 To record respiratory parameters using a nasal cannula that assists in the 
diagnosis of sleep-disordered breathing, click Diagnostic Study. 

 To record respiratory parameters and PAP mask pressure, click PAP/Bi-level 
Study. 

 To record respiratory parameters and ResMed Therapy Device flow generator 
signals, click ResMed Therapy Device Study. 

10. Click Next. 

11. Configure the Embletta Gold channel acquisition settings according to the following 
table: 

To Record Do This 

The nasal cannula signal Under Respiration, select the Nasal Cannula check 
box. 

The Abdominal Respiratory 
Effort (XactTrace) signal 

Under Respiration, select the Abdomen Belt 
XactTrace check box. 

The Thoracic Respiratory Effort 
(XactTrace) signal 

Under Respiration, select the Thorax Belt XactTrace 
check box. 

The EKG signal Under ExG, select the ExG check box, then click 
EKG. 

The EEG signal Under ExG, select the ExG check box, then click 
EEG. 

The EMG signal Under ExG, select the ExG check box, then click 
EMG. 

A DC sensor signal Under DC Sensor, select the DC Sensor check box, 
then select a sensor from the list. By default, the last 
DC sensor selected for the study type is used. To add, 
edit, or delete a DC sensor definition, see Device 
Settings. 
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To Record Do This 

A lower sampling rate In the Signal Settings section, select NON AASM 
Compliant to record with lower sampling rates, which 
result in faster study downloads and computer 
assisted analysis. 

Select AASM Compliant for a higher sampling rate, 
which is the signal quality suggested by the AASM 
manual for sleep studies. However, data download 
and computer assisted analysis take longer than the 
NON AASM Compliant setting. 

The SpO2 and Pulse signal 
derived from the oximeter 

Under Oximeter, select the SpO2 & Pulse check box. 

The Pulse Waveform signal 
derived from the oximeter 

Under Oximeter, select the Pulse Waveform check 
box. 

The Gravity signal derived from 
the Position/Activity sensor 

Under Position/Activity, select the Gravity check 
box. 

The Snoring signal derived from 
the nasal cannula 

Under Snoring, select the Derived from nasal cannula 
check box. 

The Differential Pressure 
Sensor signal 

Under Differential Pressure Sensor, select the 
Differential Pressure Sensor check box. By default, 
the last differential pressure sensor selected for the 
study type is used. To add, edit, or delete a differential 
pressure sensor definition, see Device Settings. 

The Thermistor signal Select the Thermistor check box. 

12. In Completing the Recording Wizard page, click Next. 

13. A message window indicates the Embletta Gold is programmed correctly, and the right 
status light flashes amber once every second. 

14. To start the recording, click Finish. The Embletta Gold begins acquiring and transmitting 
signals, which display on the Embla Resp Workpad Sheet. 

 

 

Tip: To add, edit, or delete a DC or differential pressure definition, see Device 
Settings. 

Programming the Embletta MPR 

Once you enter the patient information, the Embletta MPR can be programmed for a 
recording. When using either the Embletta MPR or Embletta MPR PG (with or without the TX 
Proxy Unit), a programmed recording cannot exceed 24:00 hours.   For an ambulatory study 
using the ST/ST+ Proxy (with or without the TX Proxy Unit), the maximum study duration is 
13.50 hours. 
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Note: To record online, you must connect to the TX Proxy Unit wirelessly and activate 
the Embletta Online license component to record online. See License Management for 
more information. 

Note: When using the Embletta MPR or Embletta MPR PG Unit, you can program up 
to three (3) start/stop times for an ambulatory study.  For an ambulatory study with the 
TX Proxy Unit, only two (2) start/stop times can be programmed.  With the ST/ST+ 
Proxy, only one (1) start/stop time can be programmed when programming an 
ambulatory study.  With the ST/ST+ Proxy, only one (1) start/stop time can be 
programmed (with or without TX Proxy Unit) for a maximum duration of 13.5 hours. 

Before connecting and programming the Embletta MPR for an ambulatory or online study, you 
must install the device and enter patient information relevant to the study. See the following 
topics for additional information: 

 Installing the Embletta MPR 

 Preparing a Study 

Ambulatory Recordings 

To program the Embletta MPR for an ambulatory recording: 

 

Note: Always perform a sleep study with fully charged batteries. 

1. Connect the Embletta MPR to the computer using the USB cable provided with the 
system.  

2. On the Operations sheet, click Device Control. 

 

3. From the Available Devices list, select the Embletta MPR that is connected to the 
computer. 

4. From the Recording Types list, select Prepare Ambulatory, then click OK.  Alternately, 
you can right click on the device in the Device Manager and select Prepare 
Ambulatory. 

5. From the Select Device Profile dialog, select the desired study profile for your 
ambulatory study from the drop-down menu. If the device profile is edited from here, the 
edits are only temporary. To edit the device profiles for future recordings, refer to 
Embletta MPR Device Profiles. 
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When using the ST or ST+ Proxy, you must identify the P-Ground connection type in the 
Select Device Profile dialog. 

If you are connecting your P-Ground connection to: Choose: 

The patient and the ST/ST+ Proxy Only Single (ST/ST+ Proxy Only) 

The patient and both the Embletta MPR, when using 
the ExG channel, and ST/ST+ Proxy. 

Dual (MPR and ST/ST+ Proxy) 

 

 

 

Note: When using the Embletta MPR PG in conjunction with the TX Proxy unit, a 
maximum of two ambulatory recordings can be scheduled.  If you are recording 
two studies using both a ResMed Therapy device and a TX Proxy unit, both units 
will need to be powered off once the first study has ended.  Prior to starting the 
second ambulatory study, the ResMed Therapy device and the TX Proxy unit will 
need to be powered back on. 

6. Set your Start/Stop Times by selecting one of the following: 

 Start Automatically – Begins the study once the unit has been unplugged from 
the computer and the Oximetry senor or XactTrace belts begin to send a valid 
signal. 

 Use Start and Stop Time – Begins and ends the study at the specific time set. 

7. Set your start and stop times for your study to begin by selecting one of the existing 
preset times listed.  If you would like to change a preset for the current study being 
collected, select the preset and manually adjust the Start/Stop information using the 
Add/Edit Time box.  These can be modified on a permanent basis by creating or 
modifying the preset using the device profile. 
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To adjust the: Do this: 

Start date Select one of the following from the drop-down menu: Today, 
Tomorrow, in 2 days, in 3 days, or in 4 days. 

Start Time Select this option to set the start time using the up and down arrows to 
set the correct time.  Alternately, you can manually type the start time. 

Stop Time Select this option to set the start time using the up and down arrows to 
set the correct time.  Alternately, you can manually type the stop time. 

The Duration displays the total duration of your selected study based on Start and Stop 
times. 

8. Once the start/Stop times have been set or selected, press Next to initialize the 
ambulatory recording. 

9. A verification screen showing the information for the study displays.  Click Finish. 

 

Tip: You can choose to display a dialog versus using the wizard by selecting the 
check box next to In the future display dialog instead of wizard to start 
recording.  This can be re-enabled by going to Devices | Settings | Embletta 
MPR | General Tab and selecting the Use Recording Wizard to start 
recording check box. 

10. Wait while the Embletta MPR is being programmed.  This can take a few minutes; do not 
disconnect the Embletta MPR from the computer until after the Ambulatory Recording 
Summary has displayed.  Once displayed, click OK to close the summary and 
disconnect the Embletta MPR from the computer. 
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Online Recordings 

To program the Embletta MPR for an online recording: 

 

Note: Always perform a sleep study with fully charged batteries. 

Note: To record online, you must connect to the TX Proxy Unit wirelessly and activate 
the Embletta Online license component to record online. See License Management for 
more information. 

 

 

Note: If a patient needs to move out of range of the TX Proxy Unit, during the 
collection of an online recording, the study needs to be stopped and then resumed in 
RemLogic once the patient is back in range. Out of range is defined as being further 
than 20 feet from the TX Proxy Unit, being out of the direct line of sight of the TX 
Proxy Unit (i.e. in the bathroom), or both. 

Note: If a patient moves out of range unexpectedly, the study should be stopped in 
RemLogic.  At this time, the partial study should be downloaded to RemLogic and a 
new study should be started.  Once the studies are complete, they can be joined in 
RemLogic.  See Joining Recordings in the Collecting Data Section of the Online 
Help. 

1. Open RemLogic 

2. Pair the Embletta MPR with a TX Proxy Unit using the Configuration tool, and ensure the 
TX Proxy Unit is connected to the Local Area Network (LAN) of the recording computer. 

3. On the Operations sheet, click Device Control. 

4. From the Available Devices list, select the Embletta MPR that is connected to the 
computer. 

5. From the Recording Types list, select Start Online, then click OK.  Alternately, you can 
right click on the device in the Device Manager and select Start Online. 

6. The Recording wizard opens.  Select Next. 

7. From the Select Device Profile dialog, select the desired study profile for your online 
study from the drop-down menu. If the device profile is edited from here, the edits are 
only temporary. To edit the device profiles for future recordings, refer to Embletta MPR 
Device Profiles. 

 

When using the ST or ST+ Proxy, you must identify the P-Ground connection type in the 
Select Device Profile dialog. 

If you are connecting your P-Ground connection to: Choose: 

The patient and the ST/ST+ Proxy Only Single (ST/ST+ Proxy Only) 
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If you are connecting your P-Ground connection to: Choose: 

The patient and both the Embletta MPR, when using 
the ExG channel, and ST/ST+ Proxy. 

Dual (MPR and ST/ST+ Proxy)  

8. A verification screen showing the information for the study displays.  Click Finish. 

 

Tip: You can choose to display a dialog versus using the wizard by selecting the 
check box next to In the future display dialog instead of wizard to start 
recording.  This can be re-enabled by going to Devices | Settings | Embletta 
MPR | General Tab and selecting the Use Recording Wizard to start 
recording check box. 

9. Wait while the Embletta MPR is being programmed.  This can take a few minutes and 
the following dialog displays: 

 

Once complete, the online recording begins. 

Using ResMed Tx Link* 
*Not available with the License free version of RemLogic 

ResMed Tx Link communicates information between a computer with RemLogic and ResMed 
EasyCare Tx software and RemLogic on a local area network (LAN) and a connected flow 
generator. For example, when you enter a pressure change in EasyCare Tx, the command is 
passed through Tx Link to the flow generator. Concurrently, Tx Link communicates the change 
to RemLogic, and includes information about current settings when the change was made. 

The types of information (tracings, signals, and setting information) that are produced depend 
upon the flow generator model. To determine which flow generators are compatible with Tx 
Link, visit the ResMed web site: www.resmed.com. 

The Tx Link is compatible with the following amplifiers: 

 Embletta 

 Embletta Gold 

 Embla titanium 

 MDrive (with an Ethernet connection to 
the LAN) 

 Embla communication units 

 Embletta MPR (online mode only – 
ResMed Therapy Device Setting 
disabled) 

  

  

 

Note: Before beginning the study in RemLogic, the EasyCare Tx software will need to 
be started and the therapy device should be turned on. 

http://www.resmed.com/
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Laying Tags with Tx Link* 
*Not available with the License free version of RemLogic 

If RemLogic is recording a study, the Tx Link automatically lays a connect tag when the 
connected flow generator is turned on. In addition to the time, the connect tag includes the flow 
generator's product name and its serial number. Concurrently, Tx Link automatically lays a 
settings event that includes the attributes that apply to the current mode (for example, IPAP 
pressure, EPAP pressure, and IPAP Max Time). If the flow generator changes modes, Tx Link 
automatically lays a tag with the new mode and its attributes. Throughout the study, RemLogic 
records all traces delivered from the flow generator connected to Tx Link. 

You can add special events, such as room air start/stop or pressure events and values, through 
the Event Palette. For more information, see the Flow Generator Events section in the 
following location of the RemLogic online help: Analyzing Data | Marking Events | Special 
Events. 

If the flow generator is turned off or in standby mode, Tx Link automatically lays a disconnect 
event, and data recording discontinues until the flow generator returns to an active mode. 

Viewing Tx Link Tags* 

*Not available with the License free version of RemLogic 

Setting information for the flow generator that was recorded with the tag, such as mask type, 
mode, and pressure, displays in the RemLogic Workpad when you mouse over the event that 
caused Tx Link to automatically lay the tag. Additionally, RemLogic records the flow generator's 
product name for reporting purposes. 

Using Patient Charting* 
*Not available with the License free version of RemLogic 

Patient charting allows you to electronically chart observations at intervals in the study. Patient 
charting also allows you to generate an observation report summarizing all the collection 
observations, all the general and summary observations, or only the key observations. 

 

Button Description 

 

Opens the Initial Observations chart. This button is available when the Enable Initial 
Observations option is turned on in the Observations settings. 

 

Adds a Tech Note. 

 

Displays the time until the next observation or the time elapsed since the last 
observation was due.  

 

Displays the number of fields completed.  

 

Displays the text of the Patient Observation report.  
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Observations toolbar 

1 2 3 4 5 

     

The Observations toolbar is organized according to the Patient Charting workflow: 

1. Chart Initial Observations: Prior to starting the study or shortly after starting the study, 
chart your observations and any general comments you may have about the patient. 

Click Initial Observation  to open the Initial Observations chart. You can edit the 
contents of the Initial Observations chart until you close the Workpad. Then, the content 
of the chart is no longer editable (read-only). 

2. Add Tech Notes: For your convenience, you click Add Note  to add a note during 
collection or analysis. For more information, see the Note Box section in the following 
location of the RemLogic online help: Analyzing Data | Marking Events | Special 
Events. 

3. Chart Collection Observations: Once you start collection and lay the Lights Off 
marker, the software begins counting down the time until the first Collection 
Observations chart is due to be completed. 

When it is time for you to complete the Collection Observations chart, the chart either 

opens automatically or Collection Observation  flashes on the Observations 
toolbar. 

In the Collection Observations chart, you document your observations and any general 
comments about the patient at that point in the study. 

You can only revise the current Collection Observations chart until the next Collection 
Observations chart is due. When the next Collection Observations chart is due, the 
previous Collection Observations chart cannot be edited (read-only). 

4. Summary Observations chart: Throughout the study, you can document any 
conclusions drawn about the patient. 

Click Summary Observations  to open the Summary Observations chart. You can 
edit the contents of the Summary Observations chart until you close the Workpad. Then, 
the content of the chart is read-only. 

5. Generate and View Observation Report: At the end of the study or during analysis, 
you can generate and view an observation report. 

Depending on your system settings (see the Configuring Observation Report 
Settings section in the following location of the RemLogic online help: Collecting Data | 
Managing Patient Data), you can generate an observation report that summarizes all 
collection observations (Detailed Observation Report), all general and summary 
observations (Summary Observation Report), or only those collection observations 
marked as important (Notable Event Report). 

Click Observation Report  to generate and view an observation report. 
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If the Initial -, Collection -, and/or Summary Observation buttons are not available on the 
Observations toolbar, charts must be added to the Patient Charting workflow. See Managing 
Patient Charting for more information. 

Charting Initial Observations* 

*Not available with the License free version of RemLogic 

Prior to starting the study or shortly after starting the study, chart your observations and any 
general comments you have about the patient. 

Open the Initial Observations chart by clicking Initial Observation  on the Observations 
toolbar. By default, the contents of the Initial Observations chart remains editable until you close 
the Workpad. 

To chart initial observations prior to starting or shortly after starting the study: 

1. On the Observation toolbar, click Initial Observation  to open the Initial 
Observations chart. 

2. Complete the Initial Observations chart. 

3. Click OK. 

 

Tip: Press TAB to move through the Initial Observations chart. 

Charting Collection Observations* 
*Not available with the License free version of RemLogic 

Throughout the study, you document your observations and any general comments about the 
patient in the Collection Observations chart. 

Once you start collection and lay the Lights Off marker, the software begins counting down the 
time until the first Collection Observations chart is due to be completed. When it is time for you 
to complete the Collection Observations chart, the chart either opens automatically or 

Collection Observation  flashes on the Observations toolbar. 

When a Collection Observations chart is updated by the sleep technologist, the Collection 

Observations chart icon   is moved to the time in the study timeline when the chart was 

revised. You can rest on  to view a ToolTip that displays the content of the Collection 

Observations chart or you can double-click  to open the Collection Observations chart. 

If you are unable to complete the Collection Observations chart, click Snooze to postpone 
completing the chart. The Collection Observations chart does not display until the delay period 
expires or the next Collection Observations chart is due, whichever duration is shorter. 

You will continue to complete the Collection Observations chart at regular intervals throughout 
the study until you lay the Lights On marker or stop collection. If you stop and then resume a 
collection, the software resets the interval to when the next Collection Observations chart is due 
and begins counting down. 

By default, the Collection Observations chart can only be revised until the next Collection 
Observation chart is due to be completed. When the next Collection Observations chart is due, 
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the previous Collection Observations chart cannot be edited (read-only). If you miss completing 
a Collection Observations chart for an interval, the missed chart is saved as a blank chart. Any 
partially completed charts are saved as is. 

To chart Collection observations during the study 

1. If necessary, on the Observation toolbar, click Collection Observation  to open the 
current Collection Observations chart. 

If you are unable to complete the Collection Observations chart at that time, click Snooze 
to postpone completing the chart. 

2. Complete the Collection Observations chart. 

3. Do one of the following: 

 To identify an observation as important, click   next to the observation of note. 

 To identify an entire Collection Observations chart as important, in the top right 

corner of the Collection Observations chart, click . 

4. Click OK. 

 

Tip: Press TAB to move through the Collection Observations chart. 

Charting Summary Observations* 
*Not available with the License free version of RemLogic 

Throughout the study, you can document any conclusions you have drawn about the patient. 

Depending on your system configuration, the Summary Observations chart might appear at 
intervals throughout the study with the Collection Observations chart, or you can open the 

Summary Observations chart manually by clicking Summary Observations  on the 
Observations toolbar. 

By default, you can edit your comments in the Summary Observations chart until you close the 
Workpad. 

To chart summary observations during or at the end of the study: 

1. If necessary, click Summary Observations  to open the Summary Observations 
chart. 

2. Complete the Summary Observations chart. 

3. Click OK. 

 

Tip: Press TAB to move through the Summary Observations chart. 
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Generating the Observations Report* 
*Not available with the License free version of RemLogic 

At the end of the study or during analysis, you can generate and view an observation report by 

clicking Observation Report  on the Observations toolbar. 

Depending on the default Observation Report template specified as your default template (see 
Configuring Observation Report Settings) (see the Configuring Observation Report Settings 
section in the following location of the RemLogic online help: Collecting Data | Managing 
Patient Data), you will generate one of the following observation reports: 

Notable Event Report: Lists only those collection observations marked as important by the 
sleep technologist. 

Detailed Observation Report: Lists all the collection observations. 

Summary Observation Report: List all the general observations from the Initial– and 
Collection Observations charts and all the comments from the Summary Observations chart. 

When you generate the Observation Report, it is saved with the study. Like other reports, you 
can publish your generated report to the Embla Enterprise System. 

Observation Reports have two key features: 

Hyperlinked Observation Times: Depending on your system configuration, your Observation 
Reports might have observation time hyperlinks. These hyperlinks allow you to click the 
observation time in the report to go to the corresponding time in the study. 

Highlighted Notable Observations: Observations of note are easily identified in the report by 
the bold text. 

To generate and view the Observation Report: 

 On the Observations toolbar, click Collection Observation  to generate and open 
an Observation Report. 

Viewing Observations in Analysis* 
*Not available with the License free version of RemLogic 

In analysis, you can open the Initial Observations chart, the Collection Observations chart, and 
the Summary Observations chart from the Observations toolbar. By default, these charts are not 
editable (read-only) in analysis. For more information, see Turning off Observations are Read-
Only After Collection. 

To view the Initial Observations chart: 

 On the Observations toolbar, click Initial Observation . By default, the contents of 
the chart are read-only. 

To view the Collection Observations chart: 

1. On the Observations toolbar, click Collection Observation , or double-click  on 
the collection timeline. By default, the contents of the chart are read-only. 
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2. In the top right corner of Collection Observations chart, click  or  to move to the 
previous or next Collection Observations chart. 

The   is not available when the first observation is displayed. The  is not available 
when the last observation is displayed. 

To view the Summary Observations chart: 

 On the Observations toolbar, click Summary Observations . By default, the 
contents of the chart are read-only. 

Managing Patient Charting* 
*Not available with the License free version of RemLogic 

Patient charting allows sleep technologists to chart observations electronically at regular 
intervals in a study. Patient charting prompts the sleep technologist to assess the patient 
regularly throughout the night and eliminates the need for paper charting. 

Patient charting consists of three observation charts: 

Initial Observations: The sleep technologist uses this chart to document observations prior to 
starting the study or shortly after starting the study. 

Collection Observations: The sleep technologist uses this chart to document observations at 
intervals or arbitrary times during the study. 

Summary Observations: The sleep technologist uses this chart to document any conclusions 
drawn during or after the study. 

You can customize the content of the Initial-, Collection-, and Summary Observations charts. 
You can also customize the intervals at which the Collection Observations chart appears to the 
sleep technologist. Your customized settings are saved to a file so you can transfer these 
settings to other sleep labs. 

By default, patient charting is available during collection. 

Turning off Observations are Read-Only After Collection* 

*Not available with the License free version of RemLogic 

By default, the Initial Observations chart and Summary Observations chart can be edited 
throughout a study. These charts cannot be edited (read only) once the sleep technologist 
closes the Workpad. 

By default, the Collection Observations chart can be revised until the next Collection 
Observations chart is due to be completed. When the next Collection Observations chart is due, 
the previous Collection Observations chart cannot be edited (read-only). 

By default, all observations are read-only in analysis. 

If you want to permit sleep and scoring technologists to edit observations, then you must turn off 
the Observations are read-only after collection option. 

To turn off the Observations are Read Only After Collection option: 

1. On the Tools menu, click Options. 



Instructions for Use                 RemLogic™ 3.4 

               146 

2. In the left pane, click Observations. 

3. Clear the Observations are read-only after collection check box. 

4. Click OK. 

Turning on the Collection Observation Charting Notification* 

*Not available with the License free version of RemLogic 

If you want your sleep technologists to chart collection observations at regular intervals in the 
Collection Observations chart, you can notify the sleep technologist of the requirement to chart 
in one of two ways: 

 The Collection Observations chart appears automatically at the set interval. 

 The Collection Observation button flashes on the Observations toolbar at the set 
interval. 

To turn on the Observation buttons flash on toolbar option: 

1. On the Tools menu, click Options. 

2. In the left pane, click Observations. 

3. Do one of the following: 

 To open the Collection Observations chart automatically at the set interval, select 
the Collection Observations automatically pop up check box. 

 To flash the Collection Observation button on the Observations toolbar at the set 
interval, select the Collection Observation button flashes on toolbar check 
box. 

4. Click OK. 

Adjusting the Transparency of the Collection Observations Chart 
ToolTip* 
*Not available with the License free version of RemLogic 

From the signal view, you can point to a Collection Observations chart icon  to see a 
summary of the Collection Observations chart in a ToolTip. 

By default, the background of the Collection Observation ToolTip is transparent, so you can still 
see the signal waveforms behind the ToolTip. If you want to make the Collection Observation 
ToolTip opaque so it is easier to read, you can adjust the transparency of the ToolTip in the 
Observation settings. 

To adjust the transparency of the Collection Observation ToolTip: 

1. On the Tools menu, click Options. 

2. In the left pane, click Observations. 

3. Move the slider to the left or right to decrease or increase the opacity of the Collection 
Observation ToolTip. 

4. Click OK. 
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Configuring the Initial Observations Chart* 
*Not available with the License free version of RemLogic 

In the Initial Observations chart, the sleep technologist documents observations about the 
patient prior to or shortly after starting the study. 

You can add or remove the Initial Observations chart from the patient charting workflow. When 
you remove the Initial Observations chart from the patient charting workflow, the Initial 
Observations button is not available on the Observations toolbar. 

You can also customize the contents of the Initial Observations chart. By default, the sleep 
technologist can chart blood pressure, blood oxygen saturation, neck size, and general 
comments in the Initial Observations chart. 

When you update the Initial Observations chart, your changes will not take effect until the next 
collection. 

To configure the Initial Observations: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Observations. 

3. Under Observations, click Initial Observations. 

4. Select the Enable Initial Observations check box to add the Initial Observations chart 
to the charting workflow. 

5. Do one of the following: 

To Do This 

Add an observation field a. Click Add. 

b. Skip to step 6. 

Edit an observation field a. Click the observation you want to edit. 

b. Click Edit. 

c. Skip to step 6. 

Delete an observation 
field 

a. Click the observation you want to delete. 

b. Click Remove. 

c. Skip to step 8. 

Move an observation 
field 

a. Click the observation you want to move. 

b. Click Up or Down to move the observation higher or 
lower in the list. 

c. Skip to step 8. 

6. In the Field Name box of the Observation Field dialog box, type the label name of the 
observation field. 
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7. Under the Field Type group, do one of the following: 

To Do This 

Create a label to group 
related observations 

Click None. 

Create a single line text 
box in which the sleep 
technologist can type 

Click Short Text, Medium Text, or Long Text. 

Create a multi-line text 
box in which the sleep 
technologist can type 

Click Multi-Line Text. 

Create a check box that 
the sleep technologist 
selects if an item 
applies 

Click Check box. 

Create a list from which 
the sleep technologist 
can only select one item 

a. Click List. 

b. Click Details. 

c. In the box above the OK button, type the label name 
for the item you want to add to the list. 

d. Click Add. 

e. Repeat steps iii and iv for the remaining items in the 
list. 

f. Click OK. 

Update or delete the 
content of the list from 
which the sleep 
technologist can only 
select one item 

a. Click List. 

b. Click Details. 

c. Click the item in the list you want to update or delete. 

d. Do one of the following: 

 To update an item, in the box above the OK 
button, revise the text, then click Update. 

 To delete an item, click Remove. 

e. Click OK to close the List Details dialog box. 

8. Click OK. 

Configuring Collection Observations Chart* 
*Not available with the License free version of RemLogic 

In the Collection Observations chart, the sleep technologist documents observations about the 
patient during collection. 

You can add or remove the Collection Observations chart from the patient charting workflow. 
When you remove the Collection Observations chart from the patient charting workflow, the 
Collection Observations button is not available on the Observations toolbar. 
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You can set the interval at which the sleep technologist charts collection observations. By 
default, the interval is 30 minutes. You can set the Collection Observations chart to open 
automatically or set the Collection Observation button to flash on the Observations toolbar at the 
set interval. See Turning on the Collection Observation Charting Notification in this topic. 

You can set the duration of the Snooze button. By default, the delay is 5 minutes. The snooze 
duration cannot be longer than half the interval before the Collection Observations chart 
appears. For example, if the interval is 30 minutes, then the snooze duration cannot be more 
than 15 minutes. 

You can also customize the contents of the Initial Observations chart. You can chart up to 50 
collection observations. By default, the sleep technologist can chart the following in the 
Collection Observations chart: 

 Sleep Stage 

 Respiratory Event Status 

 Snoring Status 

 Blood Oxygen Saturation 

 Heart Rate 

 Treatment Pressure 

 Respiratory Rate 

 Body Position 

 General Comments 

When you update the Collection Observations chart, your changes will not take effect until the 
next collection. 

To configure the Collection Observations chart: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Observations. 

3. Under Observations, click Collection Observations. 

4. Select the Enable Collection Observations check box to add the Collection 
Observations chart to the charting workflow. 

5. In the Interval box, type the duration in minutes before the Collection Observations chart 
appears. The Snooze Duration cannot be more than half the time specified in the 
Interval box. 

6. In the Snooze Duration box, type the duration in minutes to delay the notification to 
complete the Collection Observations chart when the sleep technologist presses the 
Snooze button. 

7. Do one of the following: 

To Do This 

Add an observation field a. Click Add. 

b. Skip to step 8. 

Edit an observation field a. Click the observation you want to edit. 

b. Click Edit. 

c. Skip to step 8. 

Delete an observation 
field 

a. Click the observation you want to delete. 

b. Click Remove. 

c. Skip to step 10. 
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To Do This 

Move an observation 
field 

a. Click the observation you want to move. 

b. Click Up or Down to move the observation higher or 
lower in the list. 

c. Skip to step 10. 

8. In the Field Name box of the Observation Field dialog box, type the label name of the 
observation field. 

9. Under the Field Type group, do one of the following: 

To Do This 

Create a label to group 
related observations 

Click None. 

Create a single line text 
box in which the sleep 
technologist can type 

Click Short Text, Medium Text, or Long Text. 

Create a multi-line text 
box in which the sleep 
technologist can type 

Click Multi-Line Text. 

Create a check box that 
the sleep technologist 
selects if an item applies 

Click Check box. 

Create a list from which 
the sleep technologist 
can only select one item 

a. Click List. 

b. Click Details. 

c. In the box above the OK button, type the label 
name for the item you want to add to the list. 

d. Click Add. 

e. Repeat steps iii and iv for the remaining items in the 
list. 

f. Click OK. 

Update or delete the 
content of the list from 
which the sleep 
technologist can only 
select one item 

a. Click List. 

b. Click Details. 

c. Click the item in the list you want to update or delete. 

d. Do one of the following: 

 To update an item, revise the text in the box above 
the OK button, then click Update. 

 To delete an item, click Remove. 

e. Click OK to close the List Details dialog box. 

10. Click OK. 
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Configuring the Summary Observations Chart* 
*Not available with the License free version of RemLogic 

In the Summary Observations chart, the sleep technologist documents any conclusions drawn 
during or after the study. 

You can add or remove the Summary Observations chart from the patient charting workflow. 
When you remove the Summary Observations chart from the patient charting workflow, the 
Summary Observations button is not available on the Observations toolbar. 

You can set the Summary Observations chart to appear with the Collection Observations chart. 
You can also customize the contents of the Summary Observations chart. By default, the sleep 
technologist can chart the following in the Summary Observations chart: 

 Findings related to sleep diagnosis 

 EEG abnormalities 

 ECG abnormalities 

 Behavioral observations 

When you update the Summary Observations chart, your changes will not take effect until the 
next collection. 

To configure the Summary Observations chart: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Observations. 

3. Under Observations, click Summary Observations. 

4. Select the Enable Summary Observations check box to add the Summary 
Observations chart to the charting workflow. 

5. Select the Include with Collection Observations check box to make the Summary 
Observations chart available whenever the Collection Observations chart appears. 

6. Do one of the following: 

To Do This 

Add an observation field a. Click Add. 

b. Skip to step 7. 

Edit an observation field a. Click the observation you want to edit. 

b. Click Edit. 

c. Skip to step 7. 

Delete an observation 
field 

a. Click the observation you want to delete. 

b. Click Remove. 

c. Skip to step 9. 

Move an observation 
field 

a. Click the observation you want to move. 

b. Click Up or Down to move the observation higher or 
lower in the list. 

c. Skip to step 9. 
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7. In the Field Name box of the Observation Field dialog box, type the label name of the 
observation field. 

8. Under the Field Type group, do one of the following: 

To Do This 

Create a label to group 
related observations 

Click None. 

Create a single line text 
box in which the sleep 
technologist can type 

Click Short Text, Medium Text, or Long Text. 

Create a multi-line text 
box in which the sleep 
technologist can type 

Click Multi-Line Text. 

Create a check box that 
the sleep technologist 
selects if an item applies 

Click Check box. 

Create a list from which 
the sleep technologist 
can only select one item 

a. Click List. 

b. Click Details. 

c. In the box above the OK button, type the label name 
for the item you want to add to the list. 

d. Click Add. 

e. Repeat steps iii and iv for the remaining items in the 
list. 

f. Click OK. 

Update or delete the 
content of the list from 
which the sleep 
technologist can only 
select one item 

a. Click List. 

b. Click Details. 

c. Click the item in the list you want to update or delete. 

d. Do one of the following: 

 To update an item, revise the text in the box above 
the OK button, then click Update. 

 To delete an item, click Remove. 

e. Click OK to close the List Details dialog box. 

9. Click OK. 

Configuring Observation Report Settings* 
*Not available with the License free version of RemLogic 

You can choose one of the following standard Observation Report templates as your default 
report template: 
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Notable Event Report: Lists only those collection observations marked as important by the 
sleep technologist. 

Detailed Observation Report: Lists all the collection observations. 

Summary Observation Report: Lists all the general observations from the Initial– and 
Collection Observations charts and all the comments from the Summary Observations chart. 

You can choose to include observation time hyperlinks in the report. These hyperlinks allow a 
report reviewer to click the observation time in the report to go to the corresponding time in the 
study. 

To configure the Observation Report Settings: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Observations. 

3. Under Observations, click Observation Report. 

4. Do one of the following: 

 To choose a report listing only those collection observations marked as 
significant, click Notable Event Report. 

 To choose a report listing all the collection observations, click Detailed 
Observation Report. 

 To choose a report listing all the general comments from the Initial- and 
Collection Observations charts and all comments from the Summary 
Observations chart, click Summary Observation Report. 

5. Click Hyperlink observation times in report to study to allow users to go to the 
relevant point in the study by clicking on the observation time in the report. 

6. Click OK. 

Transferring Patient Charting Settings* 
*Not available with the License free version of RemLogic 

Once you have created customized observation charts, you can copy them to other computers. 
This allows other sleep technologists to use your customized observation charts. You must do 
this manually by copying your modified popupsettings.xml file (which contains the settings for 
your customized observation charts) to the other computer. 

To transfer patient charting settings to another computer: 

 

Note: Before you start this procedure, you must display hidden files and folders in your 
operating system. For assistance, see the Windows Help and Support Center. 

1. On the computer with the customized observation charts, do one of the following: 

 If you are running Windows XP, browse to c:\Documents and Settings\All 
Users\Application Data\Embla\RemLogic\Settings, where c: represents the drive 
on which your operating system is installed. 
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 If you are running Windows 7, browse to c:\Program 
Data\Embla\RemLogic\Settings, where c: represents the drive on which your 
operating system is installed. 

2. Copy the PopupSettings.xml file to a portable media, such as a USB drive. 

3. From the portable media, copy the PopupSettings.xml file to the same directory location 
as listed in Step 1 on the computer you want to update the observation charts. 

Controlling the MDrive with RemLogic* 
*Not available with the License free version of RemLogic 

 

 

Note: Prior to starting a recording, check the PC storage to ensure there is adequate 
space. 

 

With RemLogic, you can control several functions on the MDrive, including: 

 Manage profiles 

 Manage bio-calibrations 

 Run impedance tests 

 Calibrate the test signal 

 Record a study 

 Mark events 

 Assume control of a study 

 Download studies from an SD card 

 Support two way audio 

The MDrive has several icons that indicate its status. Examples are outlined in the table below; 
variations can display in RemLogic. 

Icon  Status 

 
Wirelessly connected, available MDrive; no secure digital (SD) card present 

 
MDrive available, no SD card present 

 

MDrive not available, no SD card present 

 

Recording (MDrive is controlling the recording), SD card present 

 

Locked, SD card present 

 

Recording controlled by RemLogic, SD card present 

 

Impedance test, SD card present 

 

Bio-calibration test, SD card present 
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Using the SD Card and the MDrive* 
*Not available with the License free version of RemLogic 

If a secure digital (SD) card is inserted in the MDrive, you can use RemLogic to: 

 Record a study 

 Upload a study to RemLogic 

 Add new and edited profiles for the MDrive to use 

 Add new and edited bio calibrations for the MDrive to use 

RemLogic can download or delete studies from the SD card only if the SD card is unlocked. If it 
is locked, RemLogic can only display a list of studies and profiles on the card. For more 
information about the SD card, such as the amount of memory required for a study, see SD 
Card in the System Components section of the MDrive Instructions for Use. 

For more information about profiles and bio calibrations in relation to the MDrive, see Managing 
Profiles on the MDrive and Using Bio Calibrations with the MDrive. 

 

 

Note: Removing the SD card while the MDrive is recording causes the MDrive to 
experience errors. The MDrive must be restarted to record again. 

Downloading a Study from the SD Card to RemLogic* 

Studies that are recorded with the MDrive are identified with the following information in the 
Device Manager: 

 Date of the study 

 The MDrive unit’s identification number 

 The length of the study 

Download a single study, then edit the study’s patient information before downloading another 
study. 

 

Note: If you download multiple studies that were recorded the same day with the same 
MDrive without changing the patient information, all studies will have the same patient 
name. 

To download a study to RemLogic: 

1. Click the plus to the left of the 
MDrive in the Device Manager in 
RemLogic to display a list of 
studies on the MDrive’s SD card. 
The list includes the date and 
time the study started, and the 
MDrive unit’s identification 
number. 

 

MDrive’s list of studies, including start date, unit number, and study 
length. 
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2. Right-click the study that you want to download, then select Download from the shortcut 
menu. 

3. A message notifies you when the download is complete; click OK. 

4. If desired, edit the patient information by completing the following steps: 

a. Select the patient folder to be edited. 

b. Select Patient Info... from the Edit menu. 

c. Enter information as required in the Patient Information dialog box. For more 
information, see steps 2 through 6 in Preparing a Study. 

d. Click OK to save any changes and close the Patient Information dialog box. 

Deleting a Study from the SD Card* 

Deleting a study involves viewing a list of studies on the MDrive’s SD card in the Workspace 
area, then selecting the desired study for deletion. 

To delete a study from the SD card: 

1. Click the plus to the left of the MDrive in the Device Manager to display a list of studies 
on the MDrive’s SD card. The list includes the date and time the study started, and the 
MDrive unit’s identification number. 

 

MDrive’s list of studies, including start date, unit number, and study length. 

2. Right-click the study that you want to delete, then select Delete from the shortcut menu. 

3. A confirmation message asks you if you want to delete the selected recording; click Yes. 

Managing Profiles on the MDrive* 
*Not available with the License free version of RemLogic 

The MDrive has a set of default profiles that cannot be edited. Additionally, you can create and 
edit profiles in RemLogic, then save them to an SD card for use with the MDrive. You must use 
RemLogic to delete profiles from the SD card. When you add, edit, or delete a profile, RemLogic 
retrieves a list of profiles that were previously saved. 
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Note: It is strongly recommended that you configure the Windows firewall before 
managing MDrive profiles with RemLogic. 

Editing a Profile* 

You can edit a profile's name, description, impedance test and calibration test signal timing, and 
individual channel properties. You can edit profiles that are already saved on an SD card for use 
with the MDrive. 

To edit a profile on an SD card: 

1. Right-click an MDrive in the Device Manager, then select Manage Profiles from the 
shortcut menu. 

2. Select a profile from the list in the Manage MDrive Profiles dialog box, then click Edit to 
open the [Profile Name] Properties window. 

 

[Profile Name] Properties window 

3. In the General tab, edit the profile's name and description, as needed. 

4. Select a [Channel Type] tab to view, edit, and assign a specific channel to a study. The 
Auxiliary tab displays channels that are connected to the MDrive's auxiliary ports. 

 

[Profile Name] Properties dialog box, displaying the Bipolar and Resp tab. 
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5. Select the check box to the left of the channel's label for it to collect data during a study. 

6. Double-click the channel to open its properties dialog box, where you can edit the 
following: 

 Label name (the channel name that displays on the MDrive and RemLogic) 

 Sensor 

 Signal type 

 Sampling rate 

 Maximum impedance 

 

[Channel Name] Properties dialog box 

7. Click OK to return to the [Profile Name] Properties dialog box; click OK again to close 
the dialog box. 

8. Click Close to exit the Manage MDrive Profiles dialog box. 

Adding a Profile* 

You can download a profile from RemLogic to an SD card for use with the MDrive. 

To add a profile to the SD card: 

1. Right-click an MDrive in the Device Manager, then select Manage MDrive Profiles from 
the shortcut menu. 

2. In the Manage MDrive Profiles dialog box, click Add New to open the Import Profiles 
dialog box, which lists profiles that are available in RemLogic. 
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Import Profiles dialog box 

3. Select a profile, then click Import. 

4. The Manage MDrive Profiles dialog box displays; click Close. 

Deleting a Profile* 

You must use a PSG software, such as RemLogic, to delete profiles from an SD card.  

To delete a profile from the MDrive with RemLogic: 

1. Right-click an MDrive in the Device Manager, then select Manage MDrive Profiles from 
the shortcut menu. 

2. In the Manage MDrive Profiles dialog box, select the profile to be removed from the 
MDrive; then click Delete. 

 

Manage MDrive Profiles dialog box 

3. Click Close to exit the Manage MDrive Profiles dialog box. 
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Running Impedance Tests with the MDrive* 
*Not available with the License free version of RemLogic 

An impedance test is an electrical test that evaluates the electrodes' connections to the patient. 
Default MDrive profiles automatically run an impedance test when you start a study. To 
manually start an impedance test, follow the steps below. 

The MDrive can conduct an impedance test without RemLogic; the results are visible in the 
MDrive screen and saved to the secure digital (SD) card. For more information, see Displaying 
Impedances and Impedance Summary in the MDrive Menu Functions section of the MDrive 
Instructions for Use. 

To run an impedance test with the MDrive: 

Do one of the following: 

 Right-click an MDrive in the Device Manager, then select Start Impedance Test from 
the shortcut menu. 

 Click Impedance  on the Controls toolbar. 

To stop an impedance test, click Stop Impedance test, or click Impedance  on the Controls 
toolbar. 

Using Bio Calibrations with the MDrive* 
*Not available with the License free version of RemLogic 

You can create and edit MDrive bio calibrations in RemLogic, then save them to an SD card for 
use with the MDrive. Bio calibrations are saved within a single file on the SD card. Editing a bio 
calibration or adding a new bio calibration will cause the bio calibration file on the SD card to be 
overwritten. You must use RemLogic to delete bio calibrations from the SD card. 

If RemLogic is recording a study through the MDrive, RemLogic uses its bio calibrations, rather 
than the bio calibration file on the SD card. If the MDrive is recording without RemLogic, the 
MDrive uses the bio calibration file on the SD card. 

For information about viewing and marking bio calibrations with the MDrive, see Marking a 
Study with a Bio Calibration in the MDrive Menu Functions section of the MDrive Instructions for 
Use. 
 

 

Note: It is strongly recommended that you configure the Windows firewall before 
managing MDrive bio calibrations with RemLogic. 

Editing a Bio Calibration* 

Complete the steps below to edit a bio calibration's name and type. 

To edit a bio calibration on the MDrive: 

1. Right-click an MDrive in the Device Manager, then select Manage Bio Calibration from 
the shortcut menu. 
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2. In the Manage MDrive Bio Calibrations dialog box, select the bio calibration that you 
want to edit, then click Edit. 

 

Manage MDrive Bio Calibrations dialog box 

3. In the Edit Bio Calibration Event dialog box, edit the name or type of bio calibration 
event, as needed. 

 

Edit Bio Calibration Event dialog box 

4. Click OK to return to the Manage MDrive Bio Calibration dialog box. 

5. Click OK to exit the Manage MDrive Bio Calibrations dialog box and save the changes to 
the SD card. 

Adding a Bio Calibration* 

Complete the following steps to add patient behavior events, such as eye movement, to the bio 
calibrations file on the SD card. The new event will display immediately above the current 
selection. 

To add a bio calibration to the MDrive: 

1. Right-click an MDrive in the Device Manager, then select Manage Bio Calibration from 
the shortcut menu. 
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2. In the Manage MDrive Bio Calibrations dialog box, the current bio calibrations display in 
sequence. Select the existing event that will follow the new bio calibration, then click 
Add New. 
The selected bio calibration shifts down, and a blank line displays above it. 

 

Manage MDrive Bio Calibrations dialog box 

3. In the Edit Bio Calibration Event dialog box, type the name and the type of bio calibration 
event. 

 

Edit Bio Calibration Event dialog box 

4. Click OK to return to the Manage MDrive Bio Calibration dialog box. 

5. Click OK to exit the Manage MDrive Bio Calibrations dialog box and save the changes to 
the SD card. 

Deleting a Bio Calibration* 

You must use a PSG software, such as RemLogic, to delete bio calibrations from an SD card.  

To delete a bio calibration from the MDrive with RemLogic: 

1. Right-click an MDrive in the Device Manager, then select Manage Bio Calibration from 
the shortcut menu. 
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2. In the Manage MDrive Bio Calibrations dialog box, select the bio calibration event to be 
removed from the SD card, then click Delete. 

 

Manage MDrive Bio Calibrations dialog box 

3. Click OK to close to the Manage MDrive Bio Calibrations dialog box and save the 
changes to the SD card. 

Importing a Bio Calibration from RemLogic to the MDrive* 

Use the Import function to retain standard events—events that were part of the bio calibration 
default set—that were deleted. For example, if you accidentally deleted Eyes Open through the 
Manage MDrive Bio Calibrations window, the event will display at the bottom of the list in the 
Manage MDrive Bio Calibrations window after you import the bio calibrations. 

To import a bio calibration to the MDrive: 

1. Right-click an MDrive in the Device Manager, then select Manage Bio Calibration from 
the shortcut menu. 

2. In the Manage MDrive Bio Calibrations dialog box, click Import. 

 

Manage MDrive Bio Calibrations dialog box 
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3. Click OK to copy any changes to the SD card. 

Calibrating the Test Signal* 
*Not available with the License free version of RemLogic 

If the MDrive does not pass an impedance test, you can use RemLogic to calibrate the test 
signal. When it is calibrating the test signal, the MDrive sends a set of signals to the bedside 
unit to make sure the beside unit is working correctly. 

To calibrate the test signal: 

Do one of the following: 

 Right-click an MDrive in the Device Manager, then select Start Calibration Test Signal 
from the shortcut menu. 

 Click Calibration Test Signal in   the Controls toolbar. 

You can also stop a calibration test that is in progress. 

To stop a calibration test: 

Do one of the following: 

 Right-click an MDrive in the Device Manager, then select Stop Calibration Test Signal 
from the shortcut menu. 

 Click Calibration Test Signal in   the Controls toolbar. 

Recording a Study with the MDrive* 
*Not available with the License free version of RemLogic 

The MDrive has three recording options: 

 Record to PSG software and an SD card 

 Record to an SD card only 

 Assume control of a study in progress (record to PSG software and an SD card) 

With these options, and if space exists on the SD card, you can continue recording to the SD 
card if the connection between RemLogic and the MDrive is lost. For more information about 
using RemLogic to control an MDrive that is already in use, Assuming Control of a Study with an 
MDrive. 

You can also stop an MDrive recording with RemLogic, if needed. 

 

Note: It is strongly recommended that you configure the Windows firewall before 
recording with the MDrive. 

Recording with RemLogic and an SD Card* 

When the MDrive is connected to RemLogic, the software records the study. If an SD card is 
inserted in the MDrive, the card also records the study, as long as space exists on the card. 
When you finish the Recording Wizard in RemLogic, the software notifies you of how many 
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hours the card can record with the selected profile. For more information about the SD card, 
such as the amount of memory required for a study, see SD Card in the System Components 
section of the MDrive Instructions for Use. 

When you use RemLogic to select a default profile and start a recording with the MDrive, an 
impedance test automatically begins. When RemLogic is recording, "Online recording in 
progress," displays at the bottom of the window, and the recording displays in the Workpad. 

The steps below will record a study with RemLogic and an SD card concurrently, if an SD card 
is inserted. If an SD card is not present, only RemLogic will record the study. 

 

Note: Removing the SD card while the MDrive is recording causes the MDrive to 
experience errors. The MDrive must be restarted to record again. 

To record a study with RemLogic and the SD card: 

1. Enter patient information; see Preparing a Study for more information. 

2. Right-click an MDrive in the Device Manager, then select Start Online...from the 
shortcut menu to start the Embla Recording Wizard. 

3. Click Next in the Welcome to the Embla Recording Wizard page of the Embla Recording 
Wizard. 

4. Complete one of the following steps: 

 Select the profile to be used during the recording, then click Next. 

 Select a profile, then click Customize to edit the profile in the [Profile Name] 
Properties dialog box. For more information, see Editing a Profile in the 
Managing Profiles on the MDrive section. 

 

Select Device Profile page of the Embla Recording Wizard 
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5. The Completing the Embla Recording Wizard page notifies you of how many hours the 
SD card can record. Click Finish to exit the wizard. 

 

Note: If no SD card is inserted, no warning dialog will be displayed once the wizard is 
closed.  Events, showing no device storage are generated into the Workpad traces, 
and only RemLogic will save the study. 

  

 

Note: If the SD card is full when starting the recording or becomes full during the 
recording, a warning dialog will be displayed and events showing device storage full 
are generated into the Workpad traces. 

Stopping a Recording* 

You can stop an online recording on the MDrive at any time. You cannot remove the MDrive 
from RemLogic while the MDrive is in use. 

To stop a recording: 

Do one of the following: 

 Right-click the desired MDrive in the Device Manager, then select Stop from the shortcut 
menu. 

 Click Stop  on the Controls toolbar. 

A confirmation message asks if you want to stop the online recording; click Yes. The recording 
continues until you click Yes. 

Assuming Control of a Study with an MDrive* 
*Not available with the License free version of RemLogic 

If the connection between the MDrive and RemLogic is interrupted, the MDrive will continue 
recording with an SD card, if one with enough available memory is inserted. Additionally, 
RemLogic can assume control of a study that started with the MDrive only. 

When recording is interrupted,   displays on every trace in RemLogic. 

When the recording resumes,  displays on every trace. 

When a device—for example, the oximeter—is disconnected from the MDrive or bedside unit, 
the signals associated with the device display Alert: Disconnected on the MDrive screen. 
When the device is reconnected, a vertical, red line displays, and the signals resume on the 
MDrive screen. 

 

 

Note: RemLogic can take control of an MDrive that displays the following icon: . 

It is strongly recommended that you configure the Windows firewall  before recording 
with the MDrive. 

The procedure below applies if RemLogic or your computer closes unexpectedly, and the 
MDrive is saving the recording to the SD card. 
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To take control of an MDrive recording with RemLogic: 

 Open a new Workpad Sheet. 

 Right-click the MDrive that RemLogic will control; then select Take Over Recording 
Control in the shortcut menu. 

If you did not open a new Workpad Sheet, the MDrive uploads the study date and MD 
unit number, and the information displays in the Device Manager. 

 

 

Tip: Click on Workpad Sheet tabs to view the data as it records. To edit patient 
information, select the study, then select Patient Info from the Edit menu to open the 
Patient Information dialog box. See Preparing a Study for more information about the 
Patient Information dialog box. 

 

Using Audio with the MDrive* 
*Not available with the License free version of RemLogic 

With RemLogic, you can control the MDrive's volume, the PC speaker's volume, and which key 
you press to talk to the patient through the MDrive. You must also select an input device, or 
audio driver. 

To control the volume of the MDrive's and PC's speakers: 

1. Right-click Device Manager. Then select Settings, MDrive, then Audio Setup from the 
shortcut menus to open the Audio Setup window. 

 

Audio Setup window 

2. Move the slider as needed to lower or raise the volume for the respective speaker. 

3. Click OK. 

 

Note: Adjusting your PC's speaker volume through RemLogic does not change the 
volume setting that you can set through your computer. 
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To designate a Push-To-Talk key: 

1. Right-click Device Manager. Then select Settings, MDrive, then Audio Setup from the 
shortcut menus to open the Audio Setup window. 

2. Place your cursor in the Push-To-Talk Key text box, then press the desired key. 

If the key is already designated the Push-To-Talk key, a message notifies you the key is 
already in use; press another key, if desired. 

3. Click OK. 

 

Tip: You must continuously press the Push-To-Talk Key while talking to transmit 
audio through the MDrive. 

To select an audio device: 

1. Right-click Device Manager. Then select Settings, MDrive, then Audio Setup from the 
shortcut menus to open the Audio Setup window. 

2. Select an audio device from the lnput Device list. 

3. Click OK. 
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Managing Data 
This chapter provides information on downloading, archiving, and importing and exporting data. 

Downloading Data 

Downloaded study data automatically includes the name of the recorder and its serial number. 
This information displays at the bottom of the Workpad, in the area below the sheet tab names. 

 

This study was recorded with an Embletta with the serial number C1000013. 

 

Note: Recordings that are downloaded from the Embla titanium's compact flash (CF) 
card and card reader do not display this information. 

Note: When a ResMed Therapy Device treatment study is downloaded, events are 
marked in the recording and display immediately in the Workpad. 

Note: Firmware build 242 or higher must be installed on the Embletta for the data to 
properly download to RemLogic. If the firmware is not current, you must download 
data to RemLogic with a serial cable, or the data will be lost. 

Note: If the Transform to EDF format option is selected, all button events will be 
removed from the study during download. To avoid this, you can disable the 
Transform to EDF format option on the Options tab under Devices | Settings | 
[Ambulatory Device Name]. 

 

Downloading a titanium Study* 
*Not available with the License free version of RemLogic 

If you recorded an ambulatory study with the Embla titanium, you might want to download the 
data to the computer. The data is placed in the active data storage location. 

To download a titanium study: 

1. Open RemLogic. 

2. Connect the Embla titanium to the computer with the BQUSB and titanium Interface 
cable. 

3. In RemLogic, complete one of the following steps (if the titanium is still in a recording 
mode, click Stop first): 
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 Right-click the Embla titanium icon  in the Device Manager, then click 
Download.  The data will be automatically placed in the download location 
specified in the device settings.  See Setting the Download Options. 

 Select the single study from the expanded list on the Device Manager and right-
click on the study, then click Download.  The data will be automatically placed in 
the download location specified in the device settings.  See Setting the Download 
Options.   

 In the Device Manager area, expand the list of studies collected by the titanium. 
Click the study that you want to download, then drag it to the Workpad.  The data 
is automatically placed in the active data location specified on the hard disk of 
the computer.  

 Select the single study from the expanded list on the Device Manager and drag it 
to the Operations Sheet. The data is automatically placed in the active data 
location specified on the hard disk of the computer. 

 

Tip: The Drag and drop to download option is disabled if you have selected 
either the Transform to EDF format or Delete local copy after successful 
transfer in the device options settings. 

4. A progress indicator indicates the progress of the download, and a confirmation 
message displays when the download is complete. Click OK. 

As soon as the download is complete, the new recording displays in the Recording Manager in 
the Data folder of the appropriate Patient folder. 

Downloading an Embletta Study 

When an Embletta recording is complete, it should be downloaded into the RemLogic 
application. The following procedure describes how to download an Embletta recording in 
RemLogic.  

 

Note: Firmware build 242 or higher must be installed on the Embletta for the data to 
properly download to RemLogic. If the firmware is not current, you must download 
data to RemLogic with a 3-in-1 Cable, or the data will be lost. 

To download an Embletta study: 

1. Open RemLogic. 

2. If applicable, disconnect the proxy from the Embletta. 

3. Connect the Embletta to the computer with the USB cable, the serial download cable, or 
the 3-in-1 cable. 

4. Complete one of the following steps (if the Embletta is still recording, click Stop first): 

 Right-click the Embletta icon  in the Device Manager, then click 
Download.  The data will be automatically placed in the download location 
specified in the device settings.  See Setting the Download Options. 

 Select the single study from the expanded list on the Device Manager and right-
click on the study, then click Download.  The data will be automatically placed in 
the download location specified in the device settings.  See Setting the Download 
Options.   
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 In the Device Manager area, expand the list of studies collected by the Embletta. 
Click the study that you want to download, then drag it to the Workpad.  The data 
is automatically placed in the active data location specified on the hard disk of 
the computer.  

 Select the single study from the expanded list on the Device Manager and drag it 
to the Operations Sheet. The data is automatically placed in the active data 
location specified on the hard disk of the computer. 

 

Tip: The Drag and drop to download option is disabled if you have selected 
either the Transform to EDF format or Delete local copy after successful 
transfer in the device options settings. 

5. A progress indicator displays, and a confirmation message displays when the download 
is complete. Click OK. 

When the download is complete, the new recording displays in the Recording Manager in the 
Data folder of the appropriate Patient folder. 

Downloading an MDrive Study* 
*Not available with the License free version of RemLogic 

Studies that are recorded with the MDrive are saved to a secure digital (SD) card. For 
information about downloading a study from the SD card, see Using the SD Card and the 
MDrive. 

Downloading an Embletta MPR Study 

When an Embletta MPR recording is complete, it should be downloaded into the RemLogic 
application. The following procedure describes how to download an Embletta MPR recording in 
RemLogic.  

To download an Embletta MPR study: 

1. Open RemLogic. 

2. Connect the Embletta MPR to the computer with the USB cable provided with the 
system. 

3. Complete one of the following steps (if the Embletta MPR is still recording, click Stop 
first): 

 Right-click the Embletta MPR icon  in the Device Manager, then click 
Download.  The data will be automatically placed in the download location 
specified in the device settings.  See Setting the Download Options. 

 Select the single study from the expanded list on the Device Manager and right-
click on the study, then click Download.  The data will be automatically placed in 
the download location specified in the device settings.  See Setting the Download 
Options.   

 In the Device Manager area, expand the list of studies collected by the Embletta 
MPR. Click the study that you want to download, then drag it to the 
Workpad.  The data is automatically placed in the active data location specified 
on the hard disk of the computer.  
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 Select the single study from the expanded list on the Device Manager and drag it 
to the Operations Sheet. The data is automatically placed in the active data 
location specified on the hard disk of the computer. 

 

Note: For users of the license free version of RemLogic, you can also download 

a study by clicking on the Embletta MPR  icon in the Device Manager, and then 
clicking Download Data on the operations sheet. The downloading icon  will 
appear beside the Embletta MPR icon.  Upon completion of the download a 
confirmation message will be displayed.  The study can now be opened from the 
Recording Manager. 

 

 

Tip: The Drag and drop to download option is disabled if you have selected 
either the Transform to EDF format or Delete local copy after successful 
transfer in the device options settings. 

4. A progress indicator displays, and a confirmation message displays when the download 
is complete. Click OK. 

When the download is complete, the recording displays in the Data folder of the appropriate 
Patient folder listed in the Recording Manager. 

 

Note: If a recording has already been downloaded, a warning message will be 
displayed.  If you want to re-download a study, you can click Yes and the original 
recording will be overwritten with the downloaded version.  If you would like to keep 
the original recording, you can click Cancel.  This warning can be disabled by clicking 
on the Do not display the warning in the future check box. And can be re-enabled 
using the Devices | Settings | Embletta MPR | General tab.  

Data Locations 

Recorded data is saved in storage folders, also called data locations. An unlimited number of 
data locations can be specified in RemLogic. Data locations can be edited, removed, or set as 
active or archive locations. 

You can change the attributes of existing data locations and also create new locations. 

Adding a Data Location 

To add a data location: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Data Management. 

3. Click Data Locations. 

4. To the right, click Add. 

5. In the Name field, type a descriptive name for the data location folder. This name will 
display in the Recording Manager. 

6. Do one of the following: 

 In the Location field, enter a file path for the storage location. 
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 Click Ellipses  to browse for a storage location. Click OK. 

7. In the Attributes section, select the attributes for the storage location. 

 Read-only: Recordings cannot be deleted from a read-only data location. Since 
it is not possible to save new recordings in the location, a read-only data location 
cannot be set as active. 

 Archive/Archive Cache: Select this option if you intend to burn the folder to a 
storage disc. For more information, see Archiving. 

 View as a special folder: A special folder translates the coded recording name 
into patient name, ID, type, and date of recording. The special folder attribute is 
recommended. 

 Removable: This attribute is not selectable. It is automatically selected during 
archiving to a CD or DVD using an archive folder. The attribute shows whether 
the folder is on removable media. 

 Hidden: Select this attribute to hide the data location in the Recording Manager. 

8. Click OK in the Data Location Properties dialog box to confirm the added data location. 

9. Click OK to exit the Options dialog box. 

Removing a Data Location 

To remove a data location: 

1. On the Tools menu, click Options. 

2. Click the Data Locations tab. 

3. Click Remove. 

4. Click OK. 

Editing a Data Location 

To modify a data location: 

1. On the Tools menu, click Options. 

2. Click the Data Locations tab. 

3. Click Edit. 

Setting a Data Location as Active 

New and imported recordings are saved automatically to the active data location. 

To set a data location as active: 

1. On the Tools menu, click Options. 

2. Click the Data Locations tab. 

3. Select a data location, then click Set Active. 

4. Click OK. 
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In the Recording Manager, active data location folders are indicated by bold font. 

Displaying All Data Locations in the Recording Manager 

To show all data locations in the Recording Manager: 

 On the Recording Manager bar, click Recordings | Arrange | Show all locations. 

The active data location displays in bold in the Recording Manager. If the Show all locations 
option is not selected, only the active data location is accessible in the Recording Manager. 

Data locations are created and edited in the Options dialog. 

Expanding the Most Recent Recording Folder 

To save time, the most current Recording folder  can be made to expand when you expand 
the patient folder. 

1. On the Tools menu, click Options. 

2. Click the Data Locations tab. 

3. Activate the Automatically expand most recent recording when expanding patient 
check box. 

Deleting a Recording 

To delete a recording: 

1. Enable recording deletion. 

a. On the Tools menu, click Options. 

b. Click the Data Locations tab. 

c. Activate the Allow user to delete recordings check box. 

d. Click OK. 

2. Right-click the Recording folder , then click Delete. 

3. Click OK. The recording and associated files will be moved to Recycle Bin. Data in the 
Recording folders can be deleted, except for the last online copy of a recording. 

 

 

Note: To prevent accidental deletions, enable the delete recordings function only when 
necessary. 

Deleted Recordings are sent to the Recycle Bin and can be retrieved by opening the 
Recycle bin, right-clicking on the folder and selecting Restore. To view the restored 
recording in RemLogic, refresh the Recording Manager. 

Data Folders 

In RemLogic, each recording has a folder in the active data location. By default, each Patient 
folder name is coded with a unique identification in the form of a numerical string (GUID) for 
patient privacy and security purposes. To view patient names when browsing in Windows 
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Explorer, the recording must be stored in a special folder that translates the unique identification 
into the patient name, recording date, and recording type. 

Coded Folders 

Recommended. To protect the patient's personal identification, it is best to archive using coded 
Patient folder names. If a Patient folder with a coded name is placed in a regular folder or on a 
computer that does not have RemLogic installed, the recording's file name will appear as a 
numerical string instead of the patient's name. But when placed in a special folder or viewed in 
the Recording Manager, the patient's name and recording date are visible. Recordings that 
have been archived with coded folder names can be read directly from the archive folder (or 
storage media) in RemLogic as long as the archive folder (or storage media) is set as a data 
location in Tools | Options | Data Locations. 

Human-Readable Folders 

The recording is identified with the patient name and recording date in any folder on any 
computer. Use this option if the recording needs to be recognizable on computers that do not 
have RemLogic installed. Recordings that have been archived with this method cannot be read 
directly from the archiving folder (or storage media) in RemLogic and have to be imported into 
the active data location. 

The main advantage of archiving using coded folder names is that you can mount the archive 
media in RemLogic without having to import the recording to the hard disk. The main drawback 
is that you will not be able to identify the patient name on a computer that does not have 
RemLogic installed. This is also the only reason why you might want to use human-readable 
names for archiving. 

Special Folders 

To designate a folder as a special folder: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Data Management. 

3. Click Data Locations. 

4. To the right, click Edit. 

5. Under Attributes, click View as special folder. 

6. Click OK to exit the Data Location Properties dialog. 

7. Click OK to exit the Options dialog. 

Special folders are indicated by a blue trace folder icon  in Windows Explorer. On computers 
that do not have RemLogic installed, recordings will always display the unique identification 
instead of the patient name. 

When archiving, you can opt to store recordings with human-readable names so that they are 
identifiable even if they are not stored in a special folder. Extra care must be taken to protect the 
patient information contained in recordings when storing recordings with human-readable 
names. 
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Coded folder names 

 

Patient folders in a special folder 

  

 

Note: Special folders only display recording file types. To view other file types, disable 
the View as special folder option. 

Special folders cannot display subfolders. Creating a subfolder within a special folder 
is not recommended. To view subfolders, disable the View as special folder option. 

 

Folder Appearance 

Archived recordings are displayed according to the folder type specified. 

Folder 
Type 

Folder 
Icon 

Patient Folder 
Icon 

Accessibility Appearance on CD / 
DVD or computer PC 
without RemLogic 
installed 

Special 
 Doe, John 

020142-8970 

Diagnostic 

08/15/2004 

10:59:59 

Accessible by Recording 
Manager 

10d82c44-4750-492c-
2fe-384542b7ab0c 

Coded 
names 

 10d82c44-
4750-492c-
2fe-
384542b7ab0c 

Accessible by Recording 
Manager 

10d82c44-4750-492c-
2fe-384542b7ab0c 

Human-
readable 

 Doe, John - 
08/15/2004 

Accessible by Recording 
Manager (may result in 
slower performance) 

Doe, John – 
08_15_2004 
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File Information 

When browsing in Windows Explorer, you can customize the file information to display in data 
location folder (for example, patient weight, phone number, and so on). File information displays 
in columns adjacent to the folder/file name, and is derived from the Patient Information dialog 
box in RemLogic. Displaying this information in Windows Explorer allows you to sort data by 
patient information fields. 

To customize the file information columns: 

1. Browse to the data location. 

2. From the View menu, select Details. 

3. Right-click the columns bar. 

 

4. Click Columns. The RemLogic Column Settings dialog box displays. 

 

5. Select the columns you want to display. Columns that cannot be removed from the view 
are dimmed. 

6. Click Move up and Move down to sort the columns. 

7. Specify the column width for each selected column (optional). 

8. Select the Apply these folder settings to all recording folders check box to apply the 
selected settings to all RemLogic recording folders. 

9. Click OK. 
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Note: The list of available columns contains most patient information. Additionally, all 
custom patient info properties are available. For more information, see Patient 
Information in the following location in the RemLogic online help: Reporting | Active 
Reports. 

Archiving 

This topic describes the steps in archiving one or more recordings. 

 Saving a copy of a recording to a specified data location 

 Moving a recording to a specified data location 

 Burning a recording to a CD or DVD 

 Burning multiple recordings to a DVD 

Before archiving a recording, you will need to specify an archive folder and archive cache. 

Archive Folder 

An archive folder is a local or network location storage location at which you can save competed 
recordings. RemLogic can remind you to back up a recording once it is complete. 

To specify an archive location: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Data Management. 

3. Click Data Locations. 

4. To the right, click Add. 

5. In the Name text box, enter a name for the archive. 

6. In the Location text box, type the file path, or click Browse  to locate the folder you 
want to specify as the archive folder. 

7. Select the Archive check box. 

8. Optionally, select the View as a special folder check box to view patient names as the 
folder labels for each recording saved to the archive folder. For more information, see 
Data Folders. 

9. Optionally, select the Hidden check box to hide the recording saved to the archive folder 
in the Recording Manager. 

Archive Cache 

An archive cache is a local or network location storage location where you can save completed 
recordings before burning them to a CD or DVD. When the cache is full, you are prompted to 
burn the recordings to a CD or DVD. The recordings you save to the archive cache are visible in 
the Recording Manager. 

Moving each recording to the archive cache once complete is recommended. The size of the 
cache depends on the media type selected (CD [700 MB] or DVD [4.7 GB]. A DVD can hold 
approximately 10-20 studies, and can be used as a secondary backup option. 
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To specify an archive cache location: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Data Management. 

3. Click Data Locations. 

4. To the right, click Add. 

5. In the Name text box, type a name for the archive cache. 

6. In the Location text box, type the file path, or click Browse  to locate the folder you 
want to specify as the archive cache. 

7. Select the Archive Cache check box. This option will be unavailable unless you select a 
removable media location. 

8. Select the View as a special folder check box to view patient names as the folder 
labels for each recording saved to the archive folder. For more information, see Data 
Folders. 

9. Select the Hidden check box to hide the recording saved to the archive folder in the 
Recording Manager. 

Archiving a Recording 

You can move or copy recordings to a specified local or network location. Before moving or 
copying, you must specify an archive folder or archive cache. 

To archive a recording: 

1. Close the study you want to archive. 

2. In the Recording Manager, right-click the Recording folder   containing the study, then 
click Archive. 

3. Click Next. 

4. Do one of the following: 

 To save a copy of the recording, 
click Copy the recording. 

 To move the recording from its 
original location, click Move the 
recording. 

5. Do one of the following: 

 To copy/move the recording to the archive folder, click the archive folder path. 

 To copy/move the recording to the archive cache, click the archive cache path. 

6. Click Next. 

7. Do one of the following: 

 Select Coded folder names to mask the recording folder labels. See Data 
Folders. 
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 Select Human-readable folder names to label each folder with its respective 
patient name. 

8. Click Next. 

9. Click Finish. 

The recordings will display in the Recording Manager. 
 

 

Note: If you re-save a copy of a human-readable recording folder to the archive folder, 
a copy will be made, labeled with a version number. You can overwrite coded 
recording folders. 

Burning a Recording 

To burn a recording to CD / DVD: 

1. Insert a blank disc into the CD / DVD drive. 

2. Close the recording you want to archive. 

3. In the Recording Manager, right-click the Recording folder   containing the recording, 
then click Archive. 

4. Click Next. 

5. Click Burn the recording, then click Next. 

6. Do one of the following: 

 Select Coded folder names to mask the recording folder labels. See Data 
Folders. 

 Select Human-readable folder names to label each folder with its respective 
patient name. 

7. Click Next. 

8. Click Finish. 

9. To launch the Archive Label maker following the archive, do one of the following: 

 To automatically generate an archive label, click Get Label. 

 To specify an archive label, type a name in the Archive Label text box. See 
Archive Labels for more information. 

10. Click Archive. The disc will eject once the process is complete. 

11. Click OK. 

Burning Cached Recordings 

To burn cached recordings to a CD / DVD: 

1. In the Recording Manager, right-click the archive cache, then click Archive. 

2. Click Next. 

3. Click Burn the recording, then click Next. 

4. Do one of the following: 
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 Select Coded folder names to mask the recording folder labels. See Data 
Folders. 

 Select Human-readable folder names to label each folder with its respective 
patient name. 

5. Click Next. 

6. Click Finish. 

7. To launch the Archive Label maker following the archive, do one of the following: 

 To automatically generate an archive label, click Get Label. 

 To specify an archive label, type a name in the Archive Label text box. See 
Archive Labels for more information. 

8. Click Archive. The disc will eject once the process is complete. 

9. Click OK. 

Archive Labels 

RemLogic's Archiving feature allows you to create and print standard Avery labels for discs and 
jewel cases. You can also use LightScribe to print the label directly on the discs. If you are using 
Embla Enterprise Server, you can set the labeling options so that a unique number is generated 
by Enterprise for each disc. 

Creating an Archive Label 

To create an archive label: 

1. On the Tools menu, click Options. 

2. In the left pane, double-click Data Management. 

3. Click Archive Tools. 

4. To the right, specify the following labeling options: 

 Click Day, Month, and Year to add the date to the labels. You can choose to add 
only the month and year, or specify the day, too. A preview of the date format 
displays in the Preview field. 

 If you are using Embla Enterprise Server, you can generate a unique number for 
each label by clicking Enterprise Label. Enterprise generates a number between 
one and one million for each disc. You can add a descriptor before or after the 
number to further identify the Recordings. Using the Enterprise label ensures all 
labels have unique numbers. 

 Click Institution Name to add your institution's name to the label. If your 
institution's name does not appear, you can add it through Tools | Options. 
Select the Reports tab, and type the name in the Name field. Click OK to save 
the changes. 

 If you leave the label options blank, RemLogic generates a default label, which is 
RL followed by the date the disc was burned. The label name must not exceed 
16 characters. If you are unsure of the length, check how the label appears in the 
Preview field. 
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5. In the Post-Archive Tools section of the Archive Tools screen, select the check box next 
to the options to create: 

 CD/DVD Label 

6. Click OK. 

Printing Disc and Jewel Case Labels 

After clicking OK in the Embla Burn Tool, the Archive Label Maker starts. The label maker 
allows you to create your own templates for disc and jewel case labels. 

To create disc and jewel case label templates: 

1. In the Archive Label Maker dialog, click Create. 

2. The Custom Template dialog box includes the following fields (Select all that apply): 

 Type: Type the study type for the 
recordings being written to CD or DVD (for 
example, MSLT). 

 Include Archive: Select this box to specify 
that this is an archive disc. 

 Include Date: Select this box to print the 
current date. 

 Include RemLogic: Select this box to 
specify that the disc contains RemLogic 
recordings. 

 Patient names on Cover: Select this box to 
print patient names on the jewel case insert. 
This option is useful if you burn multiple 
studies to DVD. Up to 30 patient names can 
fit on the jewel case insert. 

 

 

3. When you finish selecting the options, click OK. 

4. A preview of the disc and jewel case labels containing the information you selected 
displays in the Preview window. The name of the new template displays in the Label 
Templates list, displayed to the left of the Preview window. 
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5. Click the arrow next to the Label Products field to choose a label format from the menu: 

 

 Avery Standard: Choose this option to format disc and jewel case labels using 
Avery label formats. Highlight the desired option with your mouse. Label dimensions 
and page size for the option display in the Label information section. The label 
maker supports A4 and Letter paper sizes. 

6. By default, the Print to Default printer option is selected. If you use Avery labels, the 
Archive Label Maker sends the disc label to the printer first, followed by the jewel case 
label, which is printed on a separate sheet. This allows you to insert the Avery label 
sheet into the printer prior to printing the disc label. 

7. If you clear the Print to Default printer check box, Microsoft Word starts and displays 
the labels. Print the labels in Word. 

8. Once the labels are printed, a prompt allows you to do one of the following: 

 Remove the studies from the archive cache. 

 Burn another archive disc. 

 Leave the studies in the cache for later. 

Automated Backup* 
*Not available with the License free version of RemLogic 

You can specify a directory on your network as a backup data location where newly collected 
recordings can be copied. A study can be automatically backed up to the network as soon as 
recording stops, or RemLogic can prompt you whether or not to back up the study when you 
finish recording. 

Backing up recordings on the network helps protect the data against loss due to hard drive 
failure or human error; however, it is not recommended to modify a recording over the network, 
since it could become corrupt if another user modifies it at the same time. 

If you choose to create a backup after collection, RemLogic will place a copy of the recording, 
along with any scoring you did during collection (such as sleep staging) in the network location 
you specified. 

Even though a copy of the recording is placed on the network during backup, all analysis, 
including scoring and creating reports should be done using the copy stored in your default data 
location (usually C:\RemLogic Recordings). 

To create a backup data location on the network: 
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1. First, create an archive data location (see Archive Folder) that is on the network where 
you wish to automatically back up recordings. 

2. On the Tools menu, click Options. The Options dialog box displays. 

3. Click the Advanced tab. 

4. In the Automated Backups section of the dialog, the network data location that you 
added displays. 

5. Select the Enable automated backups check box. 

6. Highlight the location you want to set as the default archive. The option beside the 
location is selected. The network drive you specified is now set as a default network 
archive location. 

 

7. There are two options in the Backup After Collection section of the dialog: 

 Backup automatically after collection 

 Only backup after collection with prompt 

If you select the first option, studies will back up without a prompt to the network 
each time you stop collection. If you select the second option, when you stop 
recording a study, the following message displays: 

 

 Click Yes to back up the study on the network. 

 Click No if you do not wish to save a copy of the recording on the 
network. 

If you resume collection after backing up a recording, and you chose to be 
prompted, the next time you stop the recording, the following message will 
display, giving you the option to overwrite the previous backup, if desired. If you 
chose not to receive a prompt after collection, the same message displays, 
except the Cancel button is not available. If you want to access the Cancel 
button, select the Only archive after collection with prompt option (Tools | 
Options | Advanced). 
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 Click Yes to overwrite the previous backup. 

 Click No to create a new backup. 

 Click Cancel if you do not wish to back up the changes to the recording. 

8. Click the desired option. 

9. Click OK to save the changes. 

Importing Data 

RemLogic can import various forms of external data. It imports data directly in its original format 
and in other formats: European data format (EDF), Plain text, and the CSV format. 

Importing a File 

Files such as Microsoft® Word documents, Microsoft® Excel® spreadsheets, Workpad files, and 
EDF recordings can be imported into an open recording where they are stored in the Patient 
folder based on type. For example, Microsoft Word documents and Microsoft Excel 

spreadsheets are stored in the Documents folder  and Workpad files and other related items 

are stored in the Recording folder . 

To import a file into a recording: 

1. On the File menu, point to Import, then click File. 

2. The Import dialog box displays. Click the file you want to import. 

 

3. Click Open. 

Depending on the file type, the data will import into either the Recording folder or the 
Documents folder. 
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Tip: You can import files by right-clicking either the Recording folder   or the 

Documents folder , then clicking Import File. 

It is essential to have an empty Workpad open when importing an EDF recording, 
because the data will always import into the current Workpad. 

Importing a Recording 

Complete recordings can be imported into the Recording Manager in RemLogic. All the contents 
of the folder containing the recording are then copied from their original location on the PC or 
network to the active location in the Recording Manager. 

To import recordings: 

1. Do one of the following: 

 On the File menu, point to Import, then click Recording. 

 On the Recording Manager bar, select Recordings | Import. 

2. The Browse For Folder dialog box displays. Select the recording you want to import. 

 

3. Click OK. 

A progress indicator displays while the recording is coping into the Recording Manager. 

 

Note: If you have a folder with multiple EDF recordings, they will all import when using 
the Import | Recording command. It is therefore advisable to keep each EDF 
recording in a separate folder, or use the Import | File option to select only one 
recording when importing EDF recordings. 

 
 

 

Importing Text and CSV Files* 
*Not available with the License free version of RemLogic 

Data that was converted from one format to plain text can be imported into the current recording 
(for example, EEG data converted to plain text format). To do this, you need to know some 
information about the original recording, such as the highest value used in that recording. 

To import text or CSV data files: 

1. Open the recording containing the data. 

2. From the main, menu, select File | Import | Text, CSV or NI16 Data File. The Import 
Data dialog box displays. 

3. Click Add. 
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4. The Trace Information dialog box displays. Modify settings as required. In the example 
below, an EEG trace is importing. Start by browsing for the signal data by clicking 
Browse. Give the signal a name in the Signal Name text box, and enter the appropriate 
information. 

 

5. Click OK. 

6. Confirm that the information in the Import Data dialog box is correct, then click Import. 

The imported data will display in the appropriate Patient folder in the Recording Manager. 
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Analyzing Data 
The analysis of a recording is ultimately used to diagnose the presence and severity of sleep 
disorders. With RemLogic, you can stage sleep, mark events, and analyze data with computer 
assisted scoring, minimizing the time it takes to score data.  

Opening Data 

This topic describes how you can view the raw data or Workpad of a previously saved 
recording. 

Raw Data 

To open a trace file, do one of the following: 

 Option 1: 

 In the Recording Manager, expand the Patient folder . 

 Double-click the Data folder . 

 Option 2: 

 On the File menu, click Open. 

 Select the file type Embla Data File (*.ebm). 

 

 Select a trace file, then click Open. 

 



RemLogic™ 3.4            Instructions for Use 

189                     

Analyzed Data 

Analyzed data is saved as a Workpad file in the Study folder. 

To open analyzed data, do one of the following: 

 Option 1: 

 In the Recording Manager, expand the Patient folder . 

 Double-click the Workpad file . 

 Option 2: 

 On the File menu, click Open. 

 Select the file type Workpad File (*.ewp). 

 Select a Workpad file , then click Open. 

Staging Sleep* 
*Not available with the License free version of RemLogic 

The following topics are related to staging sleep. 

 Scoring Sessions 

 Scoring Epochs 

 Dynamic Scoring 

 Scoring Synchronization 

 Continuous Sleep 
Staging 

 Scoring an MSLT Study 

Scoring Sessions* 
*Not available with the License free version of RemLogic 

Having individual scoring sessions ensures that staging and sleep events entered by each 
scorer are identified in the Workpad, allowing more than one scorer to score the same Workpad. 
Studies are manually scored using hot keys (keyboard keys). 

Recording a Scoring Session* 

Capturing details on how one views and modifies the digital display during a scoring session 
improves the transparency of the scoring process. Using the Record Scoring feature, scoring 
technologists can record Workpad display changes made during a scoring session. 

RemLogic records these display change events—actions that modify the way raw data is 
viewed in a Workpad during a session such as derivation changes, sensitivity adjustments, and 
modifications to filter settings—and automatically saves this information to the View as Scored 
settings file. This settings file, saved with the Workpad, allows the physician or reviewer to view 
these display changes in View as Scored mode. 

In Record Scoring mode, display change events are saved to the View as Scored settings file 
and logged chronologically in the Event Palette (under the View as Scored tab) as they are 
applied to the raw data. 

To record a scoring session: 

1. Click Record Scoring on the View History toolbar: 
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Display changes made during a scoring session ARE saved to the View as Scored 
settings file. 

2. Score the recording manually and/or using the computer assisted analyzers. Mark 
events, as appropriate. 

3. When the scoring session is complete, save and close the Workpad. 

4. To view display changes, open the Workpad, and click the View as Scored button on the 
View History toolbar: 

 

Starting a Scoring Session* 

To start a scoring session: 

1. Scroll to the point in the study at which to start the scoring session. 

2. Click a trace on which to mark the stages. For sleep staging, this is typically the EEG or 
EOG channels. 

3. On the Events menu, click New Scoring. 

4. In the Scoring Start Time text box, enter the scoring start time (optional). 

5. In the Technician text box, type your name. 

6. From the Palette list, select a scoring palette. 

7. Optionally, select a caret color. This will distinguish the scoring session from others. 

8. Optionally, enter a comment or brief description. This information will be displayed in the 
Sleep Stage Report. 

9. Click OK. 

10. Start scoring by pressing the appropriate hot keys. Refer to the Scoring Palettes and 
Associated Markers and Hot Keys table for marker and hot key information. 

Pressing a hot key will mark the selected trace and advance the scoring display by one epoch. 

 

 

Tip: The Event Palette can display while scoring by clicking Toggle Event Palette   
on the toolbar. 

Stopping/Resuming a Scoring Session* 

A sleep staging scoring session can be stopped at any time. 

To stop a scoring session: 

 On the Events menu, click Stop Scoring, or click Toggle Scoring  on the toolbar. 

The yellow highlighted area disappears from the scoring session. 
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To resume a scoring session: 

Click on the sleep scoring event you want to continue from and do one of the following. 

 On the Events menu, click Continue Scoring, or click Toggle Scoring  on the 
toolbar. 

The session will resume, and the next epoch can be scored. 

Editing a Scoring Session* 

You can change the type of a sleep scoring event after it was marked into the Workpad. The 
scoring session must be active before editing. To activate a stopped session, from the main 
menu, select Events | Continue Scoring. 

To edit a scoring session: 

1. Locate the epoch to be changed. 

2. Click on the event bar. 

 

3. Change the event marking by pressing the appropriate sleep scoring hot key. 

The epoch is marked with the new sleep stage. 

Removing a Scoring Session* 

To remove a scoring session: 

1. Right-click a sleep scoring event, then click Remove Score. You are asked to confirm 
the deletion of the scoring session. 

2. Click Yes to confirm. 

The scoring session with all its sleep scoring events is deleted from the Workpad. 

Scoring Epochs* 

*Not available with the License free version of RemLogic  

Deleting a Scoring Epoch* 

You can delete the last scoring epoch of the scoring session without removing the entire scoring 
session. The scoring session must be active in order to delete the last scoring epoch. It is not 
possible to remove single epochs when the scoring has been stopped because they are locked 
to the session. 

To delete a scoring epoch: 

1. Locate the last epoch in the scoring session. 

2. Highlight the epoch by clicking on its bar. 
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3. Right-click the epoch's event bar, then click Delete, or press DELETE. 

Scoring Epoch Gaps* 

During sleep staging, epochs may be scrolled by and left temporarily unscored. The unscored 
epoch gaps can be scored with a single keystroke either with the same stage as the latest 
scored epoch or with the same stage as the next epoch that will be scored. Optionally, epochs 
can be left unscored. 

 

To select the scoring mode for unscored epoch gaps: 

1. On the Tools menu, click Options. 

2. In the left pane, click Event. 

3. Under Score epoch gaps with, do one of the following: 

 To mark epoch gaps with the unscored event, click Unscored. 

 To mark epoch gaps with the same stage as the previous epoch, click Last 
Stage. 

 To mark epoch gaps with the same stage as the following epoch, click New 
Stage. 

4. Click OK. 

Epoch Numbering* 

Epochs are numbered in order of succession. You can choose to start epoch numbering at the 
first scored event, or at the recording start time. By default, RemLogic numbers the epochs 
relative to the scoring session, so that epochs are counted from the first event in the scoring 
session. A numbering based on the recording start time starts counting the epochs at the start 
of the recording regardless of sleep stage events. 

 

Epoch numbers are displayed on the status bar beside the patient information at the bottom of the Workpad. The epoch numbers 
indicate the location of the Workpad screen in the recorded data. 

To select an epoch numbering method: 

1. On the Tools menu, click Options. 

2. In the left pane, click Event. 

3. Under Epoch Numbering, do one of the following: 

 To start numbering epochs at the first scoring event, click Relative to scoring 
session. 

 To start assigning numbers at the start of the recording, click Relative to 
recording start time. You can modify the default duration of 30 seconds by 
selecting a duration option from the Epoch Length list. 

4. Click OK. 
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Dynamic Scoring* 
*Not available with the License free version of RemLogic 

Dynamic Scoring enables you to create a customized sleep-staging palette and make, for 
example, an adaptive scoring with variable epoch duration based on the changes in the data. 

You might want to start by making a customized sleep-scoring palette with customized 
events. 

To score dynamically: 

1. On the Tools menu, click Options. 

2. In the left pane, click Event. 

3. To the right, select the Enable advanced scoring options check box. This feature 
makes dynamic scoring possible. 

4. Click OK. 

5. Open the Scoring Session dialog box by clicking New Scoring on the Events menu. 

6. From the Palette drop-down list, select the palette to be used for scoring. 

7. From the Epoch Length list, select a length for the scoring epochs. Same as Event 
refers to the default event duration or 30 seconds. The Epoch Length list displays 
available default dynamic scoring epoch lengths ranging from 5 to 40 seconds in 5-
second increments. 

8. Select the Dynamic scoring check box. 

9. Click OK. 

10. Start the scoring session. Event duration will be according to definition on the 
customized Sleep Scoring palette. 

Making Variable Epoch Durations* 

The scoring session must be active in order to make variable epoch durations. 

1. Place the pointer on the border where two epochs meet. When the pointer is over the 
border, it will change from a white arrow to an arrow pointing in opposite directions . 

2. After the pointer changes, click and hold the left mouse button down and drag the border 
left and right to make one epoch larger and the other epoch smaller. 

Scoring Synchronization* 
*Not available with the License free version of RemLogic 

By default, scorings are automatically synchronized with epoch boundaries. 

RemLogic synchronizes the start of the current scoring session to the start of the next epoch in 
the signal window. If this option is disabled, the start of the current scoring session will be at the 
current position of the signal window. 

To turn on/turn off automatic synchronization: 

1. On the Tools menu, click Options. 

2. In the left pane, click Event. 
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3. To the right, select or clear the Automatically synchronize scoring with epoch 
boundaries check box. 

4. Click OK. 

Continuous Sleep Staging* 

*Not available with the License free version of RemLogic 

The continuous sleep staging feature offers a semi-automatic scoring of sleep staging events 
during online recordings. 

This feature is helpful if you need to step away from the PC to attend to the patient while scoring 
online recordings. While you are away from the computer, the continuous sleep staging marks 
the scoring events into the Workpad. If, for example, you mark the Unscored event before 
leaving the scoring station, that event will be marked into the Workpad every 30 seconds until 
you return. You can then continue with the manual sleep staging. The Unscored period 
indicates what section of the recording needs to be scored for sleep stages. 

Periods of Unscored events can be easily found in the Workpad with the Hypnogram and re-
scored during the online recording. 

To enable continuous sleep staging: 

1. On the Tools menu, click Options. 

2. In the left pane, click Events. 

3. Select the Continuous staging check box. 

 Unscored: Click this option to mark gaps 
with the unscored event. 

 Last stage: Click this option to mark 
gaps with the same event used for the 
sleep stage scored. 

4. Click OK. 

Continuous sleep staging is enabled for scoring sleep stages during an online recording. 

Scoring an MSLT Study* 
*Not available with the License free version of RemLogic 

MSLT recordings consist of several recording sessions. The sessions are scored individually. 

To score an MSLT study: 

1. Locate the first MSLT session. 

2. On the Events menu, click New Scoring. Score the first recording session. 

3. At the end of the first recording session, select Events | Stop Scoring from the main 
menu. 

4. Locate the beginning of the second recording session. 
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5. On the Events menu, click New Scoring. Score the second session. 

6. At the end of the second recording session, select Events | Stop Scoring from the main 
menu. 

Repeat the scoring process for the third and fourth MSLT sessions. 

Marking Events 

An event is a notable environmental (for example, lights on), respiratory (for example, apnea), 
movement-related (for example, PLM), or polysomnological episode (for example, arousal) that 
can be identified, reviewed, and analyzed in support of the diagnosis of sleep-related disorders. 
You can manually mark events (score) while a study is in progress or in completed studies 
using keyboard shortcuts, your mouse, the Event Palette, and the Events toolbar, or using 
computer assisted scoring tools. To refine both computer assisted and manual analyses, you 
can also delete, move, resize, or modify event markers (by changing their event type). 

Marking Events Using Keyboard Shortcuts 

To view a list of keyboard shortcuts, do one of the following: 

 On the View menu, point to Workspace, then click Event Palette. If the Event Palette is 
currently open, click the Palette tab. 

 Click anywhere in the Workpad Sheet, then press F6. 

To mark a trace using a keyboard shortcut: 

1. Move the pointer to the segment of the trace you want to mark. 

2. Drag across a segment of the trace. The duration of the selection displays on the status 
bar in the lower-left corner of the screen. If no duration is selected, the default event 
length is marked. 

3. Press the keyboard shortcut for the event. 

To mark multiple segments of a trace using a keyboard shortcut: 

1. While pressing CTRL, drag across segments of the trace. 

2. Press the keyboard shortcut for the event. 

Marking Events Using the Mouse 

To mark an event with your mouse: 

1. On the Event Palette, click the event you want to mark.  

 

Note: Sleep Stage Scoring events are not available for this function. 

2. Move the pointer to the segment of the trace you want to mark. The pointer changes to a 

flag when positioned over a trace. 
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3. Do one of the following: 

 Click to insert a marker with the default duration of the selected event. 

 Drag across a segment of the trace. 

Marking Events with the MDrive* 

*Not available with the License free version of RemLogic 

When the MDrive is connected to RemLogic, you can mark an event with RemLogic as 
described in this section: using keyboard shortcuts or with the mouse. You can also edit the 
event as described in this section. 

 

Note: RemLogic and a secure digital (SD) card in the MDrive can record studies. If you 
mark an event with RemLogic, the event displays in the RemLogic only; it does not 
display on the MDrive screen, and the SD card does not record the event. 

For information about marking an event using the MDrive itself, see Mark MDrive Menu 
Functions section of the MDrive Instructions for Use. If you mark an event with the MDrive, you 
can edit the event within RemLogic as described in this section. Edits do not transfer to the SD 
card 

Event Palette Insertion Mode 

In Event Palette Insertion mode, the event you last selected from the Event Palette is used for 
all subsequent event placements until another event is selected. 

To turn on Event Palette Insertion mode: 

 On the Event toolbar, click Event Palette Insertion Mode   so that it is enabled. 

To turn off the Event Palette Insertion mode: 

 Do one of the following: 

 On the Event toolbar, click Event Palette Insertion Mode   so that it is 
disabled. 

 Press ESC. 

Single Click Insertion Mode 

In Single Click Insertion mode, the event you last selected for the trace on which you are 
placing an event is used. 

To enable the Single Click Insertion Mode: 

 Click Single Click Insertion Mode   on the Event toolbar so that it is enabled. 

To disable the Event Palette Insertion mode: 

 Click Single Click Insertion Mode   on the Event toolbar so that it is disabled. 
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Overlapping Events 

By default, marking an event over an existing event replaces the existing event. You can disable 
this feature in the Options dialog. As a new feature, there are several Event Overlap Groups 
that have been created to manage the overlapping of events within RemLogic.  In the licensed 
version of RemLogic, these event groups can be modified and saved into a new configuration 
file which can be exported or imported.  See Configuration File Setup for details. 

To disable event overlapping: 

1. On the Tools menu, click Options. 

2. In the left pane, click Event. 

3. Clear the Remove events in the same Event Overlap Group check box. 

4. Click OK. 

Automatic Removal of Manual Events 

Within RemLogic, you can have the computer assisted scoring events remove any manual 
events that are a part of the same Event Overlap Group.  By default, this option is 
disabled.  You can enable this feature using the Options dialog. 

To enable Automatic Removal of Manual Events: 

1. On the Tools menu, click Options. 

2. In the left pane, click Event. 

3. Select the Automatic events can remove manual events in the same Event Overlap 
Group check box. 

Event Overlap Groups 

The following Event Overlap Groups are provided as the default within the RemLogic 
software.  Events not listed in the table below are not included in an Event Overlap Group at this 
time.  Modifications to these groups can be made in the Licensed version of RemLogic. 

Event Overlap 
Group 

Event types Included 

Arousal Arousal, Apnea Arousal, Desaturation Arousal, Hypopnea Arousal, LM 
Arousal, PLM Arousal, Respiratory Arousal, Snore Arousal, 
Spontaneous Arousal, RERA 

Autonomic Arousal Autonomic Arousal, Desaturation-Autonomic Arousal, LM-Autonomic 
Arousal, Respiratory-Autonomic Arousal ,  Respiratory Desaturation-
Autonomic Arousal, Spontaneous-Autonomic Arousal 

Body Position Left, Right, Upright, Prone, Supine, Unknown Position 

CAP MCAP-A1, MCAP-A2, MCAP-A3 

Cardiac Arrhythmia,  Asytole,  Atrial Fibrillation, Bradycardia, Narrow Complex 
Tachycardia, Sinus Tachycardia, Tachycardia, Wide Complex 
Tachycardia 
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Event Overlap 
Group 

Event types Included 

CPAP Bilevel, CPAP, APAP, VAUTO, ASV 

Movement Alternating Leg Muscle Activation, Bruxism Phasic, Bruxism Tonic, 
Excessive Fragmentary Myoclonus, Hypnagogic Foot Tremor, RBD 
Phasic, RBD Tonic, Rhythmic Movement Disorder 

PLM LM, PLM, Respiratory Related LM 

ResMed Device RMD Apnea, RMD Hypopnea, RMD Breath 

Sleep Apnea Apnea, Apnea Central, Apnea Mixed, Apnea Obstructive, Hypopnea, 
Hypopnea Central, Hypopnea Mixed, Hypopnea Obstructive, RERA 
Event 

Snoring Snore, Single Snoring, Snoring-Loud, Snoring-Moderate, Snoring-Soft 

Apneic Group Apneic Phase, Hyperpneic Phase 

Crescendo Group Crescendo, Decrescendo 

Spindle Group KComplex, Spindle, Spindle Block, Sync Spindle 

RM Group RM, SM 

Analysis Period Analysis Start, Analysis Stop 
 

Modifying an Event Overlap Group* 

*Not available with the License free version of RemLogic 

Modifications to the above groups can be made using the Event menu. 

To modify an Event Overlap Group: 

1. From the Events menu, click Event Overlap Groups…. 

2. Configure the Event Overlap Groups according to the following table: 

To Do This 

Add a new Event 
Overlap Group 

1. Click the New button. 

2. Assign your new group a unique name. 

3. Select the event types from the All event types list by 
selecting the desired event type and clicking on the 
Add button. 

4. Once all desired event types have been selected click 
OK. 
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To Do This 

Edit an existing Event 
Overlap Group 

1. Select the desired Event Overlap Group, and click on 
the Edit button. 

2. Select the event types you wish to add to or remove 
from the group by selecting the event type from the 
existing lists and pressing either the Add or the 
Remove buttons. 

3. Once all changes have been completed, click OK to 
save the Event Overlap Group. 

 

Note: Once an event type has been selected and the 
Add button has been clicked, the event is removed 
from the All event types list and added to the Group 
event types list. 

Delete an Event 
Overlap Group 

1. Select the desired Event Overlap Group, and click on 
the Delete button. 

2. This removes the Event Overlap Group permanently 
and cannot be undone. 

Create an Exception 
to the Event Overlap 
Groups 

1. Click the Exceptions button. 

2. Select the event types that you wish to be excluded 
from the Event Overlap Groups, and click the Add 
button. 

3. Once all desired exceptions have been created click 
OK. 

3. To have all changes take effect, click OK.  Clicking Cancel will undo all changes made 
within each event overlap group. 

 

Note: Modification of the Event Overlap Groups can cause undesirable results when 
scoring.  Use extreme caution when adjusting the groupings within RemLogic. 

Deleting an Event 

To delete an event from a Workpad, do one of the following: 

 Click on the event that should be deleted, then press DELETE. 

 Right-click the event, then click Delete. 

To delete more than one event simultaneously: 

1. Do one of the following: 

 Select the events you want to delete by clicking them while holding down CTRL. 

 To select events of the same type, right-click an event, then click Select By 
Type. Events of the same type are selected within the active trace. 

2. Press DELETE. 
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Moving an Event 

You can move an event to a new position within the same trace or another trace on the 
Workpad Sheet. 

To move an event: 

1. Place the pointer over the event. 

2. Drag the event to the desired location. 

Resizing an Event 

You can increase or reduce the width of an event marker. 

To resize an event: 

1. Place the pointer on the border of the event. The pointer changes to: . 

2. Drag the border to increase or reduce the length of the event. 

Event Type Destination and Preference 

An event’s destination is the location on the Workpad Sheet at which the event is placed during 
scoring. You can place an event on the active trace, a specified trace, traces belonging to a 
specified trace category (for example, EEG), and all traces on a Workpad Sheet. When you 
specify the destination of frequently used events, you tailor their behavior to suit your scoring 
workflow. As a result, scoring becomes more streamlined and interactive. 

An event's preference is its association with a specified trace or trace category (for example, 
EEG). A trace category includes traces with the same trace name prefix, such as EEG. By 
specifying a preferred trace or trace category, the event, by association, becomes a preferred 
event of the trace or trace category. You can configure a trace or trace category to have one or 
multiple associated or preferred events. This association, intended to simplify event marking, 
ensures that specified preferences are first on the list of options in the Change Type shortcut 
menu. This menu allows you to change the event type of previously placed events. See 
Changing the Event Type for more information. 

If you select Specific Trace as the preferred option for an event, and then specify a trace, the 
event is listed at the top of the Change Type shortcut menu when you change an event 
previously placed on the specified trace. Similarly, if you select a trace category as the preferred 
option for an event, the event is listed at the top of the Change Type shortcut menu when you 
change an event previously placed on a trace of the specified trace category. 

You can specify an event’s destination and preferred trace or main type in the Event Type 
Properties dialog. 

To specify the destination and preference of an event: 

1. On the Events menu, click Types. 

2. From the list, click the event, then click Edit. 

3. Click the Constraints tab. 
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4. Do one of the following: 

To… Do This… 

 Place the event on the active 
trace. 

1. Under Event Placement, from the 
Destination list, select Active Trace. 

2. Under Preferred Trace, click None. 

 Place the event on the active 
trace. 

 List the event associated with the 
specified trace in the top section 
of the Change Type menu. 

1. Under Event Placement, from the 
Destination list, select Active Trace. 

2. Under Preferred Trace, click Specific 
Trace. 

3. From the list to the right, select a trace. 

 Place the event on the active 
trace. 

 List the events associated with 
the specified trace category in the 
top section of the Change Type 
menu. 

1. Under Event Placement, from the 
Destination list, select Active Trace. 

2. Under Preferred Trace, click Trace Group. 

3. From the list to the right, select a trace 
group. 

 Place the event on all traces. 1. Under Event Placement, from the 
Destination list, select All Traces. 

2. Under Preferred Trace, click None. 

 Place the event on all traces. 

 List the event associated with the 
specified trace in the top section 
of the Change Type menu. 

1. Under Event Placement, from the 
Destination list, select All Traces. 

2. Under Preferred Trace, click Specific 
Trace. 

3. From the list to the right, select a trace. 

 Place the event on all traces. 

 List the event associated with the 
specified trace category in the top 
section of the Change Type 
menu. 

1. Under Event Placement, from the 
Destination list, select All Traces. 

2. Under Preferred Trace, click Trace Group. 

3. From the list to the right, select a trace 
group. 

 Place the event on the specified 
trace. 

 List the event associated with the 
specified trace in the top section 
of the Change Type menu. 

1. Under Event Placement, from the 
Destination list, select Specific Trace. 

2. From the Signal Type list, select a signal 
type. 
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To… Do This… 

 Place the event on all traces in 
the specified main type (for 
example, EEG). 

 List the event associated with the 
specified trace category in the top 
section of the Change Type 
menu. 

1. Under Event Placement, from the 
Destination list, select Trace Group. 

2. From the Signal Type list, select a trace 
group. 

Changing the Event Type 

You can change the event type of a previously-placed event using the Change Type shortcut 
menu or a keyboard shortcut. 

Change Type Shortcut Menu Method 

Using the Change Type shortcut menu, you can quickly change the event type of a previously 
placed event: 

 Associated with the trace on which the event is placed. 

 Associated with the trace category to which the trace belongs. 

 Included in an event palette. 

 Not included in an event palette. 

To change the event type using the Change Type shortcut menu: 

 Right-click the event, point to Change Type, then do one of the following: 

To Do This 

Change the event to a preferred 
event associated with the trace 
or trace category. 

In the top section of the Change Type shortcut menu, click 
an event. See Event Types Destination and Preference for 
more information. 

Change the event to an event 
type included in an event 
palette. 

In the second section of the Change Type shortcut menu, 
point to the applicable event palette (for example, Arousal 
Events), then click an event. 

Change the event to an event 
type not included in an event 
palette. 

In the second section of the Change Type shortcut menu, 
point to Other, then click an event. 

Keyboard Shortcut Method 

To change the event type using a keyboard shortcut: 

 Click the event, then press the keyboard shortcut of new event type. 
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To change the event type of multiple events simultaneously: 

1. Do one of the following: 

 Right-click one of the events on the trace, then click Select Events By Type. 

 Click each event while holding down CTRL. 

2. Press the shortcut key of the new event type. 

Event Markers 

By default, event markers display the event type (for example, Sleep Spindle), event mode (for 
example, manual or computer assisted), start time, and duration. If you mark events while a 
study is in progress, events are time-stamped as ending at the time the keyboard shortcut is 
pressed. For example, pressing the keyboard shortcut for Apnea at 23:30:20 time-stamps the 
event ten seconds earlier at 23:30:10, the default duration of Apnea events. For information on 
modifying keyboard shortcut assignments, see Event Types: General. 

To display event information: 

 Hover the pointer over the event bar. The pointer changes to: . A yellow comment 
box displays the event information. 

 

To change the appearance of an event marker: 

 Right-click the event marker, then click one or more of following options: 

 Enable Show Bar to show the event bar. Showing the event bar is useful in 
highlighting the event duration. Hiding the bar is might reduce the visual clutter or 
displaying many events on the screen. 

 Enable Show Caption to display the event caption. 

 Enable Highlight Background to highlight the trace background in a different 
color. This option is useful for highlighting respiratory events. 

 Enable Highlight Trace to display the event as a highlighted trace. This also 
alters the color of the trace during the duration of the event. This feature is useful 
for transient events such as sleep spindles, spikes, and artifacts. Highlighting a 
trace is suitable for short or high-density events. 

Changes are saved with the Workpad Sheet. To make permanent changes to the appearance 
of an event, see Event Types. 

Default Event Duration 

To modify the default event duration: 

1. On the Events menu, click Types. 

2. Click the event, then click Edit. 

3. In the Default Duration text box, enter type the duration in seconds. 
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Event Palette 

By default, the Event Palette is in Workspace Area, to the left of the Operations Sheet. 

 

Event Palette with the All Events event filter selected. The Palette 
tab displays by default. (Licensed Version of RemLogic) 
 

 

Event Palette with the All Events event filter selected. The Palette 
tab displays by default. (License free Version of RemLogic) 

The Event Palette organizes, according to type, default events used to score a Workpad on 
tabs. You can navigate events by clicking scored events on the Events tab. The License free 
version of RemLogic includes only the Palette and Events tabs. 

Opening/Closing the Event Palette 

To open the Event Palette, do one of the following: 

 Click Toggle Event Palette   on the toolbar. 

 On the View menu, point to Workspace, then click Event Palette. 

To close the Event Palette, do one of the following: 

 Click Toggle Event Palette   on the toolbar. 

 Click Close  on the Event Palette bar. 
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Palette Tab 

On the Palette tab, related events are grouped together under a palette name, such as Bio 
Calibration. Selecting a palette from the list displays events grouped under that event palette. 
To view all available events, select All Events from the list. 

 

Licensed Version of RemLogic 

 

License free Version of RemLogic 

Palettes available in the Palette Tab list: 

Items marked with an “*” are not available in the License free version of RemLogic. 
Items marked with a “

♦
” are not currently available in the United States. 

 All Events 

 Arousal Events 

 Autonomic Arousal 
Events 

 Bio Calibration* 

 CAP*♦ 

 CAP Manual*♦ 

 Cardiac Events 

 Infant Sleep Staging* 

 Movement Events* 

 Pediatric Sleep 
Staging* 

 PLM Events 

 Pressure Events 

 ResMed Device 
Events 

 Sleep Apnea Events 

 Sleep Events* 

 Sleep Scoring*♦ 

 Timed EEG Events* 

 Video Events* 
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Events Tab 

The Events tab lists all events that were marked into the Workpad, along with the time the 
events occurred and their duration. This can be sorted by name or time index. 

 

Licensed Version of RemLogic 

 

License free Version of RemLogic 

To view a specific event in the Workpad: 

1. In the Event Palette, click the Events tab. 

2. Select a palette type from the list. 

3. Select the event that you want to view. 

The Workpad jumps to the location of the selected event in the recording. 
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Event Associations Tab* 

*Not available with the License free version of RemLogic 

The Event Associations tab lists events that are associated with other events. To view 
associations, expand the node (+) adjacent to the event. 

 

Tech Notes Tab* 

*Not available with the License free version of RemLogic 

The Tech Notes tab lists all tech notes inserted into Workpad Sheets. You can navigate 
between notes by selecting a specific comment from the list. 
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You can insert comments anywhere in the Workpad Sheets by entering it into a note box. Note 
boxes can be resized and moved between traces. See Marking Events for information about 
how to manipulate a note box. 

To insert a tech note: 

1. Right-click inside the pane where the tech note will be placed, then click Add Note. 
Alternatively, click inside the pane where the tech note will be placed, then press F11. 

2. Type text into the note box. 

3. When you are finished, click outside the note box. 

 

The Audio Event is not available in the Event Palette (see Analyzing Data | Marking Events | 
Special Events in the RemLogic online help). 

Special events, such as time events (Analysis Start, Analysis Stop, Lights On, Lights Off, 
Button, Pressure, and Bilevel), are of special interest because of their functionality. For specific 
information about marking and function of these events, see Special Events in the following 
location in the RemLogic online help file: Analyzing Data | Marking Events. For information 
about how to create a new event type or edit available events, see Event Types and 
Customizing Event Palettes. 

View as Recorded Tab* 

*Not available with the License free version of RemLogic 

Recording related display change events are logged chronologically in the Event Palette on the 
View as Recorded tab sheet. To advance to a display change event in the recording, double-
click an item in the list. For more information, see View as Recorded in the following location of 
the RemLogic online help: Work Environment | Workpad Area | Workpad Views | View 
History. 
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View as Scored Tab* 

*Not available with the License free version of RemLogic 

Scoring -related display change events are logged chronologically in the Event Palette on the 
View as Scored tab sheet. To advance to a display change event in the recording, double-click 
an item in the list. For more information, see View as Scored in the following location of the 
RemLogic online help: Work Environment | Workpad Area | Workpad Views | View History. 

 

Customizing an Event Palette* 

*Not available with the License free version of RemLogic 

You can organize event types into event palettes, that is, groups of related events. Event 
palettes can filter information displayed in the Event Radar View and Event Report. RemLogic 
features several predefined event palettes and associated event types. You can add or delete 
events from these palettes or create new palettes—for example, create a custom list of events 
to display in the Event Radar. You can edit the event palettes in the Event Palette Properties 
dialog. 

 

Note: Only experienced users should modify the default event palettes. Incorrect 
modification of some of the default event palettes might render portions of the system 
unusable until they are recreated correctly. 

To create or edit an event palette: 

1. On the Events menu, click Palettes. The Event Palettes dialog box displays. 

 

 New: Click this button to create a new event palette. 

 Edit: If you want to edit an existing event palette, select the palette from the list, 
then click this button. 

 Delete: To delete a palette, select the appropriate palette, then click this button. 
Click OK to exit the dialog. 
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2. If you clicked either New or Edit, the Event Palette Properties dialog box displays. 

 

 Palette name: Displays the palette's name. This name displays in the Event Palette 
in the Workspace area. 

 Palette Type: Uniquely identifies a specific palette. This is usually the same as the 
palette's name. It is not possible to change the type of existing palettes. The palette 
type is only used when referencing an event palette programmatically. 

 Palette event types: Lists the event types that are in the event palette. To add 
event types to the list, select the desired type from All event types and click Add. 
To remove event types from the palette, select the type from the Palette event 
types list and click Remove. You can sort the events in a palette into any desired 
order by clicking and dragging them up or down with the mouse. 

 All event types: Contains all event types available apart from those already listed in 
the Palette event types list. Select from this list to add event types to event palettes. 

6. Click OK. 

Finding Events 

In addition to the Event Palette, you can use three different methods to locate events on a 
scored Workpad. 

Find Command 

To find an event and jump to its location in a recording: 

 On the Events menu, point to Find, then click one of the find command options. 
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Tip: You can also find events by using keyboard shortcuts. Shortcuts are listed next to 
each find command (from the main menu, select Events | Find). To find the next 
event of the same type, press SHIFT + RIGHT ARROW. 

Advanced Find 

To perform an advanced search: 

1. Do one of the following: 

 On the Events menu, point to Find. 

 Press F3. 

2. From the drop-down list, select the event type for which you want to search. 

 

3. Select the Within active trace check box to search within the activated trace. 

4. Select the Include events not visible in sheet check box to search all events (visible 
on the Workpad Sheet and invisible events (in other words, those without a bar, caption, 
or background)). 

5. See Events Toolbar for information on navigation buttons. 

Events Toolbar 

The find event buttons on the Events toolbar can be used to quickly locate events. 

 

Find Event Toolbar 

Button Description 

 

Searches for events within the active trace. 

 

Finds the previous event in recording. 

 

Finds the next event in recording. 

 

Finds the first event in recording. 
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Button Description 

 

Finds the last event in recording. 

 

Finds the previous event of same type. 

 

Finds the next event of same type. 

 

Finds all events that match the selected event type. 

Event Types 

You can create and customize event types. Event types are edited in the Event Type Properties 
dialog box. 

Creating an Event Type 

When you create an event type, it is added to the list of events in the Event Palette. 

To create an event type: 

1. On the Events menu, click Types. 

2. Click New. 

3. Modify information on the General, Visualization, Constraints and Visualizing 
Associations tabs to specify how events will behave and display in the Workpad. 

4. Click OK. 

General 

The General tab defines general properties of the event, such as the event's label, duration, 
and corresponding shortcut key. A message in the lower-left corner indicates whether the event 
type is used in an event palette. If it is used, the event type cannot be deleted, and the type 
name cannot be changed. 

General Properties 

Property Description/Procedure 

Default 
Label 

Type a descriptive label for the new event type. This label will display in the 
Event Palette and on the title caption of the event in the Workpad. It is 
recommended to keep the label short. The label name will also display in the 
type name field, if this is a new event type. 

Default 
Duration 

Type a duration for the event. The default duration is used when the event is 
marked without selecting a specific duration, and to determine the epoch 
duration for scoring events. 
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Property Description/Procedure 

Type Name Type a unique identifier for the event. The type name is used by reports to look 
for specific event types. Predefined event type names, such as those for 
respiratory events, cannot be changed because they are used by the reports. If 
you would like to create a new event type group, enter the group name followed 
by a dash, then type the event name. Ensure that there are no spaces before or 
after the dash. 

Hot Key Enter a shortcut key for the event. All events can have a hot key assigned to 
them. This allows you to insert events with a single keystroke. Avoid using 
complex combinations like control keys, and so on. The ALT key should not be 
used, as such commands will conflict with the Windows menu shortcuts. 

Icon Select an icon to be displayed with the event in the Workpad (optional). It is 
suitable for some types of events and can be very effective when viewing a large 
number of events. 

Visualization 

The Visualization tab is used to adjust how an event displays in the Workpad Sheet. The 
changes made in this tab are saved and applied to all future Workpad Sheets, unlike temporary 
changes made to event appearance. For more information, see Marking Events. 

Visualization Properties 

Property Description/Procedure 

Show event label Select this option if you want the event name to display in the Workpad. 

Highlight trace Select this option if you want to display the event as a highlighted trace. 
This alters the color of the trace for the duration of the event. This feature is 
useful for transient events, such as sleep spindles, spikes, and artifacts. 

Show event bar When this option is selected, the event will display with a bar or handle. 
Event bars are suitable for some types of events, especially where the 
event duration is important. 

Highlight 
background 

The background of the trace will be highlighted in a different color for the 
duration of the event when this option is selected. It is especially suitable for 
respiratory and other events where the epoch of the event is considered 
significant. 

Show event 
duration 

If you want the duration of the event to display along with the event in the 
Workpad, select this option. The duration will display in brackets next to the 
event label. If the Show event label option is clear, the event duration does 
not display. 
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Property Description/Procedure 

Show custom 
variable 

This option applies to events that have custom variables, such as pressure, 
Desaturation, and Impedance events. Select this option and type into the 
box the name of the variable that should display in the Workpad. The 
selected variable will display in square brackets next to the event label in 
the Workpad. If the Show event label option is not selected, the custom 
variable will not display. To find out if an event has a custom variable, place 
the mouse pointer on the event in the Workpad. A yellow comment box will 
display information about the event. The custom variables display in blue. 

Event bar and 
trace highlight 

Each event type can have a set color that is used when drawing the event 
bar. The color is also used by some of the analysis tools when referring to 
the event—for example, in the Event Report and the Overview Sheet. This 
color is also used to highlight the trace if the Highlight trace option is active. 
Click the color box to customize the color. 

Background 
highlight 

If the Highlight background option is active, the selected color highlights the 
trace background. Choose a color in high contrast to the trace color so they 
are clearly visible from one another. 

Constraints 

The constraint properties of an event allow you to mark the trace at a specific time, position, and 
destination. 

Constraints Properties 

Property Description/Procedure 

Locked in time When this option is selected, the event cannot move to the left or right in 
the Workpad Sheet. Events that have a time aspect—like event buttons—
should be locked in time. For example, sleep scoring events are locked in 
time. 

Locked to the 
trace 

When this option is selected, the event cannot move to another trace. For 
example, desaturation events should be locked to the SpO2 trace. 

Snaps to the grid 
when being 
moved 

By default, you can freely position an event anywhere in the Workpad. This 
option makes the event snap to several predefined vertical positions or 
event lines. As a result, two event title captions cannot overlap each other. 

Scoring event, 
implicitly locked 
in time 

Select this option to define the event as a scoring event. The behavior of 
scoring events differs from the behavior of instantaneous events. Scoring 
events belong to a continuous series of scoring epochs, and it is not 
possible to delete a scoring event from within the middle of a scoring 
session. 

Event Placement 
(Destination) 

Defines the placement of the event on a Workpad Sheet. Options: Active 
Trace, Specific Trace, Trace Group, and All Traces. 

Event Placement 
(Signal Type) 

Available if the Specific Trace or Trace Group Destination option is 
selected. Select the Signal Type from the drop down menu. 
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Property Description/Procedure 

Preferred Trace 
(None) 

Available if the Active Trace or All Traces Destination option is selected. 

Preferred Trace 
(Specific Trace) 

Available if the Active Trace or All Traces Destination option is selected. 
Select the Specific Trace from the drop down menu. 

Preferred Trace 
(Trace Group) 

Available if the Active Trace or All Traces Destination option is selected. 
Select the Trace Group from the drop down menu. 

  

 

Note: New customized events are only included in the Event Report and custom 
reports. 

Visualizing Associations 

The Visualizing Associations tab allows you to specify what information will display about an 
association: 

Visualizing Association Properties 

Property Description/Procedure 

Number of 
associations 

Displays the total number of associations within the association range. 

Associated 
events 

Displays the names of the events that are associated (either the label or 
type name). 

Display 
associated 
events by event 
label or event 
type 

Select either Label or Type from the list. 

Deleting an Event Type 

Default event types cannot be deleted. 

To delete an event type: 

1. On the Events menu, click Types. 

2. Select the event type, then click Delete. 

3. Click OK. 

The event type is removed from the Event Palette. 
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Event Radar View 

The Event Radar displays an overview of all the events marked on the Workpad Sheet. If there 
are no events in the Workpad, the Event Radar is empty. 

 

The Event Radar. Event colors displayed are the same as the colors chosen for particular events. 

A vertical bar on the Event Radar indicates what part of the Event Radar displays in the 
Workpad. The width of the vertical bar is proportional to the part of the recording displayed in 
the Workpad. When the scale of the time axis is large, the vertical bar becomes wider. If you 
move to another part of the Workpad, the vertical bar in the Event Radar moves accordingly. 
Likewise, if you click on a different point in the Event Radar, the Workpad displays the same 
location. Where there are intervals with no events, clicking on the Event Radar causes the 
selection to jump to the nearest event to the left of the clicked position. 

To access this view: 

 On the View menu, click Event Radar. 

Filtering the Event Radar 

By default, the Event Radar displays all event types. You can choose what types of events to 
display in the Event Radar. 

To filter the Event Radar: 

1. Right-click inside the view window. 

2. Select the events types you want to display. 

Trace Overview 

The Trace Overview displays an overview of an entire trace for the whole recording time. Trace 
Overview gives you the opportunity to quickly find places of interest in the recording—when the 
oxygen desaturation falls below normal values, for example. The Trace Overview has a position 
marker that helps you navigate through the recording. Signal traces with low sampling rates 
provide a clearer overview than those with high sampling rates. 
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Overview of an SpO2 trace and a Pulse trace 

To view the Trace Overview for a trace: 

1. Click the trace. 

2. From the main menu, select View | Trace Overview. 

Adding a Trace 

You can display multiple traces in the Trace Overview window simultaneously. 

To add a trace to the overview: 

1. Activate the trace you want to add to the Trace Overview. 

2. Right-click inside the overview window. 

3. Click Add Active Trace. 

An overview of the active trace displays at the bottom of the Trace Overview window. 

Removing a Trace 

To remove traces from the overview: 

1. Inside the Trace Overview, right-click the trace you want to remove. 

2. Click Remove Trace. 

Process Modes 

You can choose between several process modes for the Trace Overview. For example, you can 
opt to show only the minimum or maximum values for the trace. 

To select a process mode: 

1. Right-click inside the view window. 

2. Point to Process Mode, then click the mode in which the Trace Overview should 
process the trace. 



Instructions for Use                 RemLogic™ 3.4 

               218 

Trace Color 

By default, Trace Overview trace displays in blue. You can change the color of the trace in the 
view. 

To change the trace color: 

1. Right-click inside the view. 

2. Point to Line Color, then click the color you want to use for the line. 

Epoch Size 

You can change the epoch size used in the Trace Overview. By default, the Trace Overview 
displays the trace using five second intervals. Increasing the epoch size reduces trace 
resolution based on the selected process method. Similarly, decreasing the epoch size 
increases the resolution of the trace. Some process methods show more variance when used 
with larger epoch sizes, such as the min/max process method. Some process methods also 
require a certain amount of data to be considered accurate, such as the RMS and the SD 
methods. 

To change the epoch size: 

1. Right-click inside the overview window, then click Epoch Size. 

2. Type the desired epoch length into the text box, then click OK. 

The Trace Overview is updated according to the new epoch length. 

Excluding Artifacts 

By default, the Trace Overview shows artifacts that are marked on the trace. You can select to 
exclude artifacts from the overview. 

To exclude artifacts from the overview: 

1. Right-click inside the overview window. 

2. Click Artifacts. The check mark disappears. 

To include artifacts again, repeat this action. 

A check mark in front of Artifacts indicates artifact areas are shown in the Trace Overview by 
hiding those areas. 
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No check mark in front of Artifacts indicates artifact areas are not shown in the Trace 
Overview. 

 

Computer Assisted Analysis 

 

Note: The computer assisted analyzers for Snoring, PLM, Arousal, and Respiratory 
events have only been validated using Adult studies, and are for use with only Adult 
studies. 

Computer Assisted Analysis 

Depending on the version of RemLogic you have purchased, the RemLogic computer assisted 
analyzers can score sleep stages, mark respiratory events, limb movements, arousals, and 
generate heart variability from recorded EKG. These analyzers use parameters that can be 
modified and saved in an analysis profile. Multiple analysis profiles can be created to address 
the needs of differing patient populations. 

 

Note: The computer assisted analysis tools provided by RemLogic are intended to 
assist in the analysis of polysomnographic data by a physician or trained technologist. 
These tools are not intended to replace the physician or trained technologist. Users 
should always review and edit the results of computer assisted analyses to ensure 
accurate event marking. 

RemLogic has several analyzers and trace generators. 

Items marked with an “*” are not available in the License free version of RemLogic. 
Items marked with a “

♦
” are not currently available in the United States. 

 Arousal Analyzer* 

 Association Module 

 CAP Scoring Assistant*♦ 

 CSB Analyzer*♦ 

 Inter-Scorer Comparison 

 Pleth Analyzer♦ 

 PLM Analyzer 

 Respiration Analyzer 

 Scoring Assistant*♦ 

 HRV Trace Generator 

 PTT Trace Generator 

When each analyzer begins, it will check for any existing computer assisted scoring events 
generated.  It will then check for any manual events created which are the same as the 
computer assisted scoring events generated.  If existing events are found, the software will 
prompt you to remove them with the following options: 
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 Automatic Events Only – If only computer assisted analysis events are found, you can 
either remove all previous events by selecting OK, or stop the analyzer by selecting 
Cancel. 

 Manual Events Only – If only manual events of the same type as the analyzer are 
found, you have the option to remove these events by selecting OK, or stop the analyzer 
by selecting Cancel. 

 Both Automatic and Manual Events – If both manual and computer assisted analysis 
events are found, you have the option to remove these events by selecting one of the 
following options and selecting OK.  Clicking Cancel will stop the analyzer. 

o Remove automatic events only 

o Remove manual and automatic events 

If you choose remove manual and automatic events, a confirmation dialog box 
will be displayed asking if you want to delete the manually scored events.  You 
have three options available: 

1. You can choose to continue and remove both types of events by clicking 
Yes. 

2. You can choose to not remove the manually scored events by clicking No. 

3. You can stop the analyzer by clicking Cancel. 

 

Note: The Sleep Scoring Assistant analyzer will not be able to remove or re-score 
computer assisted or manual events. 

Analysis Start and Stop 

To specify the analysis period, mark the Workpad Sheet with Analysis Start (+ hotkey) and 
Analysis Stop events (- hotkey) to signify the beginning and end of the analysis, respectively. 
This step will exclude noise and artifacts resulting from the patient retiring for the night and 
separate the analysis period or Time In Bed from the Total Recording Time. For more 
information, see Marking Events. 

Regardless of the position of the Start/Stop events, body positioning and movement events can 
be inserted throughout the recording. Respiratory and LM events, however, are limited to the 
range denoted by the Analysis Start and Analysis Stop events. In the latter case, the entire 
recording will be analyzed if you do not mark the Workpad Sheet with Start/Stop events. 

The patient must place the Embletta on the abdomen; otherwise, the default device location 
Front must be changed before analyzing the recording. This step ensures settings reflect the 
actual location of the Embletta. 
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Analysis Parameters 

Several parameters affect the behavior of the various analysis modules. You can modify and 
save these parameters in an analysis profile. Any parameter modification will affect data 
analysis. The changes made to parameters will persist when you start RemLogic again. 

The analysis parameters used in the computer assisted analysis are accessible in the Analysis 
Settings dialog. 

To modify an analysis parameter: 

1. Do one of the following: 

 On the Analysis menu, click Settings. 

 On the Analysis Settings Manager bar, click Analysis, then Settings. 

The Analysis Settings dialog box displays. 

2. From the Profile list, select the custom profile to be changed. 

 

3. Expand the desired parameter section by clicking the plus symbol   next to the section 
name. A list of subsections displays. 

4. Select the appropriate subsection to view its parameters in the Parameter column on 
the right. 

 

5. To change the parameter value, do one of the following: 

 Double-click the Value field you want to change. Type in or select the desired value. 

 Right-click the Value field you want to change, and select Revert to parent or 
Revert to default to restore original settings for the selected parameter based on 
the original profile from which the custom profile was created (settings are inherited 
from the parent profile). 

 

6. When you are finished, click Close. 
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The customized parameters will be used by the analyzers when the analysis profile is selected 
in the Analysis Settings Manager. 

 

Note: RemLogic automatically starts with the default profile active. The default 
analysis profile is read-only and cannot be changed. To change parameters, a custom 
profile must be selected. To make the custom profile active during analysis, see the 
Applying an Analysis Profile section in the following location of the RemLogic online 
help: Analyzing Data | Computer Assisted Analysis | Analysis Profiles. 

Customized parameters are displayed in blue. The color makes it easy to distinguish 
default parameters from customized parameters. 

  

 

Tip: Clicking on a parameter in the Analysis Settings dialog box displays a description 
of the parameter at the bottom of the dialog. For a list of available parameters, see 
Analysis Settings (located in the Appendix of the RemLogic online help). 

The available value range for the parameter displays when the cursor hovers over the 
value. 

Clinical Study Summary – Respiratory, Arousal, Limb Movement and 
Snore Event Assisted Scoring  

Participants  

Fifty-one diagnostic PSG sleep studies were collected (one study per patient). All patients 
involved in this study were adult patients (18 years or older) with a clinical indication for a sleep 
study.  The patient data were de-identified and applied as subject data to this study.  

Dataset description  

Total Number of Subjects: 51 per event evaluated   

Total Number of scored Epochs (30 Sec): > 47,113 

Total Number of Hours: ≥ 392:36:30 

Mean number of epochs per subject: > 924 

Minimum number of epochs per subject: 764 

Maximum Number of epochs per subject: 1,162 

Data from 51 subjects were evaluated for respiratory, arousal, limb movement and snore 
events.  All epochs from these subjects were scored.  

Objective of the study  

The goal of the validation study reported here is to establish that RemLogic performance is 
equivalent to the performance of the predicate device. For the purpose of this study the 
“Reference standard” is defined using majority rule, that is at least two out of three expert 
scorings (medical professionals certified on PSG recording and analysis) agree on the presence 
of an event within an epoch.  

PSG acquisition protocol  

For this study, the following signals were recorded from each subject:  

 Six (6) Electroencephalogram ([EEG] channels: F3, F4, C3, C4, O1, and O2 
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 Two (2) Electrooculogram (EOG) channels 

 Submental and bilateral tibial electromyogram (EMG) 

 Electrocardiogram (ECG) 

 Airflow (nasal-oral thermistor and nasal pressure sensors or PAP flow) 

 Chest and abdominal movement using respiratory inductance Plethysmography 

 Pulse oximetry (SpO2) and pulse rate 

 Body position 

 Snoring 

PSG Analysis Protocol  

All physiologic data were collected and stored on a RemLogic System. The ECG, EEG, EMG, 
EOG and Snoring channels were sampled at 200 Hz or higher. The Airflow, Chest and 
Abdominal movement channels were sampled at 25 Hz or higher. The Pulse oximetry channel 
was sampled at 10 Hz. The Body Position channel was sampled at 1 Hz.  

The raw PSG recordings were de-identified, randomized and provided to three experienced and 
certified PSG specialists, including one board certified sleep specialist, who independently 
marked events of interest in each epoch, applying the following criteria:  

 Apnea is scored when both of the following criteria are met: 

a. There is a drop in the peak signal excursion by > 90% of pre-event baseline 
respiratory nasal pressure or flow sensor signal.  

b. The duration of the > 90% drop in sensor signal is > 10 seconds. 

 The apnea is Obstructive if it meets apnea criteria and is associated with 
continued or increased inspiratory effort throughout the entire period of 
absent airflow. 

 The apnea is Central if it meets apnea criteria and is associated with absent 
inspiratory effort throughout the entire period of absent airflow.  

 The apnea is Mixed if it meets apnea criteria and is associated with absent 
inspiratory effort in the initial portion of the event followed by resumption of 
inspiratory effort in the second portion of the event. 

 Hypopnea is scored if all of the following criteria are met: 

a. The peak signal excursions drop by > 30% of pre-event baseline using nasal 
pressure, PAP device flow or alternative hypopnea sensor. 

b. The duration of the > 30% drop in signal excursion is > 10 seconds. 

c. There is a > 3% oxygen desaturation from pre-event baseline or the event is 
associated with an arousal. 

 Scoring Arousals 

a. Score arousal during sleep stages N1, N2, N3, or R if there is an abrupt shift of 
EEG frequency including alpha, theta and/or frequencies greater than 16 Hz (but 
not spindles) that lasts at least 3 seconds, with at least 10 seconds of stable 
sleep preceding the change.  
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b. Scoring of arousal during REM requires a concurrent increase in submental EMG 
lasting at least 1 second. 

 Limb movement is scored if the following significant leg movement (LM) events are 
indicated: 

a. The minimum duration of a LM event is 0.5 seconds. 

b. The maximum duration of a LM event is 10 seconds. 

c. The minimum amplitude of a LM event is an 8 µV increase in EMG voltage above 
resting EMG. 

 Snore: The scoring of snore events relies on clinical interpretation. 

Separate from the expert review, all PSG studies were also analyzed by RemLogic assisted-
scoring modules at default values for:  

 Respiratory events (Central apnea, Obstructive apnea, Hypopnea)  

 Limb movement events 

 Snoring events 

The RemLogic assisted-scoring module default values applied for the clinical study are listed in 
the following tables.  

Respiratory Analysis Default Settings 

Analysis Setting Analysis Parameter Default Setting 

General Use Respiratory Baseline Event No 

Perform Computer Assisted Analysis Yes 

Perform Hypopnea Sub 
Classification 

No 

Artifact Detection Enable Artifact Detection Yes 

Apnea Select Trace Automatically  No 

Select Output Trace Automatically Yes 

Amplitude 25 

Shortest Duration 10 

Longest Duration 120 

Shortest Breath Duration 0.3 

Short Breath Amplitude 30 

Hypopnea Select Trace Automatically  No 

Select Output Trace Automatically Yes 

Amplitude 80 

Shortest Duration 10 

Longest Duration 120 
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Analysis Setting Analysis Parameter Default Setting 

Shortest Breath Duration 0.3 

Short Breath Amplitude 75 

Advanced Use Low Cut Filter for Flow Yes 

Flow Noise Level 0 

Thermistor Flow Noise Level 0 

Generic Flow Noise Level 0 

Maximum Breath Rate 1 

Pneumo Flow Noise Level 0 

Low Cut Filter for Flow 0.03 

Low Cut Filter for Thermistor 0.5 

Association Link Apnea to Desaturations No 

Interval from Apnea to Desaturation 20 

Link Hypopneas to Desaturations Yes 

Interval from Hypopnea to 
Desaturations 

20 

Ignore Desat connection when SpO2 
missing 

Yes 

Link Central Apneas < 20 sec to 
Events 

No 

Interval from Central Apnea to Event 20 

Link Hypopneas to Events Yes 

Interval from Hypopnea to Event 20 

Arousal Analysis Default Settings 

Analysis Setting Analysis Parameter Default Setting 

Analysis Shortest Duration 3 

Sensitivity 72 

Delta Sensitivity 5 

Theta Sensitivity 20 

Alpha Sensitivity 50 

Sigma Sensitivity 55 

Beta Sensitivity 55 

Link To Heartrate No 
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Analysis Setting Analysis Parameter Default Setting 

Heartrate Sensitivity 50 

Chin EMG increase search range 2 

Score Arousal During Wake No 

Minimum Chin EMG increase for 
arousal 

1.5 

Use Chin EMG increase for arousal Yes 

No EMG arousal threshold multiplier 3 

Periodic Limb Movement (PLM) Analysis Default Settings 

Analysis Setting Analysis Parameter Default Setting 

General Select Trace Automatically  Yes 

LM Analysis Shortest Duration 0.5 

Score LM during Apnea/Hypopnea 
Event 

No 

Longest Duration 10 

Lowest Relative Amplitude 8 

Highest Relative Amplitude 300 

Shortest Interval Between LM Events 5 

PLM Analysis Shortest Interval Duration 5 

Longest Interval Duration 90 

Number of Events in PLM 4 

Discard Arousal Association No 

Discard Apnea/Hypopnea 
Association 

No 

May Overlap Wake Yes 

Insert Additional Information Yes 

Combine Both Limb Traces Yes 

Association Link to Apnea/Hypopnea before LM 
Event 

10 

Link to Apnea/Hypopnea after LM 
Event 

0 

Link to Apnea/Hypopnea Method End of Event 

Link to Arousal before LM Event 0.5 

Link to Arousal after LM Event 0.5 
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Analysis Setting Analysis Parameter Default Setting 

Link To Arousal Method All Arousals 

Snore Analysis Default Settings 

Analysis Setting Analysis Parameter Default Setting 

General Perform Computer Assisted Analysis Yes 

Select Trace Automatically No 

Analysis Fewest Snores per Period 3 

Duration Between Periods 10 

Longest Snore Duration 4 

Shortest Duration Between Snores 1 

Cannula Snore Use Low Cut Filter No 

Low Cut Filter Frequency 1 

Threshold 0.00001 

Artifact Threshold 0.01 

Neck Snore Use Low Cut Filter No 

Low Cut Filter Frequency 1 

Threshold 0.00001 

Artifact Threshold 0.01 

Flow Generator Use Low Cut Filter No 

Low Cut Filter Frequency 1 

Threshold 0.4 

Artifact Threshold 400 

Audio Snore Use Low Cut Filter No 

Low Cut Filter Frequency 1 

Threshold 400 

Artifact Threshold 500000 
  

 

WARNING: Performance results reported here were obtained using default analysis 
setting parameters for assisted-scoring evaluated. Performance of the RemLogic 
assisted-scoring at settings different than the noted Default Settings have not been 
validated and may result in performance different than reported here. 
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Outcomes 

Positive Percent Agreement (PPA) between RemLogic and assisted-scoring compared to the 
Reference standard was measured on an epoch basis. The mean and 95% confidence interval 
(CI) of the PPA and false detection rate per hour for event detection for assisted-scoring are 
shown in the following table. 

PPA and False Detection Rate Per Hour of RemLogic Event Detection Assisted Scoring 
Analysis 

PPA False Detection Rate Per Hour 

Event 

95% CI 95% CI 

Mean Lower Upper Mean Lower Upper 

Central Apnea 98.3% 96.4% 99.0% 2.1 1.2 4.1 

Mixed Apnea 98.0% 95.6% 98.9% 2.4 1.3 5.1 

Obstructive Apnea 93.5% 91.0% 95.3% 7.8 5.6 10.9 

Hypopnea 85.5% 83.3% 87.4% 17.4 15.0 20.0 

Arousal 83.2% 81.2% 85.1% 20.2 17.8 22.6 

Limb Movement 86.0% 83.5% 88.2% 16.8 14.0 19.9 

Snoring 85.1% 82.5% 87.6% 17.8 14.9 20.9 

Conclusion 

Compared to the Reference standard; RemLogic assisted-scoring showed performance levels 
comparable to the manual markings of expert reviewers. The device performance is clinically equivalent 
to the Reference standard (majority rule) as constructed for this study, similar to results reported in the 
literature and to performance reported for other commercially available devices. 

 

It is important to review all detected events keeping in mind the performance of each 
analyzer described above. 

Arousal Analyzer* 
*Not available with the License free version of RemLogic 

The Arousals Analyzer is designed to score arousals from an input EEG trace and an EMG 
trace. The Arousal Analyzer analyzes the EEG signal and inserts arousal events into the 
Workpad based on the criteria set by AASM (American Academy of Sleep Medicine) Scoring 
Manual. According to the AASM specification, an arousal must be of duration 3 seconds or 
longer; however, parameters can be adjusted for user-defined criteria. In RemLogic, the default 
value is 3 seconds, but this value can be set to anywhere between 0.5 seconds and 10 seconds 
in the Analysis Settings dialog. 
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Clinical Utility* 

An EEG arousal is defined as an abrupt shift in the EEG frequency, which can include theta, 
alpha, and/or frequencies greater than 16 Hz, but not spindles. The RemLogic arousal analyzer 
identifies these abrupt EEG shifts. 

Frequency Bands* 

The Arousal Analyzer algorithm calculates a combination value from all the frequency bands 
and compares the value to a threshold value. If the calculated value is above a threshold, an 
arousal event is inserted. The algorithm uses the following frequency bands: 

Frequency Band 

Delta Band Represents frequencies from 0.5-4.0Hz 

Theta Band Represents frequencies from 4.0-8.0Hz 

Alpha Band Represents frequencies from 8.0-12.0Hz 

Sigma Band Represents frequencies from 12.0-16.0Hz 

Beta Band Represents frequencies from 16.0-35.0Hz 

  

 

Tip: To run the Arousal Analyzer, a valid EEG trace must exist in the recording and a 
scoring session must be inserted into the Workpad. 

Starting the Arousal Analyzer* 

If the arousal analyzer is run on separate traces, it will not score overlapping arousal events. For 
instance, if the arousal analyzer is run using the Central EEG derivation, it can be also be run 
on the Occipital derivation without duplicating arousal events. 
 

 

Note: A recording must include EEG and EMG data for the Arousal Analyzer to 
function. 

 

To run the Arousal Analyzer: 

1. On the Analysis menu, click Arousals. 

2. Do one of the following: 

 If the study contains computer assisted or manually scored arousal events, choose 
one of the following options, and then click OK. 

o Click Remove automatic events only to remove only the computer assisted 
analysis events. 

o Click Remove manual and automatic events to remove both the computer 
assisted and manually scored analysis events. 
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 If the study contains only manually scored arousal events, choose one of the 
following options:  

o Click Yes to delete the manual scoring, and confirm the deletion to proceed 
with the computer assisted analysis. 

o Click No to append the results of the computer assisted analysis to the 
existing manual scoring. 

3. Select the EEG trace to be used for analysis, and click OK.   

4. Select the EMG trace to be used for analysis.   

5. Click OK to finalize and run the Arousal analyzer. 

Association Module 

Use the Association Module to associate related events in a sleep study to identifying causal 
relationships. For example, an association between apnea events and arousals might indicate a 
sleep disturbance is caused by sleep disordered breathing. Similarly, associations between limb 
movements and arousals may signify a sleep disturbance caused by Periodic Limb Movements 
in Sleep (PLMS). 

Use (or customize) the default event associations provided by RemLogic to identify typically 
associated events, or customize event associations to suit your clinical requirements. 

Clinical Utility 

Apneas are defined as a drop in the peak thermal sensor excursion by greater than or equal to 
90% from baseline; a minimum duration of 10 seconds and at least 90% of the event’s duration 
meet the amplitude reduction criteria. 

Respiratory effort related arousal (RERA) is defined as a sequence of breaths lasting at least 10 
seconds, demonstrating increased effort or flattening of the nasal pressure waveform, which 
leads to an EEG arousal from sleep. 

An EEG arousal associated with a periodic limb movement should be considered when there is 
less than 0.5 seconds between the end of one event and the onset of the other event, 
regardless of which comes first. 

No arousal criterion is provided by the AASM guidelines in association with tachycardia and 
bradycardia. The EEG arousal rule described below is used by the manual scorers to identify an 
arousal. 

An EEG arousal in N1, N2, N3, or REM is scored when an abrupt shift of EEG frequency, 
including alpha, theta, and/or frequencies greater than 16 Hz, lasts at least 3 seconds. At least 
10 seconds of stable sleep should precede the EEG change. In REM sleep, the EEG arousal 
should be associated with a concurrent increase in sub-mental EMG that lasts at least 1 
second. 

The RemLogic Event Association tool detects the user scored and defined events and links 
them as "associated" by displaying an event associated tag. The tool does not utilize any 
physiological signals in linking events. 

Starting the Association Module 

Once you have configured the Association settings, you can run the Associations tool to create 
specified associations in a scored study. After running the tool once, you can use the 
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Associations Runtime Settings to ensure the associations are updated when another analyzer is 
run, or when manual edits are made to events in the study. You can also run the Associations 
tool again to update associations that are not configured in the Runtime settings. 

To start the Associations Module: 

1. From the main menu, select Analysis | Associations | Update all Associations. New 
associations are created and existing ones are updated. 

 

Note: This step should be completed again prior to generating reports 
to ensure that all associations are updated in the reports. 

2. To view the associations, select the Event Associations tab in the Event Palette. Each 
association is listed by its Primary event. To view the Secondary event, click the + sign 
to the left of the Primary event. 

 

Association Settings 

The Association Settings dialog box allows you to specify: 

 One or more primary and secondary events for each association. 

 Sub classifications for these associations, so that during analysis, the events are re-
classified to a more specific event association type (for example, desaturation-arousal 
instead of arousal). 

 When the tool should identify a series of events as an episode (such as a snore 
episode). 

To view default association settings: 

 On the Analysis menu, click Association Settings. These default associations can be 
edited or new associations can be created. For more information, see Event Association 
Parameters in the following location of the RemLogic online help: Analyzing Data | 
Computer Assisted Analysis | Association Module. 
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Association Tool Tips 

Association information (in the form of a tool tip) appears automatically when you move the 
mouse pointer over an association in a study. The tip disappears automatically in a few 
seconds, or when the mouse pointer is moved away from the association. 

Association tool tips can be configured to display the associated event name (based on the 
event label and assigned types) and the number of associations related to the event. 

To view association details (display the tool tip): 

 Hover the mouse over any associated event in a recording. 

 

Association tool tip with association information is displayed in red. The event label can be customized to display the 
number of Associations for an event and the associated event name (either label name or type name). 

You can configure tool tip settings in the Event Type Properties dialog. For more information, 
see Event Types. 

CSB Analyzer* 

*Not available with the License free version of RemLogic 
This feature is currently unavailable in the United States. 

The Embla Cheyne-Stokes Breathing (CSB) Analyzer is an algorithm that detects the typical 
crescendo and decrescendo waveforms in respiratory recording traces related to the airflow and 
breathing efforts of a patient. You can use it during collection or analysis. 

By default, the CSB Analyzer automatically selects a trace on which to detect the typical CSB 
waveform. In order of preference, the CSB Analyzer uses one of the following traces: 
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 Tidal Volume (Resp.TidalVolume-
Inductive) 

 XSUM (Resp.Sum-Inductive) 

 XFlow (Resp.Flow-Inductive) 

 Thorax Effort (Resp.Movement-
Inductive.Thorax) 

 Abdomen Effort (Resp.Movement-
Inductive.Abdomen) 

By default, the CSB Analyzer uses the Tidal Volume trace derived from the Respiratory 
Inductance Plethysmography (RIP) belts for the analysis. 

The CSB Analyzer scores the following events on a specified trace: 

 Apneic-Phase 

 Hyperpneic-Phase 

 CS-Cycle 

 CSB sequences 

You can modify their display properties in the Event Type Properties dialog box. For more 
information, see Event Types. 

Starting the CSB Analyzer* 

To start the CSB Analyzer: 

1. Open a patient recording. 

2. In the Analysis menu, click CSB Analyzer. 

 

Note: If the Select Trace Automatically is set to No in the Analysis Settings for CSB 
parameters, or if the CSB Analyzer did not detect one of the preferred respiratory 
signals, you must specify the trace on which the CSB Analyzer detects the Cheyne-
Stokes Breathing waveform.  

You can run the CSB Analyzer on any trace with a Resp. trace type, excluding: 
Resp.Phase, Resp.Rate, Resp.Snore, and Resp.TidalVolume-Flowgenerator. 

3. If necessary, click the trace on which you want the CSB Analyzer to detect the Cheyne-
Stokes Breathing waveform. 

Generating CSB Statistics* 

For Circulatory Delay statistics to appear in the report, you must score desaturation events. You 
must also run the Associations module to associate the Apneic-Phase with the desaturation 
event. 

In the Association Settings, the Apneic-Phase is associated with Desaturation by default. The 
Association module re-evaluates for Desaturation associations after you run the CSB Analyzer. 

For assistance scoring desaturation events, run the Respiration Analyzer (see Starting the 
Respiration Analyzer for more information). The Respiration Analyzer will identify SpO2 
desaturations based on the parameter settings. 

 

Note: RemLogic uses the results from the Phase-Desaturation association to calculate 
Circulatory Delay statistics for reports. Changing the default CSB Association may 
affect the reported values for Circulatory Delay, and may produce results different 
from those validated from independent research. 
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To generate a report containing CSB statistics: 

1. Score desaturation events or run the Respiration Analyzer. 

2. Run the CSB Analyzer. 

 

Note: If you turned off the feature that re-evaluates associations (after you run the 
CSB Analyzer) in the Association Runtime Settings, you must update all associations. 

3. If necessary, update all associations. See Starting the Association Module for more 
information. 

4. Run the desired report that includes CSB information. For more information, see 
Generating a Report. 

 

Tip: To include Circulatory Delay statistics in the report, Desaturation events and 
Apneic-Phase - Desaturation associations must be in the study. 

CSB Parameters* 

The following table outlines the Cheyne Stokes Breathing (CSB) parameter group associated 
with the CSB analyzer. 

General 

Parameter Value Unit 

Select Trace Automatically Yes n/a 

Analysis 

Parameter Value Unit 

T2 120 seconds 

Minimum Decrease 50 % 

Flow Noise Level 2 % 

Minimum Apneic phase duration 3 seconds 

Minimum number of cycles in CSB 3 n/a 

Inter-Scorer Comparison 

The Inter-Scorer Comparison tool is a quality-assessment and training tool that can assess 
scoring accuracy among sleep facility technologists or perform scoring accuracy studies (for 
example, inter-facility scoring accuracy). 

The Inter-Scorer Comparison tool compares a gold standard scoring session (sleep staging and 
event marking) and a comparison scorer on an epoch-by-epoch basis for a given epoch range. 
The tool also quantifies the correct matches compared to incorrect matches, and calculates 
report statistics, including the degree of agreement between the scorers (as a percentage 
value). 
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Comparing a companion scorer to a gold standard scorer is a subjective and facility-specific 
process. Each session being compared can be a result of manual scoring, computer assisted 
analysis or a combination of both. To ensure a valid comparison, scoring sessions are saved to 
different Workpads within the PSG recording folder so that the results of the gold standard 
scoring session are completely hidden from the comparison scorer. 

Comparison Scorer 

The comparison scorer is an individual whose scoring accuracy is assessed against the gold 
standard. A facility interested in assessing the scoring accuracy of new technologists may 
choose the recently-hired night tech as an ideal comparison candidate. 

Gold Standard Scorer 

The gold standard scorer is an individual whose scored Workpad has been chosen by the 
facility as the ideal or consensus scoring method against which comparison scoring sessions 
are compared. 

Accuracy 

The degree of accuracy, or the precision of the test stage scoring and event marking in relation 
to the gold standard, is summarized as the Acceptable Agreement Score on the last page of 
Inter-Scorer Comparison reports. This score (expressed as a % mark) is similar to a pass grade, 
and can be modified for each comparison. 

The degree of accuracy that is calculated in the Inter-Scorer Comparison report is influenced by 
user-defined comparison criteria selected for sleep stage and event comparisons as outlined in 
the Sleep Stage Comparison and Event Comparison topics. 

The Inter-Scorer Comparison Wizard provides step-by-step instructions for comparing two 
scored Workpads and ultimately creating one or more reports based on the findings. The steps 
include selecting comparison reports to include in the output, specifying the epoch range, and 
configuring settings that influence how sleep stages and events are compared, as outlined in 
the Sleep Stage Comparison and Event Comparison topics, which are in the following location 
of the RemLogic online help: Analyzing Data | Computer Assisted Analysis | Inter-Scorer 
Comparison. 

Starting the Inter-Scorer Comparison 

You can compare two scored Workpads and generate reports that will assist in your 
assessment of inter-scorer reliability. 

To start the Inter-Scorer analyzer: 

1. On the Tools menu, click Inter-Scorer Comparison. 

2. Click Next. The Gold Standard and Comparison Scoring Workpad windows display. 

3. In the Gold Standard Workpad window, browse the available recording folders, then 
select a scored Workpad (filename *.ewp) that will serve as the gold standard for the 
comparison. The selected Workpad filename displays in the field beneath the Gold 
Standard Workpad window. 

4. In the comparison Workpad window, select a scored Workpad with which to compare the 
gold standard. The selected Workpad filename displays in the field beneath the 
Comparison Scoring Workpad window. 
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5. Click Next. 

6. Do one of the following: 

 To generate Sleep Stage Comparison reports: 

 Select one or more sleep stage reports to generate, then click Next. The 
Stage Score Comparison screen displays. 

 To generate Event Comparison reports only: 

a. Ensure that all sleep stage report options are deselected. 

b. Click Next to skip to the Event Comparison Report window. 

c. Proceed to step 10. 

6. Specify the minimum and maximum values for the epoch range (if required): 

 To specify the minimum epoch number, do one of the following: 

 Enter a numeric value in the To field. 

 Click and drag the slider bar: the value to the right changes according to the 
slider bar position. Release the bar to set the desired epoch number. 

 To specify the maximum epoch number, do one of the following: 

 Enter a numeric value in the From field. 

 Click and drag the slider bar: the value to the right changes according to the 
slider bar position. Release the bar to set the desired epoch number. 

8. To specify the comparison criteria, enter a numeric value representing the acceptable 
agreement. For more information, see Sleep Stage Comparison in the following location 
of the RemLogic online help: Analyzing Data | Computer Assisted Analysis | Inter-
Scorer Comparison. After entering a value, do one of the following: 

 To exactly compare sleep stages, select Yes, then click Next. Proceed to step 10. 

 To specify a lesser degree of agreement, select No, then click the Matrix button. 
The Stage Weight Matrix dialog box displays. Edit the Stage Weight Matrix to give 
partial points for incorrect yet similar matches: 

 Enter a decimal value representing the percentage weight in the appropriate 
cell. To assign partial points to the comparison scorer for inexact, yet 
approximate, sleep stage scorings, enter 0.9, for instance, in the cell where 
two different stages intersect. This value represents a scoring weight of 90%, 
or 90% of a full point (1.0). Repeat as necessary, then click OK. 

9. Click Next to continue. 

10. Do one of the following: 

 Select one or more event type reports to include, then click Next. 

 To omit event type reports from the results, click Next. The Comparison Summary 
window displays. Proceed to step 14. Note: If you already skipped the sleep stage 
report selection, you must select an event type report to continue. 

11. In the Events window, select one or more event to include in the comparison. To select 
all available events, click Select All. 

12. Configure the event comparison settings (if required): 
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 To specify the minimum overlap and event length percentage, click the appropriate 
check box to select it, then enter a numeric value. 

 Do one of the following: 

 To compare the classification of events in both Workpads, select the Compare 
Event Classifications check box. This indicates that the comparison event 
must have the same classification as the gold standard to be considered a 
match. 

 To indicate the comparison event does not need to have the same 
classification as the gold standard to be considered a match, ensure the 
Compare Event Classifications check box is cleared. 

 To specify an acceptable agreement percentage, enter a numeric value. 

 Specify the maximum and minimum values for the epoch range: 

 To specify the minimum epoch number, do one of the following: 

 Enter a numeric value in the From Epoch field. 

 Click and drag the slider bar: the value to the right changes according to 
the slider bar position. Release the bar to set the desired epoch 
number. 

 To specify the maximum epoch number, do one of the following: 

 Enter a numeric value in the To Epoch field. 

 Click and drag the slider bar: the value to the right changes according to 
the slider bar position. Release the bar to set the desired epoch 
number. 

13. Click Next. The Comparison Summary displays. 

14. Click Next to complete the analysis. A Progress dialog box displays while the reports 
generate. 

15. On the final wizard screen, a window listing the generated reports displays. To view the 
reports, select all appropriate check boxes, then click Finish. The selected reports will 
open in Microsoft Word. 

Pleth Analyzer* 

*Not available with the License free version of RemLogic 
This feature is currently unavailable in the United States. 

 

Note: You must activate the Pleth license component to use the Pleth Analyzer. See 
License Management for more information. 

The Pleth analyzer detects and inserts new subtype arousal events in the plethysmograph 
trace. The detection of arousal events is based on the amplitude of the Pleth waveform. The 
Pleth waveform, SpO2, SpO2 Beat to Beat, and Pulse signals are derived from the Nonin XPOD 
probe pulse oximeter. This signal can be acquired using the following recorders: Embla titanium, 
Embla N7000, Embla S4500, and Embletta. 

Pleth Analyzer main functions: 

 Marks autonomic arousal events (AUTONOMIC) on the Pleth trace. 
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 Generates a new optional trace (Pleth Amplitude) displaying peak-to-peak amplitude of 
each waveform in the Pleth Trace. The module analyzes the peak-to-peak amplitude 
internally. The Pleth Amplitude trace is optionally stored in the current Workpad, and 
useful in determining how autonomic arousal events are generated. 

 Optionally generates artifact events (SIGNAL-ARTIFACT) to the Pleth trace. 

The Pleth Analyzer input traces are Pulse.Pleth-Probe.RD and RD-Quality. The Pulse.Pleth-
Probe.RD trace also holds the output events. The optional derived trace is Pulse.Pleth-
Amplitude. The Pleth Quality trace, RD-Quality, helps improve analyzer performance by 
detecting artifacts. 

 

Pleth Analysis Traces 

Clinical Utility 

An arousal can be detected from a change in autonomic activity. Autonomic activity can be 
measured in many signals, like the ECG, breathing rate, and Pulse Transit Time. In this case, 
an autonomic arousal is marked as a change (drop) in the amplitude of the plethysmogram 
signal. Identification and summary of the pleth amplitude drops can provide an alternative 
method to correlating EEG arousals and sleep disturbance severity with other recorded 
physiological signals. 

Starting the Pleth Analyzer 

The Pleth Analyzer runs on recordings with the Pulse Waveform traces Pulse.Pleth-Probe.RD 
and RD-Quality. 

To start the Pleth Analyzer: 

 From the main menu, select Analysis | Pleth Analyzer. 
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 If the Pleth Waveform traces Pulse.Pleth-Probe.RD and RD-Quality are present, 
a progress indicator displays while the Pleth Analyzer completes the analysis. 
You can cancel the progress indicator at any time, but an unfinished trace will be 
left in the recording. 

 If the Pleth Waveform trace is not present, a dialog box displays, indicating the 
required trace is not found in the study. To continue, click OK. To use this 
module, you must record the Pulse.Pleth-Probe.RD and RD-Quality traces. 

 If you have run the Pleth Analyzer before (or manually edited or added events), 
the following dialog box displays: 

 

Do one of the following: 

 Click Yes to delete the previous analysis. To confirm the deletion and start a 
new analysis, click Yes again. 

 Click No to add the new analysis to the previous one. Previously generated 
autonomic arousals (including manually added autonomic arousals) are 
maintained in the Workpad, and new autonomic arousals (indicated by the 
label AROUSAL-AUTON) is generated. 

 

Tip: Adding new autonomic arousals to a previous analysis does not delete manually 
added autonomic arousal events, even if settings were modified. Only computer 
assisted analysis events are deleted. 

Viewing Results 

To view the results in the Workpad: 

1. Click Traces  on the toolbar. The Add/Remove Traces dialog box displays. 

2. Select the Pleth Waveform traces to display. 
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3. Click OK. The Pleth trace(s) are added to the Workpad Sheet. 

For information on how to customize the Pleth analysis settings, see Plethysmograph 
Parameters in the Appendix of the RemLogic online help. 

Pleth Analysis Parameters 

To modify Pleth analysis parameters: 

1. On the Analysis menu, click Settings. 

2. From the Profile drop-down list, select the appropriate profile. 

 

3. Expand the Pleth Analysis parameter tree (click the plus sign ), then select the 
appropriate subsection. 

 

4. Double-click the appropriate Value field (located in the window on the right), then type in 
or select a value. 

5. Click Close. 

The most important parameters in Pleth Analysis are: 

 Threshold Drop: The amount the amplitude must drop compared to the baseline. 

 Shortest Duration/Longest Duration: Used to control events that are too short or too 
long. 

For other allowed ranges, default values, and descriptions, see Plethysmograph Parameters in 
the Appendix of the RemLogic online help. For more information on customizing analysis 
parameters, see Analysis Profiles in the following location of the online help: Analyzing Data | 
Computer Assisted Analysis. 
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Pleth Statistics 

Pleth Analysis arousal statistics are included in the Polygraphy Report and are found in the 
Sleep Summary and Position Statistics sections. Additional Pleth Analysis information is 
included in the Analysis Criteria section of the report. 

To generate the report: 

 From the Reports menu, select Polygraphy Report. 

PLM Analyzer 

The PLM (Periodic Limb Movement) Analyzer detects limb movement (LM) and periodic limb 
movement from the EMG signal. 

Clinical Utility 

A PLM is defined as a limb movement of 0.5 – 5.0 seconds in duration. It should have amplitude 
of at least 25% of the calibrated signal, and should be periodic, with a duration of 5 to 90 
seconds from onset to onset of the limb movements, and must be scored in sleep. These may 
be scored with or without EEG arousals. The utility of the tool is to assist the clinician or 
technician in identifying body movements by providing well-defined waveforms to be read and 
interpreted. 

Starting the PLM Analyzer 

The PLM Analyzer can be activated from the Operations Sheet or from the menu bar. Before 
running the PLM Analyzer, mark the appropriate analysis time by inserting Analysis Start and 
Analysis Stop events into the recording. 

To start the PLM Analyzer: 

1. Do one of the following: 

 Click Analysis on the Operations Sheet. The Analysis dialog box displays. 
Select PLM Analyzer, then click OK. 

 On the Analysis menu, click PLM. 

2. If more than one scoring session exists in the patient's Workpad, select the appropriate 
scoring session to be used for the PLM calculations, then click OK. The Select Trace 
dialog box displays. 

3. Select the traces to be used in the analysis, then click OK. A progress indicator displays 
while the PLM Analyzer completes the analysis. 

 

Existing PLM Events 

LM and PLM events that were manually marked into the Workpad Sheet can be included with 
the computer assisted scoring events in the report statistics. If a computer assisted analysis or 
manual PLM analysis was previously performed, the following message displays when the PLM 
Analyzer is run: 
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 Select Remove automatic events only to delete all computer assisted scoring LM 
events from the previous analysis but leave the manually inserted events. 

  Select Remove manual and automatic events if a completely new PLM analysis 
should be made.  In other words, all LM events, inserted both manually and by the 
computer assisted scoring, should be removed from the previous analysis. 

For information on how to customize the PLM analysis settings, see Analysis Parameters. 

Respiration Analyzer 

By default, the Respiration Analyzer detects respiratory and respiratory-related events from: the 
respiratory effort belts, the oximeter (saturation/desaturation), the actigraph (position/activity), 
the nasal cannula, and pressure transducer (nasal flow/snore pressure). The Respiration 
Analyzer usually runs after the recording was made, but can also run during online acquisition to 
assess the AHI of the patient. When running online, the analyzer analyzes the time interval 
between the Analysis Start and the Analysis Stop events. Otherwise, the analysis begins at the 
start of the recording, and ends at the point in the online recording when the analyzer started. 

The Respiration Analyzer gathers information about the following events in the Workpad: 
Analysis Start/Stop, Light Off/On, Room Air Start/Stop, and Pressure Start/Stop. If any changes 
are made to these events, the Respiration Analyzer needs to run again. Therefore, the analyzer 
should always run before creating the PSG, Split Night, and Titration Report PSG reports. 

Clinical Utility 

Apneas are defined as a drop in the peak thermal sensor excursion by greater than or equal to 
90% from baseline; a minimum duration of 10 seconds and at least 90% of the event’s duration 
met the amplitude reduction criteria. Classification of the apnea events as obstructive used the 
criteria that continued or increased inspiratory effort was present throughout the entire period 
with a corresponding absence of airflow. Central apnea was scored when the event was 
associated with an absence of both airflow and respiratory effort. Mixed apneas were scored 
when an associated absence of inspiratory effort in the initial portion of the event followed by 
resumption of inspiratory effort in the second part of the event. Hypopneas were scored when 
the nasal pressure signal deflections dropped by greater than or equal to 30% of baseline; a 
minimum duration of 10 seconds; an associated greater than or equal to 3% oxygen 
desaturation from baseline and at least 90% of the event’s duration met the amplitude reduction. 
The utility of the tool is to assist clinicians and technicians well-defined signals to better 
flattening, plateauing and or fluttering in the wave airflow and respiratory effort forms. 

Starting the Respiration Analyzer 

The Respiration Analyzer can be activated in two ways: by use of the Operations Sheet, and 
from the menu bar. Before the Respiration Analyzer is run, mark the appropriate time of analysis 
by inserting Analysis Start and Analysis Stop events into the recording. 
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To start the Respiration Analyzer: 

1. Do one of the following: 

 Click Analysis on the Operations Sheet. The Analysis dialog box displays. 
Select Respiration Analyzer, then click OK. 

 

 On the Analysis menu, click Respiration Analyzer. 

2. If the Respiration Analyzer was run before, a dialog box prompts you to delete the 
previously analyzed respiratory events. Do one of the following: 

 Select Yes to delete the events. 

 Click No to keep the events, and append the previous analysis. 

3. If more than one scoring session exists in the Workpad Sheet, select the appropriate 
scoring session to be used for the respiration analysis. Click OK. 

4. If you are using a customized analysis profile in which the setting for Oxygen 
Saturation | General | Select Trace Automatically is set to No, a dialog box asks you 
to select which trace to mark the Oxygen Desaturation events. Select the desired trace 
and click OK.  

 

5. If you are using a customized analysis profile in which the setting for Snore | General | 
Select Output Trace Automatically is set to No, a dialog box asks you to select which 
trace to use when marking the snore events. Select the desired trace and click OK. 

 

6. If the Default (read-only) profile is used, the settings for Apnea/Hypopnea | Apnea 
(Hypopnea) | Select Trace Automatically are set to No. Select a trace to use for the 
Apnea detection, and click OK.  Then select a trace to use for the Hypopnea detection, 
and click OK. 
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A progress indicator displays while the Respiration Analyzer completes the analysis. 

For detailed information on analysis profiles, see Analysis Parameters and Analysis Profiles 
(which are available in the following location of the RemLogic online help: Analyzing Data | 
Computer Assisted Analysis). 

Scoring Assistant* 

*Not available with the License free version of RemLogic 
This feature is currently unavailable in the United States. 

The Scoring Assistant stages sleep according to current scoring guidelines. The Scoring 
Assistant is a tool intended as an aid in sleep staging and does not replace a specialist in sleep 
scoring. The results of the Scoring Assistant can be accepted, edited or rejected. A typical night 
study is analyzed in 1-5 minutes. 

The Scoring Assistant algorithm utilizes a number of experts to score sleep stages efficiently 
and reliably. The following experts are incorporated into the Scoring Assistant: 

 Delta Frequency Expert 

 Sleep Spindle Expert 

 Eye Movement Expert 

 Electromyogram (EMG) Expert 

The properties of the experts can be adjusted in the Analysis Settings dialog. For more 
information, see Analysis Settings Manager Properties. 

You can modify the relative probability of a particular sleep stage being scored in relation to the 
other sleep staging events. A higher set value for a particular sleep stage increases the 
probability that the sleep stage will be scored by the Scoring Assistant. A lower set value 
decreases the likelihood that a sleep stage will be scored by the Scoring Assistant. 

The following parameters must be recorded in the sleep study for the Scoring Assistant to score 
sleep stages reliably: 

 EEG data 

 EOG data 

 EMG Submental data. 
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For information on report parameters please refer to Report Parameters and Sections in the 
Online help. 

Clinical Utility* 

Wake is defined as trains of sinusoidal 8-14 Hz EEG activity recorded over the occipital region. 
These waveforms are accompanied with eye blinks and eye movements. Stage N1 is 
characterized as having slow eye movements, low amplitude, mixed EEG frequency of 4-7 Hz, 
and vertex sharp waves. Stage N2 is characterized by the presence of K-complex waves with a 
duration of greater than or equal to 0.5 seconds and sleep spindles in the frequency range of 
11-16 Hz and a duration of greater than or equal to 0.5 seconds. Stage N3 is characterized as 
having EEG frequencies of 0.5 – 2 Hz and peak-to-peak amplitudes of greater than 75µV 
measured over the frontal region. REM sleep is defined as having rapid eye movements, low 
chin EMG activity, sawtooth waves, and transient muscle activity. The tool assists the clinician 
and technician with details of the waveforms by identifying waveform patterns that are typically 
identified manually. 

Starting the Scoring Assistant* 

The Scoring Assistant can be activated from the main menu. Before the Scoring Assistant is 
run, the appropriate time of analysis should be indicated by marking Analysis Start and Analysis 
Stop events into the recording. 

When the Scoring Assistant is run, a dialog box appears on the screen prompting you to select 
which EEG trace from the recording should be used by the Delta Frequency Expert and Sleep 
Spindle Expert to score the sleep stages. You are also prompted to select EOG traces and an 
EMG trace. The Eye Movement Expert requires that EOG data be recorded as well, and the 
EMG Expert looks for EMG-Submental data to assist in the scoring of Rapid Eye Movement 
Sleep (REM) because of the change in muscle tone concurrent with REM sleep. 

To start the Scoring Assistant: 

1. On the Analysis menu, click Scoring Assistant. 

2. From the experts that display, select which traces to use for the analysis. 

3. A progress indicator displays while the Scoring Assistant completes the analysis. 

The analysis results display in the Workpad, available for review. For more information about 
manually editing events, see Marking Events. For more information about how to customize the 
Scoring Assistant settings, see Analysis Parameters. 

PTT Trace Generator 

PTT (Pulse Transit Time) is measured as the time between the beat of the heart and the arrival 
of the arterial pressure pulse wave to a peripheral site, usually the finger. The moment that the 
heart muscle contracts is measured by the R-top in the EKG. When the pressure wave reaches 
the finger, a fixed point is measured on the pulse wave of the plethysmogram, a signal that is 
already available from the sensor measuring oxygen saturation. The extent to which the PTT 
value drops can be used as an indicator for finding autonomic arousal events. 

Clinical Utility 

PTT is complementary to plethysmography for identifying micro-arousals. The clinical user can 
visually determine whether PTT trace changes coincide with plethysmography changes and 
EEG micro-arousals. 
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PTT Traces 

The PTT Trace Generator creates two primary PTT traces based on the EKG and Pleth 
Waveform signals. These derived traces are labeled PTT-Raw and PTT-Trans. The traces are 
called PTT-Inductive and PTT-Transformed, respectively. The PTT-Raw trace is calculated from 
EKG and Pleth traces and presented without averaging. The PTT-Trans trace is a trace with 
“smoothed” PTT values, the former which is calculated by averaging the PTT-Raw trace to 
eliminate cycle-by-cycle swing. 

The PTT Trace Generator also creates two optional traces called R-tops and Slope. The R-tops 
trace shows where R-tops in the EKG trace are detected. The R-tops trace can be useful for 
evaluating the accuracy of R-top detection on the EKG trace and can help you determine if 
adjustments in the detection of R-tops are needed. The Slope Trace shows the location on the 
plethysmogram waveform that is used as the reference. It is detected based on the threshold 
setting.  Since the Slope trace is generated with a low frequency (the same as Pleth trace), the 
position of the pulses in this trace is rounded up to the nearest sampling point. However, in 
internal calculation, the exact pulse position is used. The Pulse Transit Time interval is 
measured as the time between the R-top and the reference point on the pulse waveform 
(plethysmogram), which is shown in the Slope trace. 

Starting the PPT Trace Generator 

Before generating the PTT traces, make sure that the EKG and Pleth traces are available in the 
recording. 

To start the trace generator: 

1. On the Analysis menu, click PTT Trace Generator. Note that you cannot run the PTT 
Trace Generator unless both the EKG and Plethysmogram traces are available in the 
recording. If one or both is unavailable, a dialog box appears informing you that the 
required traces are not found in the study. Click OK, and select a study that contains the 
required traces. The Signal Type for the Plethysmogram is Pulse-Pleth-Probe-RD. 

2. If the required traces are present, a progress indicator is displayed while the PTT Trace 
Generator completes the analysis. The progress indicator can be canceled at any time 
but unfinished traces will be left in the recording. 

Viewing Results 

To view the generated PTT traces in the Workpad: 

1. Click Traces  on the toolbar. The Add/Remove Traces dialog box displays. 

2. Select the PTT traces that you want to view. 

 

3. Click OK, and the PTT trace(s) are added into the Workpad Sheet. 

For information on how to customize the PTT trace generation settings, see Analysis 
Parameters. See PTT Parameters in the Appendix of the RemLogic online help for PTT values 
and descriptions. 
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Autonomic Arousal Event Marking 

Once the PTT traces are generated and inserted into a Workpad, you can manually score 
Autonomic Arousal events on the traces. 

The following Autonomic Arousal events are available: Autonomic, LM-Autonomic, Resp-
Autonomic, Desat-Autonomic, Resp.Desat-Autonomic, Spontaneous-Autonomic. 

This group of autonomic arousal events can be reported using the Event report. 

If you would like to include autonomic arousals in other reports, such as the Polysomnography 
report, you should score them using the standard Arousal Events palette. These standard 
arousal events are included in the arousal statistics and tables available in several of the more 
comprehensive sleep reports. 

For more information on manually scoring events, see Marking Events. For more information on 
generating reports, see RemLogic Reports. 

HRV Trace Generator 

The Heart Rate Variability (HRV) Trace Generator calculates the heart rate signal from a 
standard EKG signal. The result is optionally written to three new traces in the Workpad, Heart 
Rate, Heart Rate Variability and R-R Intervals. 

Clinical Utility 

The ECG signal collected at 200 Hz sampling rate provides the user with well-defined ECG 
waves to evaluate cardiac ischemia, identifies basic heart rates with the HRV tool, and identifies 
dysrhythmias. 

Precision Factor 

The localization of the QRS complex, calculated by interpolating the EKG signal to a greater 
time-resolution, is used to locate the R-notch with greater accuracy in comparison to using the 
timing between the sampling points. The Precision Factor is used to enhance the accuracy of 
the R-R interval calculation. For example, the R-notch detection accuracy using a Precision 
Factor of 10 for an EKG  signal sampled at 200Hz provides the same result as a 200Hz EKG 
signal sampled at 2000Hz. Sampling an EKG signal at 2000Hz, however, would produce and 
add to the signal significant noise, resulting in a reduced voltage resolution and timing accuracy. 

The HRV trace generator uses this over-sampling technique to increase the R-notch detection 
accuracy to 10 times the original sampling rate. There is a computational trade off, however, as 
increasing the precision factor increases the time it takes to calculate the HRV by the same 
factor. 

Starting the HRV Trace Generator 

Before running the trace generator, make sure that the EKG trace is available. The HRV Trace 
Generator analyses HR, HRV, and R-R traces for the whole recording so no Analysis Start and 
Stop events are needed. 

To start the trace generator: 

1. On the Analysis menu, click HRV Trace Generator. 

2. If no or more than one EKG trace exists in the recording, a dialog box will prompt you to 
select the EKG for analysis. Click OK. 
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3. A progress indicator displays while the HRV Trace Generator completes the analysis. 
You can cancel the progress dialog box at any time, but that will leave unfinished traces 
in the recording. 

Viewing Results 

To view the results in the Workpad: 

1. Click Traces  on the toolbar. The Add/Remove Traces dialog box displays. 

2. Select the HRV traces that you want to view. 

 

3. Click OK. The new heart rate traces will be added into the Workpad Sheet. 

For information about how to customize the HRV analysis settings, see Analysis Parameters. 

 

Tip: Running the HRV Trace Generator overwrites the previous HR, HRV, and R-R 
traces with new traces. 
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Reporting 
RemLogic reports summarize facts and figures collected from data analysis and are an integral 
part of the Workpad. Generated reports display as separate sheets in the Workpad identified by 
sheet tabs at the base of the Workpad. RemLogic reports include active and non-active report 
types. Available reports depend upon the type of RemLogic installation. 

Refer to the chart listed in the Installation Components section for the list of reports that are 
included with the typical, custom and complete installation options.  With RemLogic, you can: 

 Generate a report 

 Print a report 

 Delete a report 

 Customize a report 

Generating a Report 

Running a report involves selecting the report you want to generate. Active and non-active 
reports display in the Workpad; custom reports display in Microsoft Word. 

Before creating a report, ensure the appropriate analysis is made. Creating a report without the 
required analysis will result in an empty report or a warning from the application. 

Computer assisted analyzers analyze the period between the Analysis Start and Analysis Stop 
events. If these events are not marked to delineate the scored portion of a recording, the 
computer assisted analyzers will analyze the entire recording. 
 

 

Note: Prior to generating reports, ensure that all associations are updated by 
manually running the Associations Module.  To do this, select the following from the 
menu: Analysis>Associations>Update All Associations. 

 

To create a report: 

 Do one of the following: 

 On the Operations Sheet, click 
Reporting. Select the reports you want to 
create, then click OK. 

 On the Reports menu, click the report 
you want to create. If applicable, select 
the scoring session you want to use, then 
click OK. The selected report displays as 
a sheet in the Workpad. 

When you save a Workpad, you also save the 
reports you created. 
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Customizing a Report 

RemLogic reports supports the addition of a custom header, which can include your institution's 
name, address, and logo. 

 

The first page of a Sleep Report displaying a header and institute address 

To add a logo and name to active reports: 

1. On the Tools menu, click Options. 

2. Click the Reports tab. 
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 Institution: Type the institution's name, address, and other relevant information. 
This information displays in the Report Title section of all active reports. 

 Logos: Select Use bitmap logos if a logo or a header should display in the 
active reports. Type the pathway for the logo in the First page text box, or click 
Browse to search for it on the computer. The logo displays on the first page of 
the active reports. If the reports should contain a logo in the header of every 
page, type the logo's path in the Header text box, or search for it by clicking 
Browse. 

3. Click OK. 

  

Printing a Report 

You can print hard copies of reports on your default Windows printer. The Active report page 
layout is formatted for US letter or A4 paper in a portrait orientation, and cannot be modified. 

To print an open report: 

1. Do one of the following: 

 Click Print  on the toolbar. 

 On the File menu, click Print. 

2. Specify the necessary print options. 

3. Click OK. 
  

Deleting a Report 

You can delete reports from the Workpads as needed. 

To delete a report from the Workpad, do one of the following: 

 Right-click the sheet tab of the appropriate report, then click Delete. 

 

 Open the appropriate report, then click Close  in the upper-right corner of the sheet. 
Click Yes. 
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Exporting Active Reports 

Active reports can be exported in the following file formats: 

 HTML world wide web format (*.htm) 

 PDF file (*. pdf) 

 Rich Text Format (RTF) file (*.rtf) 

 Text file (*.txt). Applicable to report text only. 

To export an active report: 

1. Click the sheet tab of the report you want to export. 

2. On the File menu, point to Export, then click Report. 

3. The Export dialog box displays the Patient folder in which the report was created as a 
default export location. 

 

 Save in: Choose the appropriate export location. 

 File name: Type a name for the report. 

 Save as type: Click   and select a file format. 

4. Click Save. 
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Exporting Non-Active Reports 

Information from non-active reports can be copied and pasted into other file formats. 

Copying an Entire Report 

You can copy non-active report information (graphics and text) to the clipboard and paste it into 
Microsoft Word documents or Microsoft Excel spreadsheets. 

1. Open the report. 

2. Right-click on the report's header, then click Copy Report. The report information copies 
to the Windows Clipboard. 

3. Open the file that will include the report information. Most Windows applications accept 
Clipboard data. 

4. Paste the data into the file by the method supported in the application. For example, you 
can press CTRL+V in Microsoft applications to paste information. 

The numerical data is represented as text, and the graphics are stored as a picture or an 
enhanced metafile. For example, you can paste the numerical data into a spreadsheet, and the 
graphics into a word processor. 

If the report exceeds one page, an image-processing program is recommended, because word 
processors do not always allow big pictures to flow between pages. 

Copying Report Sections 

You can copy certain sections, such as Hypnograms, tables, or color maps, separately from all 
non-active reports except the Technote Report. 

1. Locate the section to be copied. 

2. Right-click the section, then click Copy. The data copies to the Windows Clipboard. 

3. Open the file that will include the report information. Most Windows applications accept 
Clipboard data. 

4. Paste the data into the file by the method supported in the application. For example, you 
can press CTRL+V in Microsoft applications to paste information. 
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Troubleshooting 
The following table outlines known issues, and provides workaround information where 
applicable for the RemLogic software. 

Description Workaround / Fix 

RL-36 – When downloading multiple 
studies from the Embletta Gold, use of 
the USB download cable may not 
work.   

To download multiple studies from the device, use the 
3-in-1 cable. 

RL-49 – When collecting an online 
study using the Embletta MPR and 
initiating the Impedance check, on 
occasion the Impedance test may not 
stop. The “Start Impedance Test” 
dialog will therefore not close. 

To resolve this error and reconnect with the Embletta 
MPR: 

1. Stop the study in RemLogic. 
2. Reboot the TX Proxy. 
3. Reboot RemLogic, and resume the recording 

in the software. 

RL-157 – When collecting an online 
study with the Embletta MPR and the 
ST/ST+ Proxy, you may be able to 
interact with the RemLogic workspace 
while it is still loading.  This interaction 
may cause the software to crash. 

Allow the RemLogic software to load the workspace 
prior to interacting with the software. 

RL-161 – When using Microsoft Office 
2016, the Event Matrix table in the 
Event Summary Report may be cut off. 

To display the table in its entirety, 

1. Select the Event Matrix Table 

2. Right-click and select AutoFit or AutoFit to 
Window from the context menu.  

NOTE: That the Comparison title in the table in the 
title of the table will be missing. 
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